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Change log

The below table summarizes the list of changes introduced in a particular version of this document.

Table 1: Summary of changes

FeatureFunctional
area

Change descriptionDateVersion

N/AN/AInitial version
09-May-
2018

1.0

Configure milestone steps in review cyclePerformanceUpdated How does it
work now?

15-May-
2018

2.0

Change review ownerPerformanceUpdated How does it
work now?

Rewards RedemptionEcommerce and
Reward Redemp~
tion

Updated How did it
work? and How does it
work now?

Introducing WalletUpdated How does it
work now?

Updates to Training Unit Agreement APIsREST APIsAdded a new topic23-May-
2018

3.0

Improvements to IP validation error messages
and status codes

SystemAdded a new topic

Modified label in catalog search results columnLearningAdded a new topic

Report As A ServiceAnalyticsUpdated How does it
work now?

28-May-
2018

4.0

RDI supports certification in recertify status on
page 214

System - Data In~
tegration

Added a new topic14-Jun-
2018

5.0





New features at a glance by functional area

The below table summarizes the list of features introduced in the release and their potential impact on your environment.

Note:  * Enabled by default does not necessary imply that the feature is immediately available to your users; it
may require a user with an appropriate administrator role to turn on applicable functionality, business rules, etc.

 indicates a new feature introduced in this update, others are enhancements/changes to the existing functionality.

Table 2: Summary of features

Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

Analytics admin

Analytics user

Disable sending of adhoc emails
for report subscriptions

Analytics

Analytics admin

Analytics user

Obfuscate analytics data for
purged users

Analytics admin

Analytics user

Certification Gap Analysis by
Role

Analytics admin

Analytics user

Check-Ins Status Report

Analytics admin

Manager

Team Status Overview Dash~
board

Analytics admin

Analytics user

Report As A Service

"admin" user

Analytics admin

Analytics user

Pivot table reports

Analytics admin

Analytics user

Number chart



Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

Analytics adminDisable sending of subscription
emails with no data

Analytics admin

Analytics user

New Attributes

Analytics admin

Analytics user

Updated Attributes

End user

Manager

System ad~
min

Hide Career Planning Link on
ME Tab

Career Plan~
ning

Talent admin

Compensation
admin

Status bar display for Snapshot
creation

Compensa~
tion

Compensation
admin

Export Library Fields file en~
hanced with additional fields

Compensation
admin, manager

Remove terminated employees
from an active plan cycle

Compensation
admin, manager

Improved handling of termin~
ated employees and managers

Employee, Man~
ager

Improved Mini-card display

Compensation
admin

Library fields updated

Compenation ad~
min

Clearing and updating user
data

Compensation
admin

Add employees to active plan
cycles

System admin

HR admin
System ad~

min

Rewards RedemptionE-com~
merce and
Reward Re~
demption
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Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

End userUpdated My Rewards page

End userIntroducing Wallet

System admin

Ecommerce ad~
min

Share training units agreement
with other organizations

End userLearning
admin

Web accessibility support for
assessments

Learning

Learning adminDisplay visual indicator while
importing content

Learning adminNew mobile compatibility op~
tions for content import

Learning adminSystem ad~
min

Limit number of contents
shown per content folder

Learning admin
CMI5 content support

End user

Learning adminSaba LRS is ADL conformant

Learning adminCourse templates

Learning adminSynchronize course template
values with related component
attribute changes

End userSystem ad~
min

New Local Catalog Admin se~
curity role

End userSystem ad~
min

Simplified course creation

Learning adminSystem ad~
min

Identify gamified courses
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Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

End userSystem ad~
min

Enhanced notifications for
courses and classes

Manager

End userDisplay visual indicator for at~
tending virtual class sessions

Learning adminDisplay event ID for sessions in
WebEx virtual classes

End userRestrict leaders from deleting
events created via virtual
classes

End userAdjust the Saba Meeting event
seat count on adding or remov~
ing instructors to a virtual class

Organization
manager

System ad~
min

New named queries for organiz~
ation managers

Learning adminManually trigger status change
of certifications, curricula and
recurring courses

End userDisplay visual indicator for in-
progress recurring course
without registration

End user
HR admin

Manually reconcile job role for
learning items

End user
System ad~

min

Display empty mandatory cus~
tom fields when adding extern~
al/completed learning to plan

End userSystem ad~
min

Configure ribbons in Discover
portlet

End userSystem ad~
min

New ribbons in Discover portlet

Learning admin
Modified label in catalog search
results column

Analytics admin
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Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

Marketplace ad~
min

Activation key for Workday
connector

Market~
place

Marketplace ad~
min

Expire Lynda content based on
the list from Lynda

System admin
Remove purged Saba Cloud
users from Saba Meeting

Meeting

Meeting admin

People adminConfigure option for cleanup of
learning items for terminated
users

People

People adminAudit options for Purge action

People adminTransfer Internal users to extern~
al and vice-versa

System admin,
People admin

Enhancement to smartlist criter~
ia

People admin,
End user

Addition of custom fields on
external work history page

People admin,
End user, man~
ager

Enhancement to Job Roles de~
scription page

People admin,
System admin,
End user

System ad~
min

Provide ability to mark a termin~
ated person as Stop Pro~
cessing

End userExtended custom attributes are
visible in Custom sections

Performance ad~
min

Perform~
ance admin

Enhancements to Overall Score
Calculation in Reviews

Perform~
ance

Review owner

System admin

Manager

System ad~
min

Delete Held Skills from My
Plan

End user
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Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

Performance ad~
min

Perform~
ance admin

Expected distribution can now
be hidden from Review Owners

Review owner

System admin

Performance ad~
min

System ad~
min

Transfer points to peers via im~
pression

End user

Manager

End userNew filter to access reviews
from My Plan page

Performance ad~
min

Normalized weightings in the
Goal Weight Summary are now
rounded

Review owner

Performance ad~
min

Perform~
ance admin

Restrict who can cancel reviews
to Performance administrators

Review owner

Performance ad~
min

Perform~
ance admin

Section Weights Support Up to
Two Decimal Places

Performance ad~
min

Perform~
ance admin

Configure milestone steps in
review cycle

Performance ad~
min

Review owner

Change review owner

End user

Manager

Update required level for skills

End user

Review owner

Updated labels for override
overall ratings
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Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

End user
Apply for Job with FacebookRecruiting

Recruiting admin

Hiring manager

Enhancements to Workflow

Recruiter

Hiring team

Candidate

Recruiting admin

Recruiter

Enable and define external job
boards

End user

System adminSystem ad~
min

Configurable Invite Candidate
Email for External Assessment

Hiring manager

Users with Man~
ager Access

New recruiting dashboard

System admin

Hiring team
System ad~

min

New settings to enable resume
parsing and TIM recommenda~
tions

Hiring teamUpdated logic of Days to Fill
calculation for position

DeveloperUpdates to People APIs
REST APIs

DeveloperUpdates to Training Unit
Agreement APIs

DeveloperAdd smartlist as a criteria for an
audience type

DeveloperRetrieve all orders for TUA/PO
using ID or Agreement Number

DeveloperUpdate or delete profile picture
of a person using REST APIs
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Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

DeveloperAPIs to find extended details of
classes

DeveloperSupport for special characters

DeveloperRetrieve external Job Board
data

DeveloperRetrieve all the resources at~
tached to a class

DeveloperPublic APIs to retrieve job
postings

Learning adminSystem ad~
min

Saba Video servicesSaba
Videos

End user

Learning adminSystem ad~
min

Upload and launch formal
streaming videos

End user

Learning adminManage Saba Video usage

End userGroup ad~
min

Showcase videos in a group

End user

"admin" userSystem ad~
min

Upload Saba Video

System admin

End user
Enhancements to CollectionsSocial

End userInline Preview of Images in
Activity Stream

System admin

"admin" user

Audit Trail AuthorizationSystem
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Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

End userWeb accessibility support

System admin
Changes to attributes for SAML
user provisioning

HR adminSystem ad~
min

Changes to Badges administra~
tion workflow

Checklists association for Blen~
ded offering, virtual class, ILT
and WBT imports

System adminData import option for Sign-up
Rules

System adminChange or import IdP certificate
for an existing IdP metadata

System adminImprovements to PGP configur~
ation

Manager

Learning admin

Change in sorting of text-based
searches for Catalog items

System admin

"admin" user

Improvements to Microsite
properties page

System admin

All

Alerting users about the use of
cookies

System adminCert SSO enabled Microsite lo~
gin page to now also accept
URL Identifier

AllCaptcha is now updated

Learning adminEnhancement to Student Certi~
fication Import

Learning adminAssociate and dis-associate
courses in Job Role imports
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Affected
audience

Affects
existing

configuration
or data

Submit
a

Support
ticket

to
enable

Requires
admin
setup

Enabled
by

default?*

FeatureFunctional
area

Learning admin,
System admin

Skip omitted column functional~
ity extended to a few more ob~
jects

Learning adminRDI import for Adhoc transcript
improved

Allow removal of skills from
Person Competency Import

People admin,
System admin

Provide data import option for
bulk transfer of people

System adminData import supports Do-Not-
Process marking for terminated
users

System adminPremium data extracts will not
return purged users or those
with do-not-process mark

System adminImprovements to IP validation
error messages and status codes

System admin,
Learning admin

RDI supports certification in
recertify status

Talent adminUpdate domain of talent pool in
Draft state

Talent
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Chapter

1

Analytics

Topics:

• Framework enhancements
• New Reports
• Updated Reports
• New Attributes
• Updated Attributes



Framework enhancements

Disable sending of adhoc emails for report subscriptions

Prior to this update, in Analytics you could schedule a report or a dashboard and receive it as adhoc emails.

The Analytics admin can now enable or disable the email option by setting an appropriate value for the Disable Adhoc
Emails property under Analytics Settings > Configuration.

Note:  By default, Disable Adhoc Emails will be disabled, which means adhoc emails can be added and sent via
report subscriptions.

Figure 1: Analytics Settings > Configuration > Disable Adhoc Emails
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Once the property value is enabled, the email option will no longer be available as the Recipient type and you cannot
add email addresses whilst subscribing to reports.

Figure 2: Recipient type

Note:

If an existing schedule has adhoc emails, the report will not be sent to those adhoc emails.

This enhancement allows the Analytics admin to control adding of adhoc emails to report subscriptions.

Obfuscate analytics data for purged users

Prior to this update, in Analytics there was no provision to obfuscate the following analytics data for purged users:

• Filters
• Preference
• Subscription > Recipient (Type: Person)
• Custom Dimension

Whenever, terminated users are purged using the Purge Profile option available under People > Manage People >
External People/Internal People > Search for a terminated employee, data from the following areas in Saba Analytics
will be obfuscated:

• Filters
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• Preference
• Subscription > Recipient (Type: Person)
• Custom Dimension

Note: To purge an individual person's profile, you need to enable the Purge functionality available under System
> Configure System > Microsites > <site-name> > Site properties > Web Variables > Enable Purge.

In addition to this, terminated users who are marked as Do Not Process, will no longer be shown in the report data when
the report is exported to CSV, PDF, or Excel from the UI or report schedules. Such users will only be visible when the
report is viewed on the UI.

This enhancement allows the analytics data to be obfuscated for purged users.

Report As A Service

This is a new functionality.

Charts in Analytics use a subset of the data after filtering appropriately for the chosen plotting values and this subset of
the overall report data will now be made available in Report As A Service (RAAS).

Note:  Report As A Service is an add-on feature. For provisioning Report As A Service, submit a request. For
details, contact your Saba Account Manager.

When a report is available as a service, you can invoke the appropriate REST API that the report provides and use the
data it returns in third party applications.

After the functionality is enabled, the Analytics admin can enable Report as a service on a per report basis while saving
the report.
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Note:  By default, the per report configuration is disabled. This configuration is only available:

• For CUSTOM REPORTS
• When the Report as a service functionality is enabled
• For all custom reports (report having charts) other than the data extract reports

After the Report as a service is enabled for a report, the execution link becomes available for that report.

Figure 3: Report as a service per report

This is the REST API URL that when invoked executes the report definition.

All the API executions are available in the History action of that report.

Figure 4: Report as a service - Execution link

 | Analytics | 27



The following REST APIs are available for this functionality:

Figure 5: Report as a service - Execution History

GET REPORT DEFINITION

GET REPORT LIST

REPORT ASYNC EXECUTION STATUS

EXECUTE ASYNC REPORT

EXECUTE REPORT

For details on these APIs, refer to the REST API Reference guide.

N/A

Disable sending of subscription emails with no data

Prior to this update, subscription emails were sent even when the report had no data.
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Analytics now provides a new property called Send subscription for blank reports under Analytics > Settings >
Configurations.

Note: The value of this property will be true by default.

The Analytics admin can set it to false to disable sending subscription emails when report has no data.

Note: This only applies to email subscriptions. FTP/SFTP/Async subscriptions are excluded.

For dashboards, if none of the modules have data only then the dashboard will be considered as no data.

This helps prevent sending emails with no data to the recipients.

Pivot table reports

This is a new feature.

Analytics now provides a new type of report called Pivot table report.

Note:  Pivot table reports is an add-on feature. For provisioning Pivot table reports, submit a request. For details,
contact your Saba Account Manager.

Figure 6: Pivot table Report

Pivot table reports allows re-organizing and summarizing selected columns and rows of data.
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Creating a Pivot table report

To create a pivot table report:

1. As an Administrator, click Analytics in the main menu.
2. Click New and select Pivot table Report as the report type. The report creation form appears.

Figure 7: Build a Pivot table Report

Viewing a Pivot table Report
A pivot table report when executed looks like this:
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• 1 - This means that sorting is applied on data. For example, if Course Title is selected under Rows and sorting is

set as , then the course title data will be sorted in the ascending order. The same is true for the Columns when the

sorting is set to .
•

1 -  or  when applied to Rows then the Total of rows will be sorted in descending ( ) or ascending ( ) order.

The same is true for Columns i.e. descending ( ) or ascending ( ) order .

• 2  indicates filtering report data. Filter is available for each attribute.

• 3 indicates aggregate functions available for creating a Pivot.
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• 4 indicates the following available Pivot types:

• Table: This is basic type. It supports conditional formatting.
• Table Bar chart: Here, each cell is colored which is also configurable per pivot. The height of the color is

proportional to the highest value of the cell in that row excluding the total cell in that row.
• Heat Map: Here, all the cells are colored. The highest value has the actual color and the lowest value is represented

using a white color and all the cells with values between the highest and lowest appear in a lighter shade of actual
color.

• Row heat map: Here, the color shade is calculated per row excluding the total cell in each row. Row wise total
is evaluated separately for color shade.

• Column heat map: Here, the color shade is calculated per column excluding the total cell in each column.
Column wise total is evaluated separately for color shade.

• 5 indicates the available fields in the Pivot report. It lists all the display attributes of the report.
• 6 indicates the column attributes.
• 7 indicates the row attributes.

Whenever the first pivot on the report is saved, it will be treated as the default. If the same user changes it further, this
will always reflect in default pivot. If a user executing this report does not have a pivot preference, the default will be
shown. Saving saves the following:

• Pivot table type
• Conditional formatting
• Aggregation function value (if any)
• List row attributes
• List of column attributes
• Row sort order
• Column sort order
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Some quick facts about the pivot table reports:

• Pivot table reports do not support the following functionality:

• Preview Report
• Schedule (No export supported as of now)
• Theme

• Pivot table report is a license based available feature. When the Pivot table report license expires, the creation and
execution of the Pivot table reports will be stopped. Also the existing Pivot table reports will no longer be available.
Pivot table report count will be considered in the overall report limit licenses when pivot license is active. When the
license expires the pivot table reports will be excluded from the original report limit.

• Any form of downloads are not supported for a pivot table report

This enhancement help users to perform these operations from within Saba Analytics instead of taking them outside to
a spreadsheet.

Number chart

This is a new feature.

Analytics now provides a new type of chart called Number chart.

Figure 8: Number chart

A number chart depict a number/digit and some text below it. The number and the text together comprise a single element
or record.

Note: The default number of elements on the number chart is 3.
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Figure 9: Configure Number chart

A number chart can be configured as:

• Number chart: This type of chart accepts only metrics. Each metric added can be assigned a label and a color. The
numeric values show the aggregation on the metrics’ data and does not correspond to a specific record in the data.

Note:  If you do not specify the label name, the default display name (locale specific) for the attribute is used
instead. If you add a label, that label is visible in other locales as well. When you edit the chart to add a label
through another locale, that change will be reflected for that locale only. All these labels changes are limited to
that particular report.

• Pie-as-Number chart: This is not a chart on its own but a configuration to a pie chart. When creating/editing a pie
chart, you can check the Save as Number Chart check box to display the pie chart as a number chart. This chart is
created with a dimension and a metric. The numeric data in this variation of the number chart will correspond to an
actual record in the report data. The text below will be the value from the record of the dimension selected.

The color used will always be black unless the dimension used is a LOV and that particular LOV's values were
configured with colors.

This enhancement help users to perform these operations from within Saba Analytics instead of taking them outside to
a spreadsheet.

New Reports

Check-Ins Status Report

This is a new report.

This update introduces a new report called Check-Ins Status Report.
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Check-Ins Status Report

This report shows the details of the check-ins for all the employees in the manager's hierarchy, grouped by their
Organization and Direct Manager.

This report needs the following services:

• Performance

Figure 10: Check-Ins Status Report Example

Report Details

This section provides high-level details of the Check-Ins Status Report.

Filters

This report uses the following mandatory filters:

1. Include Manager Hierarchy (Equal)
2. Hierarchy Manager Full Name (IN)
3. Is Terminated (Equal)

This report uses the following optional filters:

1. Check-In Start Date
2. Check-In End Date

Dimensions

This report uses the following dimensions:

1. Person Organization Name
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2. Manager Full Name
3. Person Full Name
4. Check-In Start Date
5. Check-In End Date
6. Check-In Duration (Minutes)
7. Last Check-In Date
8. Last Check-In Duration

Metrics

This report uses the following metrics:

1. Total Check-Ins
2. Total Check-In Topics
3. Average Check-In Duration (Minutes)

This enhancement allows reporting for Check-Ins in Analytics.

Team Status Overview Dashboard

This is a new dashboard.

This update introduces a new dashboard called Team Status Overview Dashboard (available to managers under My
Team > Analytics). It gives the manager an overview of the team's top level information such as team distribution,
learning request, skills, performance, goals, compliance, etc. using the following charts:

• My Team - This is a number chart that provides a summary (with the following information) of the team in terms
of size with Manager Fullname as the filter:

• Direct team size

• Indirect team size

• Mentors in my Team

• Direct Team distribution - This is a pie chart (as a number chart) that provides location wise distribution of team
(Top three location by team member count) with the following information and Manager Fullname as the mandatory
filter and Is Terminated as an optional filter:

• Person Location Name
• Head Count

• Team Learning - This is a number chart that provides details of team learning profile (with the following information)
with Manager Fullname as the mandatory filter and Is Terminated as an optional filter:

• Total assigned learning
• Total In Progress Learning
• Total Overdue Learning

• Team Learning Requests - This is a number chart that provides the following information about learning requests
made by team members and uses "Learning Request Learner Manager Name as the mandatory filter and Is Learning
Request Learner Terminated and Learning request submitted on as the optional filters:
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Total Learning requests from team•
• Pending Learning approvals for team members

• Team Skills - This is a radar chart that shows percentage of team competent for a given skill with Manager Fullname
as the mandatory filter and Skill Assigned On as an optional filter:

• Skill Name
• Competency Compliance Percent

• Team Compliance - This is a cross-tab chart that status wide distribution of team's certifications and curricula with
Manager Fullname and Learning Element Title as the mandatory filter and Is Terminated and Learning Element
Assigned On as optional filters:

• Learning Element Type
• Learning Element Status
• Learning Element Count

• Team Performance - This is a number chart that provides summary of team member reviews with Manager Fullname
and Review Cycle Status as the mandatory filters and Is Terminated as an optional filter:

• Reviews - In Progress
• Reviews - Completed
• Reviews - Pending Approvals

• Team Goals - This is a pie chart (as a number chart) that provide status wise distribution of goals assigned to team
members with Manager Fullname as the mandatory filter and Is Terminated and Goal Assigned On as optional filters
:

• Goal Status
• Goal Assignments
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Figure 11:Team Status Overview Dashboard Example

This enhancement allows mangers to get an overview of the team's top level information.

Updated Reports

Certification Gap Analysis by Role

Earlier the Certification Gap Analysis by Role report was only available to admins.

Certification Gap Analysis by Role report is now available to managers as well as administrators. The managers can
access this report from My Team.

This enhancement allows sharing this report with managers.

New Attributes

Analytics

These are new attributes.

This section describes the attributes that have been added under the Analytics reports model in the Saba application.

Note: The Available in Dashboard column indicates if that entity is available in the dashboards.

Table 3: Analytics Details

DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

Dashboard Chart TitleNoDimensionDashboard
Chart Title

Reports
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DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

Dashboard Chart TypeNoDimensionDashboard
Chart Type

Reports

Fullname of the user who created Report
Schedule

NoDimensionReport Sched~
ule Created By

Reports

Timezone of the Report Schedule CreatorNoDimensionReport Sched~
ule Creator
Timezone

Reports

End Date of the Report ScheduleNoDimensionReport Sched~
ule End Date

Reports

Shows the date and time for Next schedule run
of the active report subscription only. Once the
subscription is over, it will show blank

NoDimensionReport Sched~
ule Next Run
Date

Reports

Shows the date and time for Previous schedule
run of the active report subscription only. Once
the subscription is over, it will show blank

NoDimensionReport Sched~
ule Previous
Run Date

Reports

Start Date of the Report ScheduleNoDimensionReport Sched~
ule Start Date

Reports

Shows the schedule time selected by user in
HH:MI format (24 Hour Clock)

NoDimensionReport Sched~
ule Time
(HH:MI)

Reports

This attribute can be used as filter only. This at~
tribute when used in the report with value Yes,

NoDimensionShow Deleted
Reports

Reports

allows users to see the Deleted Reports and user
will be able to see audit data for deleted reports
to identify who deleted the report, on which date
etc. When This filter has value No or it is not
added to the report, the report will not fetch de~
leted reports.

Shows Yes if the report displayed in the output
is a deleted report else shows No

NoDimensionIs Deleted Re~
port

Reports
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DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

Date and Time on which report was editedNoDimensionReport Audit
Timestamp

Report Audit
Data

Action taken on the reportNoDimensionReport Audit
Action

Report Audit
Data

Full name of the user who edited the reportNoDimensionReport Audit
User Fullname

Report Audit
Data

Users can now pull these new attributes (Dimensions / Metrics) while creating or updating the Analytics reports.

Compensation

These are new attributes.

This section describes the attributes that have been added under the Compensation reports model in the Saba application.

Note: The Available in Dashboard column indicates if that entity is available in the dashboards.

Table 4: Compensation Details

DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

Shows Yes if the Terminated user has not selec~
ted "Stop Processing" option in the Profile else
shows No.

NoDimensionCan Process
Data

Person Details

Users can now pull these new attributes (Dimensions / Metrics) while creating or updating the Analytics reports.

Learning

These are new attributes.
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This section describes the attributes that have been added under the Learning reports model in the Saba application.

Note: The Available in Dashboard column indicates if that entity is available in the dashboards.

Table 5: Learning Details

DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

Number of Badges presentNoMetricTotal BadgesBadges

Custom attribute of course attached to Certifica~
tion

NoDimensionCertification
Course Cus~
tom0

Certification
Details

Custom attribute of course attached to Certifica~
tion

NoDimensionCertification
Course Cus~
tom1

Certification
Details

Custom attribute of course attached to Certifica~
tion

NoDimensionCertification
Course Cus~
tom2

Certification
Details

Custom attribute of course attached to Certifica~
tion

NoDimensionCertification
Course Cus~
tom3

Certification
Details

Custom attribute of course attached to Certifica~
tion

NoDimensionCertification
Course Cus~
tom4

Certification
Details

Custom attribute of course attached to Certifica~
tion

NoDimensionCertification
Course Cus~
tom5

Certification
Details

Custom attribute of course attached to Certifica~
tion

NoDimensionCertification
Course Cus~
tom6

Certification
Details

Custom attribute of course attached to Certifica~
tion

NoDimensionCertification
Course Cus~
tom7

Certification
Details

Custom attribute of course attached to Certifica~
tion

NoDimensionCertification
Course Cus~
tom8

Certification
Details
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DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

Custom attribute of course attached to Certifica~
tion

NoDimensionCertification
Course Cus~
tom9

Certification
Details

Custom attribute of course attached to Certifica~
tion

NoDimensionCertification
Course Cus~
tom10

Certification
Details

Custom attribute of course attached to Certifica~
tion

NoDimensionCertification
Course Cus~
tom11

Certification
Details

Custom attribute of course attached to Certifica~
tion

NoDimensionCertification
Course Cus~
tom12

Certification
Details

Custom attribute of course attached to Certifica~
tion

NoDimensionCertification
Course Cus~
tom13

Certification
Details

Custom attribute of course attached to Certifica~
tion

NoDimensionCertification
Course Cus~
tom14

Certification
Details

Number of Badges associated with certifications
selected

NoMetricTotal BadgesCertification
Details

Shows the Learning Event ID for CurriculaNoDimensionCurricula IDCurricula De~
tails

Shows the name of vendor for CurriculaNoDimensionCurriculum
Vendor

Curricula De~
tails

Shows the name of vendor for CertificationNoDimensionCertification
Vendor

Certification
Details

Custom attribute of course attached to Cur~
riculum

NoDimensionCurriculum
Course Cus~
tom0

Curricula De~
tails
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DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

Custom attribute of course attached to Cur~
riculum

NoDimensionCurriculum
Course Cus~
tom1

Curricula De~
tails

Custom attribute of course attached to Cur~
riculum

NoDimensionCurriculum
Course Cus~
tom2

Curricula De~
tails

Custom attribute of course attached to Cur~
riculum

NoDimensionCurriculum
Course Cus~
tom3

Curricula De~
tails

Custom attribute of course attached to Cur~
riculum

NoDimensionCurriculum
Course Cus~
tom4

Curricula De~
tails

Custom attribute of course attached to Cur~
riculum

NoDimensionCurriculum
Course Cus~
tom5

Curricula De~
tails

Custom attribute of course attached to Cur~
riculum

NoDimensionCurriculum
Course Cus~
tom6

Curricula De~
tails

Custom attribute of course attached to Cur~
riculum

NoDimensionCurriculum
Course Cus~
tom7

Curricula De~
tails

Custom attribute of course attached to Cur~
riculum

NoDimensionCurriculum
Course Cus~
tom8

Curricula De~
tails

Custom attribute of course attached to Cur~
riculum

NoDimensionCurriculum
Course Cus~
tom9

Curricula De~
tails

Custom attribute of course attached to Cur~
riculum

NoDimensionCurriculum
Course Cus~
tom10

Curricula De~
tails
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DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

Custom attribute of course attached to Cur~
riculum

NoDimensionCurriculum
Course Cus~
tom11

Curricula De~
tails

Custom attribute of course attached to Cur~
riculum

NoDimensionCurriculum
Course Cus~
tom12

Curricula De~
tails

Custom attribute of course attached to Cur~
riculum

NoDimensionCurriculum
Course Cus~
tom13

Curricula De~
tails

Custom attribute of course attached to Cur~
riculum

NoDimensionCurriculum
Course Cus~
tom14

Curricula De~
tails

Number of Badges associated with Curricula
selected

NoMetricTotal BadgesCurricula De~
tails

When Value is set to "Yes", includes all child
Content Folders, direct as well as indirect. When

NoDimensionInclude Content
Folder Hier~
archy

Content Folder
Hierarchy

value is set to "No", shows data for Content
Folder selected in Hierarchy Parent Content
Folder name filter.

Parent Content Folder Filter to select Content
Folder for which Hierarchy is to be displayed.

NoDimensionHierarchy Par~
ent Content
Folder Name

Content Folder
Hierarchy

Name of the content ProviderNoDimensionContent Pro~
vider

Content Details

External Content ID of the ContentNoDimensionExternal Con~
tent ID

Content Details

Number of Badges associated with Courses se~
lected

NoMetricTotal BadgesCourses

Objective DescriptionNoDimensionObjective De~
scription

Lesson Details

 | Analytics | 45



DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

Title or name of the Objective associated with
Content

NoDimensionObjective IDLesson Details

Score for the Objective associated with ContentNoDimensionObjective ScoreLesson Details

Status of the ObjectiveNoDimensionObjective
Status

Lesson Details

Shows the Success Status of the content lesson
objective

NoDimensionObjective Suc~
cess Status

Lesson Details

Is Learning Request Requestor TerminatedYesDimensionIs Learning Re~
quest Requestor
Terminated

Learning Re~
quest

Learning Request Learner Manager NameYesDimensionLearning Re~
quest Learner
Manager Name

Learning Re~
quest

Learning Request Learner Manager UsernameYesDimensionLearning Re~
quest Learner

Learning Re~
quest

Manager User~
name

Count of Pending Learning RequestsYesMetricPending Learn~
ing Requests

Learning Re~
quest

Count of Assigned CoursesYesMetricAssigned
Course

Transcript

Count of Overdue CoursesYesMetricOverdue
Course

Transcript

Users can now pull these new attributes (Dimensions / Metrics) while creating or updating the Analytics reports.

Profile
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These are new attributes.

This section describes the attributes that have been added under the Profile reports model in the Saba application.

Note: The Available in Dashboard column indicates if that entity is available in the dashboards.

Table 6: Profile Details

DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

Manager Without TeamNoDimensionManager
Without Team

Person Man~
ager

Direct Reportees count to a managerYesMetricDirect Re~
portees

Person Man~
ager

Indirect Reportees count to a managerYesMetricIndirect Re~
portees

Person Man~
ager

Number of mentors in a teamYesMetricMentors in
Team

Person Man~
ager

Learning Element TypeYesDimensionLearning Ele~
ment Type

Person Man~
ager

Learning Element StatusYesDimensionLearning Ele~
ment Status

Person Man~
ager

Learning Element CountYesMetricLearning Ele~
ment Count

Person Man~
ager

Count of person compliant to skill in a groupYesMetricCompetency
Compliance
Count

Person Skills

Percent of person compliant to skill in a groupYesMetricCompetency
Compliance
Percent

Person Skills

Shows Yes, if the user has not marked Do Not
Process Data on his profile, else shows No.

NoDimensionCan Process
Data

Person Details
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Users can now pull these new attributes (Dimensions / Metrics) while creating or updating the Analytics reports.

Performance

These are new attributes.

This section describes the attributes that have been added under the Performance reports model in the Saba application.

Note: The Available in Dashboard column indicates if that entity is available in the dashboards.

Table 7: Performance Details

DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

Fullname of the User who will perform the
Check-in

NoDimensionCheck-In Own~
er

Check-Ins

Start date and time of the Check-inNoDimensionCheck-In Start
Date

Check-Ins

End Date and time of the Check-inNoDimensionCheck-In End
Date

Check-Ins

Check-in Duration in MinutesNoDimensionCheck-In Dura~
tion (Minutes)

Check-Ins

Summary Comment for the Check-inNoDimensionCheck-In Sum~
mary Comment

Check-Ins

Fullname of the User who ended the Check-inNoDimensionCheck-In
Ended By

Check-Ins

Count of Comments in the Check-inNoDimensionCheck-In Com~
ment Count

Check-Ins

Count of Topics reviewed during the Check-inNoDimensionCheck-In Topic
Count

Check-Ins
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DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

Duration after which the topic will be revisitedNoDimensionCheck-In Topic
Revisit Dura~
tion

Check-Ins

Comments on the topics reviewed in Check-inNoDimensionCheck-In Topic
Comment

Check-Ins

Date on which the topic was added to Check-inNoDimensionCheck-In Topic
Added On

Check-Ins

Date after which the topic will be availableNoDimensionCheck-In Topic
Available After

Check-Ins

Name of the topic discussed during check-in, it
can be a Goal, a skill, an Impression, or a work~
note

NoDimensionCheck-In Topic
Name

Check-Ins

Total number of check-ins presentNoMetricTotal Check-
Ins

Check-Ins

Total number of topics associated with Check-
ins

NoMetricTotal Check-In
Topics

Check-Ins

Average Duration of Check-ins selected in the
report

NoMetricAverage
Check-In Dura~
tion (Minutes)

Check-Ins

Date of the last completed check-inNoDimensionLast Check-In
Date

Check-Ins

Duration of the Last completed Check-inNoDimensionLast Check-In
Duration
(Minutes)

Check-Ins

Status of the Check-inNoDimensionCheck-In StatusCheck-Ins

Duration Type of Check-in Topic RevisitNoDimensionCheck-In Topic
Revisit Dura~
tion Type

Check-Ins
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DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

Status of The Check-in RevisitNoDimensionCheck-In Topic
Revisit Status

Check-Ins

Status of the Topic in Check-inNoDimensionCheck-In Topic
Status

Check-Ins

Type of the topic discussed in Check-inNoDimensionCheck-In Topic
Type

Check-Ins

This metric gives number of goals assigned to a
group

YesMetricGoal Assign~
ments

Goals

Date on which reviewer submitted the ratingNoDimensionReviewer Rat~
ing Submitted
On

Reviewer

Shows Yes if Calculation Method has Self option
selected else shows No

NoDimensionAllow Self Re~
view Ratings

Review Details

Shows Yes if Calculation Method has Manager
option selected else shows No

NoDimensionAllow Manager
Review Ratings

Review Details

Shows Yes if Calculation Method has 2nd Level
Manager option selected else shows No

NoDimensionAllow Second~
ary Level Man~
ager Review
Ratings

Review Details

Shows Yes if Calculation Method has Alternate
Manager option selected else shows No

NoDimensionAllow Altern~
ate Manager
Review Ratings

Review Details

Shows Yes if Calculation Method has Stakehold~
er option selected else shows No

NoDimensionAllow Stake~
holder Review
Ratings

Review Details

Shows Yes if Calculation Method has Direct
Reports option selected else shows No

NoDimensionAllow Direct
Report Review
Ratings

Review Details
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DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

Shows Yes if Calculation Method has Peers op~
tion selected else shows No

NoDimensionAllow Peer Re~
view Ratings

Review Details

Count of InProgress ReviewsYesMetricInProgress Re~
views

Review Details

Email for the Review ownerNoDimensionReview Owner
Email

Review Details

Type of Review Owner selected for a Review
Cycle

NoDimensionReview Cycle
Review Owner
Type

Review Cycle
Details

Title of the WorknoteNoDimensionWorknote TitleWorknotes

Description of the WorknoteNoDimensionWorknote De~
scription

Worknotes

Category of the WorknoteNoDimensionWorknote Cat~
egory

Worknotes

Shows Yes if the Worknote is PrivateNoDimensionIs Private
Worknote

Worknotes

Due date of the WorknoteNoDimensionWorknote Due
Date

Worknotes

Date on which the worknote was createdNoDimensionWorknote Cre~
ated On

Worknotes

Fullname of the user on whom the note is being
created. It will be blank if the note is created on
the person himself

NoDimensionWorknote OnWorknotes

Username of the user on whom the note is being
created. It will be blank if the note is created on
the person himself

NoDimensionWorknote On
Username

Worknotes
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DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

Full name of the user who has been added as
Contributor

NoDimensionWorknote Con~
tributor

Worknotes

Username of the User who has been added as
contributor

NoDimensionWorknote Con~
tributor User~
name

Worknotes

Name of the Skill or Goal to which the note is
linked

NoDimensionWorknote
Linked To

Worknotes

Total Number of WorknotesNoMetricTotal Work~
notes

Worknotes

Users can now pull these new attributes (Dimensions / Metrics) while creating or updating the Analytics reports.

Pulse 360

These are new attributes.

This section describes the attributes that have been added under the Pulse 360 reports model in the Saba application.

Note: The Available in Dashboard column indicates if that entity is available in the dashboards.

Table 8: Pulse 360 Details

DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

Question Response CountNoMetricQuestion Re~
sponse Count

Pulse 360 Feed~
back

Users can now pull these new attributes (Dimensions / Metrics) while creating or updating the Pulse 360 reports.

 | Analytics | 52



Recruiting

These are new attributes.

This section describes the attributes that have been added under the Recruiting reports model in the Saba application.

Note: The Available in Dashboard column indicates if that entity is available in the dashboards.

Table 9: Recruiting Details

DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

This metric shows the Time taken to hire the
candidate from the first activation date of the

NoMetricTime to Hire
Candidate
(Days)

Candidate De~
tails

requisition and considers only the period when
the Job requisition was Active

Note: Average Time to Hire metric is
now replaced with Time to Hire Candid~
ate (Days) metric. Average Time to Hire
metric will no longer be available.

This metric shows the Time taken to hire the
latest candidate from the first activation date of

NoMetricTime to Fill
Requisition
(Days)

Job Requisition
Details

the requisition and considers only the period
when the Job requisition was Active

This metric shows the Time for which the Requis~
ition is active till it gets closed after filling all

NoMetricActive Time
for Requisition
(Days)

Job Requisition
Details

the required positions from the first activation
date

Users can now pull these new attributes (Dimensions / Metrics) while creating or updating the Analytics reports.

Social

These are new attributes.

This section describes the attributes that have been added under the Social reports model in the Saba application.
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Note: The Available in Dashboard column indicates if that entity is available in the dashboards.

Table 10: Social Details

DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

Average Impressions for TeamYesMetricAverage Impres~
sions for Team

Impressions

Users can now pull these new attributes (Dimensions / Metrics) while creating or updating the Analytics reports.

Saba Meeting

These are new attributes.

This section describes the attributes that have been added under the Saba Meeting reports model in the Saba application.

Note: The Available in Dashboard column indicates if that entity is available in the dashboards.

Table 11: Saba Meeting Details

DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

Client Used for Saba MeetingNoClient UsedAttendance

OS Used for Saba MeetingNoOS UsedAttendance

Users can now pull these new attributes (Dimensions / Metrics) while creating or updating the Saba Meeting reports.

System

These are new attributes.

This section describes the attributes that have been added under the System reports model in the Saba application.
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Note: The Available in Dashboard column indicates if that entity is available in the dashboards.

Table 12: System Details

DescriptionAvailable in
Dashboard

Attribute
Type

Attribute
Name

Entity Name

Smart List NameNoDimensionSmart List
Name

Smartlist De~
tails

Smart List ParentNoDimensionSmart List Par~
ent

Smartlist De~
tails

Smart List StatusNoDimensionSmart List
Status

Smartlist De~
tails

Smart List OwnerNoDimensionSmart List
Owner

Smartlist De~
tails

Smart List Owner TypeNoDimensionSmart List
Owner Type

Smartlist De~
tails

Smart List Created ByNoDimensionSmart List Cre~
ated By

Smartlist De~
tails

Smart List Created OnNoDimensionSmart List Cre~
ated On

Smartlist De~
tails

Smart List Updated ByNoDimensionSmart List Up~
dated By

Smartlist De~
tails

Smart List Updated OnNoDimensionSmart List Up~
dated On

Smartlist De~
tails

Users can now pull these new attributes (Dimensions / Metrics) while creating or updating the Analytics reports.
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Updated Attributes

Analytics

These are already existing attributes which didn't include dashboard data.

These attributes are modified to include dashboard data as well.

Table 13: Analytics Details

Attribute TypeAttribute NameEntity Name

DimensionReport History Executed ByReport History

DimensionReport History Execution DateReport History

DimensionReport History Is Manual ExecutionReport History

DimensionReport History Is Scheduled ExecutionReport History

DimensionReport History Execution FrequencyReport History

DimensionReport History Transmit TypeReport History

MetricTotal Report ExecutionsReport History

DimensionTotal ChartsReports

N/A

Learning
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These are already existing attributes which didn't include transcript notes in case of recurring courses when recurring
course context is set.

These attributes are modified to include transcript notes in case of recurring courses when recurring course context is
set.

Table 14: Learning Details

Attribute TypeAttribute NameEntity Name

DimensionTranscript NotesTranscript

DimensionTranscript Notes Added OnTranscript

DimensionTranscript Notes Added ByTranscript

DimensionTranscript Notes CategoryTranscript

N/A

Attributes to show time as per the time format

These are already existing attributes which didn't show time as per the time format set in logged in user's locale settings.

These attributes are modified to now show time as per the time format set in logged in user's locale settings.

Table 15: Attribute Details

Attribute NameEntity Name

Scheduled Class Start TimeClasses

Session Start TimeClasses

Session End TimeClasses

Scheduled Class Start TimeClasses Catalog

Completed Courses (Transcript) Completion TimeTranscript

Video Uploaded On TimeFile/URL/Video
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Attribute NameEntity Name

Video Uploaded On TimeBlog/Workspace/ChannelVideo

Logout TimeLogin Details

Login TimeLogin Details

Appointment Start TimeResource Assignment

Appointment End TimeResource Assignment

Room Assignment Start TimeResource Assignment

Room Assignment End TimeResource Assignment

Resource Assignment Period Start TimeResource Assignment

Resource Assignment Period End TimeResource Assignment

Video Uploaded On TimeContent Details

Video Uploaded On TimeContent Details Catalog

Module Start TimeModule Details

Module End TimeModule Details

First Attempt Time (HH:MI AM)Module Details

Prescriptive Rule Start TimePrescription Rules

Event Start TimeEvent

Event End TimeEvent

Entered Meeting (Time)Attendance

Exited Meeting (Time)Attendance

N/A
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Chapter

2

Career Planning

Topics:

• Hide Career Planning Link on ME
Tab



Hide Career Planning Link on ME Tab

When the Career Planning service is enabled, the Career Planning link appears in the left hand menu on the ME tab.

The visibility of the Career Planning link on the ME tab is now controlled by the new setting Hide Career Planning
link on the ME tab. under the Career Planning service. By default, this setting is disabled. When this setting is disabled,
the Career Planning link appears in the left navigation on the ME tab. To enable it, contact your system administrator.
When it is enabled, the Career Planning link is hidden on the ME tab.

Figure 12: New Setting to Hide Career Planning Link

When the link is hidden and an end user tries to access Career Planning using the deeplink, the The Career Planning
link is currently switched off hence not accessible. Please contact your System Administrator about the same. error
appears.

This doesn't affect talent administrators and managers as they can still see view their employees' and direct reportees'
career paths.

This enhancement allows to hide the Career Planning link from end users.
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Status bar display for Snapshot creation

In the past, when creating a Snapshot, the system did not provide any indication of the status of the process. It was
difficult for users to determine if they are ready for the next step in the workflow.

With this update, a status bar displays when you create a snapshot from the People Snapshots page, or when you create
a snapshot from within the plan cycle wizard.

Status bar display during snapshot creation

Snapshot creation process now has a status bar display to indicate progress level.

Export Library Fields file enhanced with additional fields

In the past, when performing Export Library Fields step from the Admin > Compensation > Configuration > Library
Fields page, not all the attribute details were exported to the file.

With this update, new columns are added to the template so that more fields are available for export.

The following attribute details are added to the Library Field export file:

1. Debit from Budget - Yes/No
2. Include in Category Total - Yes/No
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3. Is Pick List - Yes/No
4. Editable - Yes/No
5. Formula - Import - formula
6. Formula - Worksheet - formula
7. Soft Rule - formula
8. Soft Rule Message - text
9. Hard Rule - formula
10. Hard Rule Message - text
11. Created By
12. Updated On

Compensation Administrator can now see all related data in the export file when performing the Export Library Fields
step.

Remove terminated employees from an active plan cycle

In the past, compensation administrators could not remove terminated employees from an active plan cycle.

With this update, compensation administrators can remove a terminated employee from an active plan cycle.

To remove a terminated employee from an Active Plan Cycle:

1. From the All Plan Cycle page, select Active and search for the plan that you wish to update.

a. Click on Update Plan Cycle.

2. On the Plan Cycle details page that displays, select Remove Employees from Actions.
3. Choose the Employee that you want to remove from the Employees list and click Continue.
4. As an administrator you can also change the recommended amount to remove from the budget.
5. Click Save on the Remove Employees page.

Remove Employees Action selected to remove Terminated Employees
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Terminated employees can now be removed from an Active Plan cycle.

Improved handling of terminated employees and managers

In the past, during budget distribution, if the allocated plan includes any managers who are terminated, the budget
distribution will fail and the worksheet progress will stop.

With this update, in a scenario as mentioned above, the budget distribution will not fail. A warning message will display
during the Check Data step and the user can choose to go back and change any setting and redistribute the budget, or
choose to ignore the warning message and activate the plan cycle.

If the terminated manager is also an Approver, Compensation Administrator can approve the budget.
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With this update, the worksheet sequence or the budget distribution steps will not be affected when managers and
employees are terminated during the process.

Improved Mini-card display

In the past, the bar chart on the mini card on the worksheet was not consistent in the display.

With this update, the bar chart on the mini card display is enhanced and it conforms with the Saba Cloud UI enhancements.
It also provides the correct display with different localization options.

Mini-chart display

Mini chart display has been enhanced.

.

 | Compensation | 65



Library fields updated

New Library Field has been added and existing field has been modified.

The Library Fields page in Compensation has been updated with additions and changes.

A new field called the Username has been added to the Library fields.

Figure 13: username field added to Library fields

The Manager field is renamed as Line Manager.

Figure 14: Line Manager field
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The Library Fields page has been updated and modified.

Effects of purging user profile information

N/A

With this update, when a user's data is purged from Saba Cloud, data from the following sections will be obfuscated:

1. TIM Analysis
2. Mini Card
3. Audit Log
4. Compensation profile dialog
5. Compensation Statement
6. Compensation Letters

a. Delete the Letters when user's data has been purged

7. Manager's worksheet - Team of.. section
8. Approval flow

Additionally, profile information such as Location, Job and organization will be deleted from the worksheet grid. But
compensation specific data such as the Current Base Salary will not be deleted.

Note:  Do not perform any Compensation Tasks, while a purge operation is running. Purge operation may not
work on Compensation data, if a Compensation job is running at the same time as the purge operation.

When a user's information gets purged from Saba Cloud, the associated data from all of the above section will be
obfuscated.

Add employees to active plan cycles

The Add Employees screen has been enhanced and updated.

With this update, Compensation Administrators can now search, select and add employees to an activated plan cycle.
While selecting the employee to add to the worksheet, you can select which component the employee(s) are eligible for
and add budget for each component.
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Note: An employee can be added to a Manager's worksheet only if the status is Allocation in Progress or when
it has been Returned to Manager.

To add an employee to an active plan cycle:

1. Admin>Compensation>All Plan Cycles>Active Plan Cycle
2. Select the Plan Cycle that you wish to work on and Click on Update Plan Cycle.
3. Click on Add Employees from the Actions tab.
4. Click on the Add Employees icon located at the top right corner.
5. In the next screen, search for the specific employee name that you wish to add.
6. Select the Name and click Continue.
7. In the next screen, select the Component you want to add to the Plan Cycle.
8. Click on Finish. A confirmation message will display to indicate that the employee name is added.

Users are now able to add employees to active plan cycles.
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Rewards Redemption

This is a new feature. User could earn points before but there was no option to redeem points within Saba Cloud.

When you earn various rewards, you also earn points against it. You can accumulate and redeem those points by buying
items like a T-shirt, giftcard and so on. You can redeem these points only when the Reward Redemption service under
Rewards is enabled. By default this service is disabled. To enable, contact your system administrator.

Important: The Rewards service is now moved from the Collaboration service to Foundation service. By default
this service is disabled. To enable, contact your system administrator.

Your HR administrator must create rewards in the system so that you can redeem your points by buying those rewards.
The HR administrator can create rewards only when:

• Reward Redemption service is enabled.
• Can access HR->Manage Badges->Reward Order privilege is enabled under MenuVisibility-HRAdmin component

for Human Capital Admin security role.

As an HR administrator, navigate to Admin > HR > Manage Rewards and create new rewards.

Figure 15: New Reward

Once the reward is created, as an HR admin you can associate an owner who will fulfill the order. The one who creates
the reward by default becomes the owner. However, you can have additional owners as well.
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Figure 16: New Reward

As an end user, you can search for rewards using the attribute Reward in the Global Search.

Figure 17: List of rewards

Based on your points, you can redeem a reward that fits in your wallet. You may view the reward details, redeem it,
enter the desired information, if prompted, and confirm your reward order. The reward order goes in Placed status.
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Figure 18: Reward Order

Once you place the order, the order goes through confirmation state and then delivered state. In between the process,
you can cancel the order only during the Placed status while the HR administrator can cancel the order in any state.

As an HR administrator, you can navigate to HR > Manage Rewards > Reward Order, search for and click on the order
to take further action, and click the status to process it further.

Figure 19: Reward Order Process

As an end user, you can also transfer some of your points to a peer outside of an impression. Say you would like to
collect points toward purchase of the group reward item like a team lunch. This is a similar workflow to Distribute
earned points through impression but an impression is not created.

This improves the motivational impact of points-based rewards by allowing the user to redeem points for fun things and
experiences, like gift cards or team lunch.
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Improved My Rewards page

Prior to this update, points and badges were shown on the My Rewards page as depicted below:

Figure 20: Complete Picture Preview

There was a need to display them separately to improve its visibility and usability.

With the introduction to new features like reward redemption and transferring of points, the badges and points are now
displayed separately on the My Rewards and Wallet page, respectively. If the Rewards Redemption service is disabled,
then the Points and Points History still appears on the separate page. See Wallet for more information.

Note: You can view your badges by navigating to Me > Rewards.
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Figure 21: Updated My Rewards page

The My Rewards page shows the following tabs. Earlier the leader-board was points driven but now it shows badges.

• ME

This tab displays the count of your badges earned through Learning, Impression, and Achievement.

• Learning - Shows the total number of badges you have earned by completing the learning items like courses,
recurring courses, gamified courses, certifications and curricula.

• Impression - Shows the total number of badges you have earned by receiving impressions from your peers. To
view all your impressions, click the Go to Impressions link to navigate to your My Impressions page.

• Achievement - Shows the total number of achievement badges you have earned by completing gamified courses
created via the new Simplified Courses Workflow.

You can click the badge count to view the date and source of last 3 badges.
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Figure 22: Me tab in My Rewards

• TEAM

This tab displays the top three badge earners within your team including the logged-in user's rank and a graphical
display for the last six months. The Team defined here is as all of you and all of your peer that report to the same
manager, but it does not include the manager's badges.

• Top Badge Earners - Shows the top 3 badge earners within your team placing the user with maximum badges at
rank 1 and so on. If you are part of the top 3 earners, then your card appears in blue. If you are not part of the top
3 badge earners, then your rank appears after the third earner.
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Figure 23:Top badge earners

• Badge Count - Shows a graphical display of number of badges earned by you, top earner, and the team average
within the last 6 months.

Figure 24: Badge count
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If you do not belong to a team, you will not see the Team tab.

• Organization

This tab displays the top badge earners within your organization, top 3 organizations, and a graphical display for
last 6 months including the logged-in user's rank. This tab shows the Saba Cloud HR defined organizational structure.

• Top Badge Earners - Shows the top 3 badge earners within your organization placing the user with maximum
badges at rank 1 and so on. If you are part of the top 3 earners, then your card appears in blue. If you are not part
of top 3, then your rank appears after the third earner.

Figure 25:Top badge earners in organization

• Top Organization - Shows the top 3 organizations with maximum badges. If your organization isn't part of top
3, then it shows your current rank after the 3rd ranker.
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Figure 26:Top organizations

• Badge Count - Shows the graphical display of number of badges earned by you, the top earner, and a organization
average within the last 6 months.
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Figure 27: Badge count of top organizations

As an external person if you do not belong to an organization, you will not see the Organization tab.

In addition to this, the My Rewards page also shows your wallet depicting the total number of your available points
earned through learning badges, achievement badges, impressions, and transferred by peers. For more information, refer
Introducing Wallet.

This expanded leaderboard will help end users see where they stand within their team and organization and will promote
healthy competition and engagement.

Introducing Wallet

This is a new feature. User could earn and view points before but the notion of a wallet was not needed as there was no
option to redeem points within Saba Cloud.

With the introduction to new features like reward redemption and transferring of points, the badges and points are now
displayed separately on the My Rewards and Wallet page, respectively.

Note: You can view your badges by navigating to Me > Rewards.

As an end user, you can access your wallet from ME > My Rewards page. Your wallet shows the points that you have
earned through learning badges, impressions, and transferred from peers. You can keep a track on your reward points
so you know how many points you can give away or use in redeeming for fun items. You can also quickly monitor how
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many points have you received and spent, in case of any discrepancy. In addition to this, you can view your order history
to check your order status or to cancel an order.

On the Wallet page when the Rewards Redemption service is enabled, you can:

• View featured rewards
• Click View All Rewards to purchase and redeem your available points
• View your Points History

• Check the total number of available points
• Check points earned via completion of learning items, impressions, or through Achievement badges
• Check the total number of points given to you by your peers

• View Order History to check your order status or cancel your order
• Transfer points to your peers

Figure 28: Wallet

If the Rewards Redemption service is disabled, you can see only Points Total and Points History.

This allows end user to quickly access reward items, to see their order history for cancellation or reorder, and to see
point history in case they have a question about a past transfer of points.

Share training units agreement with other organizations

A training unit agreement created for an organization can be utilized only by the employees of that organization.
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A new setting Share training unit agreement has been introduced under the Training Unit service. This controls
whether Training Unit Agreements (TUAs) can be set up without a strict organization affiliation. Assuming the setting
is set to Only Selected Training Unit Agreements, a new checkbox called Allow anyone to use this training unit
agreement appears for admin while creating or editing a TUA.

Figure 29: New setting
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Figure 30: New Checkbox

If the setting is set to Never share TUA, then the current behavior is unchanged i.e., a training units agreement is
available only for the employees of that organization. If the setting is set to Only Selected Training Unit Agreements
and the Allow anyone to use this training unit agreement checkbox is selected, then you can control and allow certain
TU agreements to be shared but not all using the agreement number. If the setting is set to All Training Unit
Agreements, then all TU agreements are available to be shared across organizations irrespective of whether the Allow
anyone to use this training unit agreement checkbox is selected or not.

This feature is beneficial for larger extended enterprise users, who have resellers purchasing and reselling training units.
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Assessment
This section describes new features and enhancements related to assessments.

Web accessibility support for assessments

Prior to this update, there was no Web accessibility support for test and survey assessments in Saba Cloud.

This update provides Web accessibility support for test and survey assessments so that the assessment player, which
displays these assessments to users in Saba Cloud, is now Web accessible.

To support Web accessibility for the assessment player, the following new property is added to tests and surveys:

Table 16: Web accessibility property

DefaultDescriptionProperty

NoSet this property to "Yes" to restrict a test or survey to features com~
pliant with Web Content Accessibility Guidelines.

Web Accessibility

If this property is enabled, then:

• The test or survey is required to use only the following player
themes:

• Flexi
• Flexi Plus

• The test or survey is required to use only single question per page.
• The test or survey cannot use questions with attached media.
• The following question types are not allowed:

• Hot Spot
• Matching
• Unequal Matching
• Pulldown

This ensures the assessment player that launches these assessments
is Web accessible.
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Figure 31: Web Accessibility property for tests

To set this property, assessment administrators can navigate to Learning > Manage Assessments > Manage Test &
Survey and edit the required test/survey.

Administrators can make assessments available to users with accessibility requirements.

Content
This section describes new features and enhancements related to content.

Display visual indicator while importing content

Prior to this update, when a learning administrator was importing content, Saba Cloud did not display a visual indicator
to indicate if the content was loading. So, they were not able to understand if the content was being processed or if any
error had occurred.
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With this update, Saba Cloud now displays visual indicators to learning administrators when they import or update
content.

Visual indicators are displayed in the following situations during content import:

When importing new content

When importing new content, Saba Cloud displays the "Importing content" progress indicator.

Figure 32: Importing new content

When saving existing content with or without updates

When saving existing content with or without making any changes, Saba Cloud displays the "Please wait" progress
indicator.
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Figure 33: Saving existing content without updates

To import or update content, navigate to Admin > Learning > Manage Content > Content Library, select the required
content folder and click Import link or edit an existing content.

Note: These visual indicators are displayed irrespective of the browsers used by administrators during import.

Administrators need to know if the content they try to import is uploaded successfully, is in progress or if an error has
occurred during the import.

New mobile compatibility options for content

Prior to this update, mobile device compatibility options could be specified for iOS-based devices and Android-based
devices separately. There was no way to select mobile-device compatibility options for both iOS and Android devices
for content that was compatible with both. So, if the content was meant to be available on large devices or small devices,
then administrators could not specify all large devices or all small devices without mentioning Android or iOS.

With this update, Saba Cloud supports mobile device compatibility of content for all large devices or all small devices,
irrespective of specifying iOS or Android operating systems. The following new options are introduced for mobile
device compatibility:

Table 17: New mobile device compatibility options

DescriptionOption

Select this option if the imported content is meant to be compatible with large
devices such as tablets for both iOS and Android.

All Large Devices-responsive
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DescriptionOption

Select this option if the imported content is meant to be compatible with small
devices such as mobile phones for both iOS and Android.

All Small Devices-responsive

The following functional areas are affected by this change:

• Content Import

While importing content into the content library, administrators can select the new options for Mobile Device
Compatibility field.

Go to Learning > Manage Content > Content Library, select the required folder and click Import.

Figure 34: New Mobile Device Compatibility options in Content import

• Test/Survey Properties

While creating a test or survey, administrators can select the new options for Mobile Device Compatibility field in
the Test Properties tab.

Go to Learning > Manage Assessments > Manage Test & Survey, select the required folder and click New > New
Test/New Survey.
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Figure 35: New Mobile Device Compatibility options in Test/Survey properties

• Data Import

The Bulk Content Import object is modified so that the MOBILECOMPATIBILITY field now provides support
for the following new values:

• allLargeDevices
• allSmallDevices

Content creators need to build platform-independent content meant only for tablets or only for small hand-held devices.

Limit number of contents shown per content folder

Prior to this update, when administrators browsed a content folder in the content library, Saba Cloud used to retrieve all
contents in the content folder and display them in the results. This affected the performance of the application especially
when the number of contents in the folder were very large.
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With this update, Saba Cloud now provides the ability to limit the number of contents displayed in a content folder when
administrators browse the folder in the content library.

The following new site-level property under Content is now available for System administrators:

Table 18: New Content site-level property

Default ValueDescriptionProperty

2000Defines the maximum number of contents displayed in
each content folder in the content library while browsing
the folder.

Number of contents shown per
content folder

To access the new property, navigate to System > Configure System > Microsites > <default_site> > Properties >
Content.

Configuring this property does not affect any other functionality such as search or export of contents.

Administrators need to see contents in a content folder without any delay even when the folder contains large number
of contents.

CMI5 content support

Prior to this update, Saba Cloud did not support the CMI5 content format.

With this update, Saba Cloud now supports the CMI5 content format.

This allows content administrators to import CMI5 content into the content library. To import CMI5 content, go to
Learning > Manage Content > Content Library, select the required folder > click Import and select "CMI5" from
the Content Format dropdown list.
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Figure 36: CMI5 content import

Saba Cloud supports the following for CMI5 content:

• Supports CMI5 for CIF services used by the Saba Publisher
• Stores LRS statements similar to the way it does for Tin Can content

Supported Verbs

The following xAPI verbs are supported in the CMI5 specification:

• Launched
• Initialized
• Completed
• Passed
• Failed
• Abandoned
• Waived
• Terminated
• Satisfied

Catalog administrators can now attach CMI5 content to classes. To attach CMI5 content, go to Learning > Manage
Classes > Classes > Edit the required class > Activities > Add Activities > Attach Content and select "CMI5" from
the Content Format dropdown list and search.
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Figure 37: Attach CMI5 content to class

Learners can launch a CMI5 content attached to their class. The launch attempt and scoring behavior for CMI5 content
is different from other content formats supported by Saba Cloud as follows:

• Once CMI5 content is passed successfully by a learner, the content score for that attempt is displayed on the class
details and results pages. Any subsequent attempts on the same content, even with higher scores by the learner, are
not considered and displayed.

• Once CMI5 content is passed successfully by a learner, any subsequent attempts on the same content displays the
content status in the View Results page as Reviewed.

Figure 38: CMI5 content attempts and results in class

Changes to existing LRS statements

As part of this change, the word "tincan" is replaced by the word "learning" for Tin Can content in LRS statements for
learners and administrators.
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Figure 39: LRS statement update

Limitations

Currently, CMI5 content format has the following limitations in Saba Cloud:

• No Saba Anywhere support
• No support for bulk content import using data import
• No mobile support

In addition to support for xAPI statements within content (similar to Tin Can), CMI standards also provide better
interoperability for LMS and content providers.

Saba LRS is ADL conformant

Prior to this update, the Saba LRS (Learning Record Store) was not conformant to ADL (Advanced Distributed Learning)
guidelines.

With this update, the Saba Cloud LRS is now certified as an ADL (Advanced Distributed Learning) conformant LRS.

Saba is now listed in the xAPI Adopters and Conformant LRS registry on the ADL Website.

• xAPI Adopters: https://adopters.adlnet.gov/adopters/0
• Conformant LRS: https://adopters.adlnet.gov/products/all/0

Note: To adhere with ADL conformance guidelines, users using an external LRS must send only valid xAPI
statements.

ADL offers conformance certificate to LRSs. This allows organizations that are developing or acquiring an LRS to
ensure it fully adheres to the xAPI specification, which aids developers, and Federal agencies, and the broader community
as they seek to implement xAPI-conformant systems.
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Learning Activity
This section describes new features and enhancements related to learning activities.

Display visual indicator for attending virtual class sessions

Prior to this update, Saba Cloud did not display any visual indicators to learners indicating they attended sessions in a
Virtual Classroom. The class details page only displayed the status of past sessions where user attended fully, as "Not
evaluated".

If a learner has launched or attended a session in a Virtual Classroom, then the details page of the Virtual Classroom
now indicates the same using a visual indicator in the Status column as shown in the image below:

Figure 40: Visual indicator for launching VC sessions

The Launched visual indicate remains visible till the session status is Not evaluated. If the class is marked completed
but sessions are still in Not evaluated status, then too the visual indicator is displayed. The completion status of the
Virtual Classroom changes to "Evaluated" only after all sessions in the classroom are attended by learners and the
indicator is no more displayed.

Learners need to be clearly indicated when they have attended a session in a Virtual Classroom with multiple sessions.

Display event ID for sessions in WebEx virtual classes

Prior to this update, Saba Cloud did not display any event ID for WebEx sessions in Virtual Classrooms.

With this update, Saba Cloud provides an ability to display the event ID for WebEx sessions in Virtual Classrooms.

The Saba Cloud "admin" user can enable the display of event ID for WebEx sessions in Virtual Classrooms.
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Note:  By default, this feature is disabled. To enable this feature, submit a request. For more details, contact Saba
support.

Once enabled, the Event ID column is displayed for WebEx sessions. Learning administrators can view the event ID
by navigating to Learning > Manage Classes > Classes, search for the required WebEx virtual class and edit the class
and go to the Activities tab. For the required WebEx session, click Actions > Edit Activity Details. The Session Details
table displays the Event ID column.

Note: This column is displayed only for WebEx sessions. It is not available for sessions created using other VLE
providers.

Figure 41: Event ID column for WebEx sessions

Users can use this event ID as the access code to dial into WebEx meetings.

Saba Cloud allows the telephony option from Virtual Classrooms for WebEx. Thereby, it is possible to create WebEx
sessions with conference number and access code. The access code is generated by WebEx, and not Saba. This access
code from WebEx Meetings needs to be made available in Saba Cloud so that participants can see the access code and
use the code to dial-in.

Restrict leaders from deleting events created via virtual classes

Prior to this update, Saba Cloud allowed virtual event leaders to delete events created via virtual classes from the
following flows in Saba Cloud:

• Me > Plan >Meetings > Actions
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Figure 42: Delete from Plan

• Me > Plan > Meetings > Edit a meeting > More actions

Figure 43: Delete from meeting details page

• Me > Meetings > Upcoming Meetings
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Figure 44: Delete from Upcoming Meetings

• Search results for virtual events in global search

Figure 45: Delete from global search results

This update removes the ability of virtual event leaders to delete events created via virtual classes by removing the
Delete button from the following flows in Saba Cloud:

• Me > Plan >Meetings > Actions
• Me > Plan > Meetings > Edit a meeting > More actions
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• Me > Meetings > Upcoming Meetings
• Search results for virtual events in global search

Note: This change does not affect ad hoc meetings. Leaders can still see the Delete button for ad hoc meetings
and delete those meetings.

When a virtual classroom is created via VLE integration to Saba Meeting, WebEx, or Adobe, a corresponding event is
created in the virtual event provider. Ideally, a virtual event must be deleted only if the corresponding virtual class is
cancelled from Saba Cloud. The event must not be deleted in any other way and by any other person such as the event
leader.

Adjust the Saba Meeting event seat count on adding or removing
instructors to a virtual class

A Saba Meeting event is created when a virtual class is created in Saba Cloud. Prior to this update, the Saba Meeting
enrollment limit on the server side was set as one more than the max enrollment count of virtual class. However, when
multiple instructors were added to a virtual class after the class was saved in Saba Cloud, the instructors occupied the
seats for attendees, thereby reducing the seat count of learners attending the corresponding Saba Meeting event.

With this update, Saba Cloud ensures that adding or removing instructors to a virtual class in Saba Cloud does not affect
the seat count of learners attending the corresponding Saba Meeting event. Now, the Saba Meeting event seat count is
increased or decreased on the server side when an instructor is added to the virtual class or removed from it.

With this change, the max seat count for a virtual class on the Saba Meeting server is calculated as:

Max Seat Count of Saba Meeting event = Max Count of Saba Cloud Virtual Class +
Number of Instructors Added to the Virtual Class + 1

Similarly, if the instructors are removed from the class, then the seat count for the corresponding Saba Meeting event
is decreased accordingly without affecting the count of attendees.

Example

The virtual class Advanced Java in Saba Cloud has a max seat count of 20. Then the seat count of the corresponding
Saba Meeting event is 21 (20 + 1). If you add 4 instructors to this class in Saba Cloud, then the new seat count in the
Saba Meeting event becomes 25 (21+4). If 2 instructors are removed at a later time, then the new seat count in the event
becomes 23 (25-2). Thereby, learners attending the Saba Meeting event are not affected.

The number of learners attending a Saba Meeting event should not be affected even if the number of instructors are
increased or decreased in the corresponding virtual class in Saba Cloud.

New named queries for organization managers

Prior to this update, many learning notifications for managers and alternate managers did not provide the option to
include named queries for organization managers. So, organization managers were not notified when necessary.
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This update enhances the following notifications so that they now include the following named queries for organization
managers:

Table 19: New named queries

ServiceNamed QueryNotification

ILT ClassList all confirmed registered learner or~
ganization managers for this class

Instructor-Led Class Cancelled

List all registered learner organization
managers for this class

CertificationOrganization Manager of the LearnerLearner Certification Expiration in X days Re~
minder

Organization manager of learner with
valid certification requirement

CertificationOrganization Manager of the LearnerLearner certification is Expired

Organization manager of learner with
valid certification requirement

ILT ClassList all registered learner organization
managers for this class

Change StartDate/SessionTemplate of Instruct~
or-Led Class

List all organization managers of intern~
al registered learners whose registrations
are open

To access these new named queries, navigate to System > Configure System > Services, edit the required service and
go to the Notifications tab.

For many organizations such as the automotive dealership industry, the Organization manager role fits a very critical
need. Thereby, organization managers need to be notified so they take the nrequired actions and manage critical processes
more effectively.

Manually trigger status change of certifications, curricula and
recurring courses
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Prior to this update, Saba Cloud supported status change of certifications, curricula and recurring courses for learners
only via periodic notifications. However, this status change would be hampered if notifications were not configured
correctly, or if configured were not processed. In such cases, administrators did not have an option to manually trigger
this status change for learners.

This update now provides learning administrators with the ability to manually trigger status change of certifications,
curricula and recurring courses for learners directly from the Saba Cloud interface.

Note: This is applicable only to active certifications, curricula and recurring courses.

To manually change the completion status of learners, click the Recalculate Learners' Completion Status button on
the Certification/Curriculum Details page.

The Recalculate Learners' Completion Status button is also introduced for recurring courses.

Clicking the Recalculate Learners' Completion Status button now opens a new popup page with the following options:

Table 20: Recalculate Learner Status

Applicable toDescriptionOption

Allows you to manually recalculate completion status of
all learners associated with the certification/curriculum.

Recalculate Learners'
Completion Status

• Certification
• Curriculum

This process continues to run in the background. On com~
pletion, all learners' completion status is updated to reflect
recent changes made to the certification/curriculum.

Note: This is the existing behavior. Prior to this up~
date, this behavior was triggered on clicking the Re~
calculate Learners' Completion Status button.

Allows you to manually trigger the status change of certi~
fication/recurring course to Reacquisition Required.

Re-acquisition
• Certification
• Recurring course

Note:  If the Recertification service is disabled, then
the Re-acquisition option is not available for certific~
ations, but available for recurring courses.

Allows you to manually trigger the status change of certi~
fication/curriculum to Overdue.

Overdue
• Certification
• Curriculum

Allows you to manually trigger the status change of certi~
fication/recurring course to Expired.

Expire
• Certification
• Recurring course

Note: When the "Cascade Expiration/Revoke" setting
for certifications is enabled and expiration for a child
certificate is in progress, the Expire option for the
parent certification is disabled.
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Figure 46: Recalculate Learner Status Manually for Certifications

Learning administrators can access this button from Learning > Manage Learning Catalog > search and edit a
certification/curriculum/recurring course > Main tab on details page.

Note:

• The new manual status change options are not available on the Recalculate Learners Completion Status
popup page for certifications/curricula in Draft, Obsolete, or Discontinued state.

• For recurring courses in Discontinued state, the Recalculation Learners Completion Status button itself is
not displayed.

• If a system-level notification is already processing a certification, curriculum, or recurring course for a particular
status change (recertify, overdue or expire), then the corresponding option is disabled for manual change.

• Similarly, when a status change that is triggered manually, Saba Cloud locks the record till completion. If the
lock is not released even after completion due to some unknown reason, then Saba Cloud releases the lock after
24 hours. Locked records are not available for user-triggered or periodic notification processing.

• If you manually trigger a status change for a certification, curriculum, or recurring course and a periodic
notification is run while the manual change is in progress, then the notification skips processing of all records
where manual action is in progress.

• For recurring courses, this updates introduces a new audit action Actions Manually Triggered on Recurring
Courses to audit the new status change options. This action is available under Course > Component > Offering
Template and is applicable only for recurring courses, not for normal courses. For certifications/curricula, the
existing audit action for Recalculate Learners Completion Status now works even for the new status change
options.

Administrators need to manually change status of certifications, curricula and recurring courses. This is required to
provide a fallback mechanism in cases where predefined notifications are not triggered due to some reason, and to allow
administrators to change status of specific certifications, curricula or recurring courses outside of the notification cycle.

Display visual indicator for in-progress recurring course without
registration

Prior to this update, if a learner had registered for a recurring course but not completed it, then the course moved to
"In-progress" status. Then, if the recurring course was dropped midway, its status on the learner's plan did not change
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to "Assigned"; instead, it remained as "In-progress". As a result, learners were not indicated if they needed to register
again for the recurring course.

This update now displays a "Registration Required" visual indicator for learners whose recurring course is in "In-progress"
status without any registration as shown in the image below:

Figure 47: Registration Required visual indicator on course details page

This visual indicator is displayed on the following pages:

• My Plan
• Course Details
• My Learning Portlet
• To-Do list

Additionally, now all such "In-progress" recurring courses where registration is required again by the learner, are
displayed under the "Pending Registration" Status filter for the "Course" Type on the learner's My Plan page.

Figure 48: Plan page
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The application must clearly indicate learners when their in-progress recurring course is dropped. This will lead to a
more logical user experience and a reportable outcome.

Manually reconcile job role for learning items

Prior to this update:

• Learning items inside a job-role were not pushed to learner via job type having that job role.
• Learning items inside a role were not pushed to learners via ad hoc role where learners had that ad hoc role.
• Although learning items inside a role were removed, the items were still displayed in the profile of learners with the

role as the source.
• Although the role was removed from a job, learning items pushed via job-role were still in learner's profile.
• Although the job was removed from a learner, learning items pushed via job-role were still in learner's profile.

With this update, Saba Cloud provides the ability to manually reconcile a role so that any learning items in the role or
job-role combination can be added or removed from learners associated with that job-role.

HR administrators can click the new Role Reconcile button on the Main tab of the role details page to reconcile a role.

Figure 49: Role reconcile for learning items
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When a role is reconciled:

• Learning items added to the role are pushed to the learners associated with that role.
• Similarly, any learning items removed from the role are removed from the profile of learners associated with that

role.
• If there are multiple sources of assignment for the learning items, then only the reconciled job-role is removed as

the source; other sources are not affected.
• If a role is changed from optional to required, and that role is reconciled, then the learning item in that role must be

added to the learner's profile.

Role reconciliation does not support changing of learning items from mandatory to non-mandatory or vice-versa in a
role. HR administrators have to delete the learning items, reconcile the role, change the mandatory flag for the learning
items, and then add them back to the role and reconcile the role again to reflect the change.

Learning items assigned to learners via job roles must be reflected as per changes to the role. Administrators need the
ability to manually push such changes to learning items in a role, in case the changes do not happen automatically.

Display mandatory custom fields when adding external/completed
learning to plan

Prior to this update, even if a custom field was marked as "Is Required" on the Course component, it was not displayed
to learners when adding an external or completed learning to their plan. Resultantly, when learners tried to add the
learning, Saba Cloud displayed an error.

If a custom field is marked as "Is Required" on the Offering Component (Course) component, then Saba Cloud now
displays the mandatory custom field to learners when adding an external or completed learning to their plan. Learners
cannot proceed further without populating the field.

This ensures no error is generated for mandatory custom fields, irrespective of their default values.

To add an external learning to your plan, navigate to Me > Plan > Actions > Add External Learning / Add Completed
Course > Add New or Search Existing.

For example, a custom field "C_String" is marked as Is Required on Offering Template (Course) component and has
no value set in the Default Value field.
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Figure 50: Mandatory custom fields with no default value on Course component

When learner tries to add a new external or completed learning to the plan, the "C_String" custom field is now displayed
as a mandatory field, which learner must fill to proceed further. When the learner specifies a value for the field and
proceeds, no error is received.
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Figure 51: Mandatory custom fields with no default values

Learners must be able to add external or completed learning with mandatory custom fields to their plan without facing
any errors.

Configure ribbons in Discover portlet

Prior to this update, there was no option to configure the display of ribbons in the Discover portlet on a user's Home
page.

This update provides system administrators with the ability to configure the display of ribbons in the Discover portlet
on a user's Home page.

The following new service and settings are now available:

Table 21: New service

Default ValueDescriptionService

OnControls the display of ribbons in the Discover portlet on the
Home page of users. This portlet displays various ribbons such

Discover Portlet

as Top Rated Learning, Microlearning, Saved For Later, and
so on if the respective settings in the service are enabled.

The Discover Portlet service itself is not configurable. System
administrators can only configure the visibility of ribbons in~
side the portlet through the different settings under the service.
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Default ValueDescriptionService

Table 22: Settings under Discover Portlet service

Default ValueDescriptionSetting

OnEnable this setting to display the Top Rated Learning
ribbon in Discover portlet.

Display Top Rated Learning ribbon

On
Enable this setting to display the In-Progress Learning
ribbon in Discover portlet.

Display In-Progress Learning ribbon

On
Enable this setting to display the Hot Learning (Overdue
and Mandatory) ribbon in Discover portlet.

Display Hot Learning (Overdue and
Mandatory) ribbon

On
Enable this setting to display the Shared With You ribbon
in Discover portlet.

Display Shared With You ribbon

On
Enable this setting to display the Topics You Are Follow~
ing ribbon in Discover portlet.

Display Topics You Are Following
ribbon

On
Enable this setting to display the Bite-Sized Content
(Microlearning) ribbon in Discover portlet.

Display Bite-Sized Content (Mi~
crolearning) ribbon

On
Enable this setting to display the Saved for Later ribbon
in Discover portlet.

Display Saved For Later ribbon

To configure ribbons in the portlet, navigate to System > Configure System > Services > Foundation > Discover
Portlet.

Note:  Enabling or disabling a ribbon setting works only if the corresponding service for each ribbon is enabled.

Administrators need the ability to configure the visibility of individual ribbons on the Discover portlet for users.

New ribbons in Discover portlet

N/A

This update introduces the following new ribbons in the Discover portlet on a user's Home page:
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Table 23: New ribbons in Discover portlet

DescriptionAttribute

This ribbon in the Discover portlet displays any learning that is overdue within
the last 15 days and not yet completed by the learner, or that is due within the
next 15 days.

Hot Learning (Overdue and Man~
datory

For mandatory items, the ribbon displays a visual indicator.

For overdue items, the ribbon highlights the Due Date.

This ribbon in the Discover portlet displays any learning that has been started
by the learner but is not completed.

In Progress Learning

For following is applicable for both ribbons:

• The learning items are displayed by their due date so that most urgent items are displayed on the left-most side of
the ribbon; however, items that do not have a due date are also displayed on the ribbon.

• The ribbons display a Go to Plan link, clicking which take the learner to their plan.
• The maximum items displayed in the ribbons is 20, which is the limit for existing ribbons as well.

Figure 52: In-progress and Hot Learning ribbons

To enable the display of these ribbons, system administrators must enable the following:

• Display Hot Learning (Overdue and Mandatory) ribbon setting under Discover Portlet service
• Display In-Progress Learning ribbon setting under Discover Portlet service
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Learners need to quickly see their overdue, mandatory and in-progress learning items in the Discover portlet of their
Home page so they can take appropriate actions immediately.

Modified label in catalog search results column

Prior to this update, the title of a column related to certifications in catalog search results was Notify Before (Days).

With this update, the title of the column related to certifications in catalog search results is changed to Send Reminder
(Days).

Figure 53: Modified label for column in search results

Note: This change is also reflected in the Analytics reports and data model where the Certification Notify Before
(Days) dimension is now displayed as Certification Send Reminder (Days).

There is a need to enhance the consistency of labels between different pages of the application.

Simplified Course Creation
Simplifying the course creation process, makes it easy for users other than catalog administrators (for example, SMEs,
managers, or local learning leaders), to create a course without diving into its complexities. This helps decentralized the
course creation process and provides more flexibility and scale across different learning programs.

 | Learning | 109



Course templates

Learning administrators did not have the ability to create a template for courses.

This update now allows learning administrators to create course templates. Course templates allow administrators to
define basic fields, custom fields and notifications of a course, delivery mode and WBT class all in one go, and then
make them available to users for creating courses using the new simplified course creation workflow.

Only users with appropriate security privileges on the following component can create a course template:

• Web-Based Class

The following table lists the security roles and the default privileges granted to the roles on this component:

Table 24: Default security roles and privileges associated with Web-Based Class

Enabled?PrivilegeSecurity Role

YesCan Create Course TemplateSuper User

YesCan Edit Course Template

YesCan View Course Template

YesCan Delete Course Template

YesCan Create Course TemplateLearning Admin - Catalog Builder

YesCan Edit Course Template

YesCan View Course Template

YesCan Delete Course Template

YesCan View Course TemplateLearning Admin - Local Catalog
Admin

To view this component, navigate to System > Manage Security > Security Roles, search for and edit one of the role
and search for the component.

Templates can be saved in any domain. Users with "Learning Admin - Local Catalog Admin" security role can use
course templates based on domain security.

If any field is marked as required at the component level, then these fields are displayed as required in the template and
cannot be changed to optional, unless a default value is set.

To create a new course template:

1. Go to Learning > Manage Learning Catalog > Course Templates.

The Manage Course Templates page appears.
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Figure 54: Manage Course Templates page

2. Click the New template link.

Figure 55: New Template page

3. Provide the course template details such as template name, description, and domain.
4. Specify details in the following sections:

• Basic Details

Includes the basic fields of a course. You can include or exclude fields, specify their default values, and mark
them as required or optional while creating the template. If a field is marked as Required, then you cannot clear
the Visibility checkbox without providing the default value.
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Figure 56: New Template - Basic details

• Custom Details

Includes any custom fields for any modified components. You can include or exclude fields for each component,
specify their default values, and mark them as required or optional while creating the template.

Note:

• If the Data Types of custom fields are changed at the "Offering Template", "Delivery Type" or "WBT"
component level, then the simplified course creation does not work because of the conflict between data
type at the component level and the one used by the course template.

This is true in both the scenarios noted below:

• When you change the data type of a custom field at the component level and then try to create a new
course using the course template, an error occurs.

• When you create a course template and then change the data type of a custom field at the component
level, you cannot use that course template while creating a new course.

• Extended custom fields are not supported.
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Figure 57: New Template - Custom details for Course

Figure 58: New Template - Custom details for Class

• Notifications

Includes notification events configured at the course level. You can enable or disable them while creating the
template.

Figure 59: New Template - Notification details
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5. To save a draft for further editing, click the Save as Draft button. Templates in the Draft status are not available for
selection during course creation.

6. To save and make the template available for use, click the Save and Activate button. Templates in the Active status
are available for selection during course creation.

The ability to create a template allows administrators to make the simplified course creation as simple or complex, as
required by organization needs. The system can determine the fields that must be exposed to the user through the
simplified course creation workflow. Predefining a course template allows them to simply select the required template
and proceed with minimum changes, thereby minimizing repeated effort and time.

Synchronize course template values with related component
attribute changes

N/A

The new Course Template introduced in this update is synchronized with any changes made to the following components:

• WBT
• Delivery Type
• Offering template (Course)

Saba Cloud triggers synchronization of values for the Course template:

• When the course template is accessed for the first time by users after a major update
• When any attribute value in any of the above-noted components is changed

If an attribute is not unified (that is, unique to a component), then the attribute value is taken from the updated component.

If an attribute is unified (that is, the same attribute exists across multiple components; for example, "Description"), then
Saba Cloud takes the property value from the WBT component. For such unified attributes, Saba Cloud uses the following
precedence rules for updating attribute values:

Table 25: Precedence rules for unified attributes

Precedence RuleAttribute Value Type

If all components are in sync for that attribute overwrite, then the value on the template
are taken as per component. Else, it is considered as single-valued attribute and is set
as single-valued on the component.

Multivalued

Default values in templates are inherited from their respective Component defaults in
the following order - WBT, Delivery Mode and Offering template.

Default Value

Takes minimum of WBT, Delivery Mode and Offering Template.Min Value

Takes least value of WBT, Delivery Mode and Offering Template.Max value

Takes value from any of WBT, Delivery Mode and Offering Template.Display
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Precedence RuleAttribute Value Type

"Is Required" on any attribute is considered as required everywhere (All templates
and default template).

Is Required

Take minimum size of the WBT component (All templates and default template).Size

Takes least value of WBT, Delivery Mode and Offering Template.MaxSize

Any changes to course-related component attributes need to be saved to the predefined course templates.

New Local Catalog Admin security role

N/A

This update introduces the Learning Admin - Local Catalog Admin predefined security role in Saba Cloud.

The new predefined security role is designed to create courses using the new simplified course creation workflow. Users
with this security role can create course via the New Course portlet and the Courses I Manage page. To view this role,
navigate to System > Manage Security > Security Roles.

The new Learning Admin - Local Catalog Admin security role has the following predefined configuration:

Table 26: Security privileges for Learning Admin - Local Catalog Admin role

Enabled?PrivilegeComponent

YesNewContent Inventory

YesEdit

YesDelete

YesView

YesChange Domain

YesNewWBT Offering

YesEdit

YesDelete

YesView

YesChange Domain

YesChange Display for Web and Call Centre
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Enabled?PrivilegeComponent

YesNewOffering Template

YesEdit

YesDelete

YesView

YesChange Domain

YesChange Availability

YesChange Enable

YesChange Course number

YesChange List Price

YesChange Max. Discount

YesChange Min. Confirmations

YesChange Max. Confirmations

YesChange Max. Bookings

YesChange Language

YesChange Roster Template

YesChange Display for Web and Call Centre

YesCan Local Catalog Admin Gamify Course

NoCan Local Catalog Admin Add Points to Gamified
Course

YesViewDelivery Mode

YesNew

YesEdit

YesIs Local Catalog AdminSystem

NoCan Local Catalog Admin use Template

NoCan Assign learning activity to othersPerson, Internal

NoCan Manager View Results of Learners
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Enabled?PrivilegeComponent

NoCan Administrator View Results of Learners

YesViewCourse Template

YesViewDerived Component

YesCan add items to price listPrice List

YesCan view items of price list

YesCan remove items from price list

YesNewQuestion Pool Folder

YesEdit

YesDelete

YesView

YesQuestion Editor

System administrators can copy the role and modify it to suit their organization requirements. They can enable the
privileges, which are disabled by default, to expand the capabilities of the Local Catalog Admin.

Additional changes to existing components and security roles

To support this feature, the following new security privileges are granted to the existing Learning Admin - Catalog
Builder role:

Table 27: Security privileges for Learning Admin - Catalog Builder role

Enabled?PrivilegeComponent

YesNewQuestion Pool Folder

YesEdit

YesDelete

YesView

YesQuestion Editor

Users need the ability to create and manage courses in a simplified way.

Simplified course creation
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Prior to this update, Saba Cloud allowed only learning administrators to create courses in the system. Other users could
not create courses for themselves.

Saba Cloud now also allows users other than learning administrators, who have access to the following new predefined
security role, to create and manage courses using the new simplified course creation workflow.

• Learning Admin - Local Catalog Admin

If you are assigned this role, then you can create a new course from the following areas:

• Courses I Manage menu

You can view the new Courses I Manage menu under the ME tab.

Figure 60: Courses I Manage menu

Clicking this menu displays the Courses I Manage page. From this page, you can search for any existing courses
using search filters or create new ones using the New Course button.
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Figure 61: Courses I Manage page

• New Course portlet

You can also view the new New Course portlet on the Home page.

Figure 62: New Course portlet

To start creating a new course, just drag and drop the required file from your file explorer on to the portlet or
click the Create New Course button.

Creating a course

Using either of the ways noted above, you can create a new course. Select a course template from the ones available to
you. This opens the course edit form with prepopulated course fields. Make the required changes to prepopulated fields,
fill in other sections, and save your changes. Saba Cloud creates a new course in the Draft status. You can activate the
course to make it available.

A course created using this workflow contains the following sections:

• Basic Details

Prepopulated section with details sourced from the selected course template.
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• Course Other Information, Class Other Information and Delivery Mode Other Information

Prepopulated section with details sourced from the underlying course, WBT class and delivery mode.

• Sections and Activities

You can create multiple sections in the course, and add different types of activities such as files, URLs and tests to
each section. To add an activity, either click the activity type button or drag the required activity type button from
the left pane and drop it in the right pane. For example, to create a new test and add it to the section, drag the Create
New Test button and drop it in the right pane. This opens the Create New Test popup page.

Or, if you used the New Course portlet to create a course using the drag and drop option, the file you dragged and
dropped on to the portlet is already added to the section.

Currently, you can only add up to six sections to a course with up to eight activities per section.

Figure 63: Sections and Activities

• Badges and Points

If you select the Gamify this course checkbox, then this section is displayed for the course.

Note: This checkbox and the section is available to you only if:

• You have the "Can Local Catalog Admin Gamify Course" privilege on "Offering template" component.
• The Rewards service is enabled for your domain by the system administrator.

This section allows you to add badges and points to your course. By default, the following predefined badges are
added to the course:

• Completion Badge

This badge uses the existing Learning context.

You can edit this badge and replace it with any one of the existing learning badges to associate them with the
course.

• On Time Completion Badge
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This badge is awarded when a person successfully completes a course on time. Points may or may not be associated
to the badge.

• First Try Badge

This badge is awarded when a person completes a test successfully the first time from within the gamified course
workflow. It can be awarded more than once in a course depending on the number of tests added to the course.
Points may or may not be associated to the badge.

Note:  Currently, HR administrators can only view achievement badges; they cannot create them.

You can choose to associate points with badges by clicking the Allow points slider. You can see this slider only if
you have the "Can Local Catalog Admin Add Points to Gamified Course" privilege.

All associated badges and points if any, are awarded only on successful completion of the course.

Figure 64: Badges and Points

• Course Notifications

Prepopulated section with details sourced from the selected course template. You can enable or disable a notification
to suit the needs of your course.

Viewing course details - Admin view

To view details of a course, Local Catalog Admin can go to Me > Courses I Manage and search for the course. Click
the course name title to open the course details page. Depending on the course status, the course details page view varies.

For a course in the Draft state, the details page displays the Edit Course and Activate buttons.
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Figure 65: Course details - Draft state

For a course in the Active state, the details page displays the Edit Course button and an additional Learners in this
course section. This section contains Assign Course and See all learners links. These actions and the data they display
are governed by following privileges on the Person, Internal component:

Table 28: Privileges

DescriptionPrivilege

Users with this privilege can assign the course via the Assign Course link
on the course details page.

Can Assign learning activities to others

Users, who are Manager/Alternate Manager/Organization Manager and
who have this privilege, can view the course status of their team members
who have been assigned, in progress, dropped or completed the course.

Can Manager View Results of Others

Users, who are not Manager/Alternate Manager/Organization Manager
and who have this privilege, can view the course status of all learners in

Can Administrator View Results of
Learners

their domain who have been assigned, in progress, dropped or completed
the course.
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Figure 66: Course details - Active state

Viewing course details - Learner view

Learners can either search for a course in the learning catalog using global search and enroll for it, or the Local Catalog
admin can assign a course to them using the simplified course creation workflow.

Click the course name title to open the course details page. Learners can view activities in the course and take action
on them.
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Figure 67: Course details page for learners - In-progress Course

Figure 68: Course details page for learners - Completed Course

Users need the ability to create courses without sending request for their creation to learning administrators.

Identify gamified courses

Prior to this update, only HR administrators had the ability to associate Learning badges with courses.
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With this update, Saba Cloud now allows Local Catalog Admin users to associate both, the existing Learning badges
and the new "Achievement" badges with courses created using the new simplified course creation workflow. Learners,
who successfully complete such courses, are awarded the badges and points associated with them.

The following badges can be added to the course using the simplified course creation workflow:

• Completion Badge

This badge uses the existing Learning context.

You can edit this badge and replace it with any one of the existing learning badges to associate them with the course.

• On Time Completion Badge

This badge is awarded when a person successfully completes a course on time. Points may or may not be associated
to the badge.

• First Try Badge

This badge is awarded when a person completes a test successfully the first time from within the gamified course
workflow. It can be awarded more than once in a course depending on the number of tests added to the course. Points
may or may not be associated to the badge.

Note:  Currently, HR administrators can only view achievement badges; they cannot create them.

A gamified course is distinguished from a non-gamified course by a "cup" icon as indicated in the image below:

Figure 69: Gamified courses in search results

The "cup" icon indicates that a course is "gamified", whereas the number besides the "cup" indicates the points associated
with the course.

The course details page of a gamified courses displays an additional Potential Rewards portlet. This portlet displays
badges and points associated with the course. The following gamification details are displayed:

• Total badges
• Total points
• Badge count for each badge

You can scroll through the badges to see details of each badge.
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Figure 70: Potential Rewards section

There is a need to clearly distinguish courses that support rewards from the ones that don't.

Enhanced notifications for courses and classes

N/A

This update enhances certain course and class related email notifications so that they now:

• Contain predefined event actions
• Follow standard notification themes

The following table describes the predefined event actions and themes for affected notifications:

Table 29: Enhanced notifications

Theme/TemplatePredefined Event ActionNotification

ConfirmationalNotify course creator and course owner when
course is created.

Course Created

InformationalNotify course learner and learner's manager when
course is added in learner's plan.

Course added to profile

Must do - UrgentNotify course learner and learner's manager that
course is due today.

Course due today
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Theme/TemplatePredefined Event ActionNotification

Must doNotify course learner and learner's manager when
course is due in 15 days.

Course due in 15 days

Must doNotify course learner and learner's manager when
course is due in 30 days.

Course due in 30 days

InformationalNotify course learner and learner's manager that
Target date changed for a course in a learner's plan.

Target date changed for a course in
a learner's plan

Must do - UrgentNotify course learner and learner's manager that
course is overdue.

Course overdue by X days

CongratulatoryNotify course learner and learner's manager that
learner completion status is marked Successful.

Learner Completion Status marked
Successful

A few sample notification images with new themes are shown below:

Figure 71: Course Created event with Confirmational theme
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Figure 72: Learner Completion Status marked Successful event with Congratulatory theme

To access these enhanced notifications, navigate to System > Configure System > Services, edit the required service
and go to the Notifications tab.

Notes

• By default, the new predefined event actions are disabled for the affected notifications. Thereby, existing users who
are using these notifications are not affected by this change.

• The theme changes do not apply to Message Center notifications.

Many organizations have a need for more robust and visually appealing notifications.
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Marketplace

Topics:

• Activation key for Workday
connector

• Expire Lynda content based on
the list from Lynda



Activation key for Workday connector

In the past, Workday connectors did not require an activation key.

Starting from this update, all Workday connectors require the Activation key to enable the connection.

New Workday users can choose a free trial of 30 days or purchase the activation key from Saba.

Figure 73: Workday Start free trial
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Figure 74: Workday free trial expiration

A system generated key is provided to the user and this activation key must be entered in the required field for the system
to save the configuration. Before making any request to the vendor system, Saba will verify if the activation key is still
valid. Once that is confirmed, the connector to the vendor will become available.

For existing users, who have configured Workday the activation key will be set by default. The activation key will be
valid until the customer's contract renewal date. .

Figure 75: Workday activation screen
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Existing and new Workday connectors will now require an activation key to enable the connector.

Expire Lynda content based on the list from Lynda

Currently, Saba Cloud determines the content to expire based on the content list from Lynda that was a combined list
of expired and active content. This method can lead to some inconsistencies.

With this update, to avoid errors and inconsistencies, an active content list and an expired content list is provided by
Lynda and based on that information the content is also expired from Saba Cloud.

Saba Cloud now expires content only based on the expired content list provided by Lynda.

 | Marketplace | 132



Chapter

7

Meeting

Topics:

• Remove purged Saba Cloud
users from Saba Meeting



Remove purged Saba Cloud users from Saba Meeting

After a terminated user was purged in Saba Cloud, if the corresponding user existed in Saba Meeting, then the user was
not removed from Saba Meeting.

This update provides the ability to remove users from Saba Meeting when the corresponding users are purged in Saba
Cloud from the following work flows:

• A user profile is purged from the People administration work flow
• The Purge Terminated Persons notification is triggered

Note:  If a user profile was purged in Saba Cloud before this update, then the corresponding user profile is not
removed from Saba Meeting.

The purged users are removed from Saba Meeting using the following internal SMF jobs:

Table 30: SMF jobs

DescriptionJob

This job is responsible to process a purge request.
Centra Asynchronous Process to Purge User

• If the purge process is successful, then the record is deleted
from Saba Meeting

• If the purge process returns error, then the error is logged for
record or reprocessing.

This job is responsible to re-process a purge request. It picks up
records that failed or are stuck on a previous date.

Centra Asynchronous Process to Retry Purge User

• If the purge process is successful on retry, then the record is
deleted from Saba Meeting

• If the purge process returns error on retry, then the error is
logged for record or reprocessing.

• The retry defaults to a maximum of three tries, post which
the reprocessing is stopped.

Note: To trigger these SMF jobs, the Meeting service must be enabled when terminated users are purged in Saba
Cloud.

You can ensure if users are removed from Saba Meeting by navigating to System > Monitor Background Jobs > Job
Dashboard and view details for the corresponding SMF jobs.
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Figure 76: SMF jobs to remove purged users from Saba Meeting

Batch Processing Purged Profiles

Saba Cloud uses the existing "CMS Bulk Profile Sync Batch Size" site-level property to split the list of Saba Cloud
purged users into batches and trigger the SMF jobs batch-wise. The default value is 10, which means a batch of 10
purged users is processed by the SMF jobs to remove them from Saba Meeting.

Saba Cloud "admin" users can configure this property.

Note: To enable bulk processing of purged users, submit a request. For details, contact Saba support.

Important

• Even if a user is obfuscated and deleted from Saba Meeting, recordings of meetings the user has led or attended as
a participant or presenter continue to be available and accessible in Saba Cloud.

• The "Meet Now" room name of the purged user is changed in Saba Cloud. However, any users who attended that
meeting can playback any recordings by accessing the room URL.

• The names of deleted participants are not obfuscated from Saba Meeting recordings and chat logs.
• Purged users are not unenrolled as leaders of any future meetings in Saba Cloud; however, they are unenrolled from

such meetings in Saba Meeting. The meeting in Saba Meeting becomes a leaderless meeting. If the meeting in Saba
Cloud has other presenters, then such a meeting can be run successfully. If not, then a new meeting has to be created.

When a terminated user is purged in Saba Cloud, if the corresponding user exists in Saba Meeting, then that user must
be automatically deleted from Saba Meeting.
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Configure option for cleanup of learning items for terminated
users

In the past, after termination of users, the clean up of learning items for the terminated users was set to 2 days. In some
situations the transition phase needed additional days to avoid issues.

Starting from this update, this setting can be configured. User can set the value to their specifications. The default value
is 2.

Post Internal and External Person Termination days - Default value

Saba Cloud now provides the option to configure the clean up of learning items for the terminated users.

Audit options for Purge action

In the past, it was not possible to have a record of who executed a purge and when a record was purged and so on.

With this update, it is now possible for users to get visibility into the Purge actions happening in their environment.
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The Purge audit record will display who performed the Purge action and the date and time of the Purge action.

Note: The purged employee's user name or any other identifier will not be displayed.

To view Purge Activity History:

Navigate to Saba Cloud>Admin>People>Manage People>Purge History

Figure 77: Purge Activity History page

Note:  Enable Purge property in Saba Cloud Microsite has to be enabled for Purge History menu to be displayed.

Users will have more visibility to the Purge actions in their environment.

Transfer Internal users to external and vice-versa

In the past, mechanism to Transfer internal user to external and vice-versa, and bringing over the data were done manually.
This was time consuming.

With this update, the process to transfer user data from internal to external and vice versa is automated and handled by
Saba Cloud.

This process is similar to a Merge operation. It involves the following steps:

• Create a new record (Person) on the other side. (external/internal)
• Conduct a Person Merge from old record to new record.
• Carryover the username to the new profile and change the username of the old record.
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In the past, this process was done manually. Now, when Profile Transfer button is clicked, the system will automatically
perform these steps.

The mechanism to Transfer internal user to external and vice-versa, and bringing over the data is now automated.

Enhancement to smartlist criteria

New feature addition.

With this update, a new criteria named Talent Profile has been added to the Smartlist page.

Figure 78:Talent Profile criteria added to Smartlist

Talent profile covers the following attributes:

• Critical Person
• General Readiness
• Potential Level
• Custom fields

The smartlist criteria option is enhanced now to include Talent profile with associated attributes.
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Addition of custom fields on external work history page

New addition.

In this update, custom fields are added to the External Work History section of the Profile page.

Figure 79: Custom fields added to Work History page

Note:  In this update, Saba Cloud supports only the Custom fields for External Work History and does not support
Extended Custom fields.

The custom fields on the Work History page will allow users to include customized information for user profile.

Enhancement to Job Roles description page

Job Roles field has been enhanced to address a few user needs.

The following changes have been made:

The description field size on Roles has been increased to 2000 characters and will support rich text.

When assigning or viewing assigned Roles, end users and managers can see more details about the Role.

The Required Roles and Optional Roles section will display directly under Current Job on the Profile page.
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Job Roles section has been enhanced to accommodate user needs.

Provide ability to mark a terminated person as Stop
Processing

In the past, terminated user accounts were editable and the data could be exported. However, when employees are
terminated, they may want the organizations to Stop Processing their information and Saba Cloud did not provide that
option.

In this update, the mechanism to mark a user who is terminated as Stop Processing Personal Data has been added.

• This applies to users who are already terminated.
• Information for users with Stop Processing state cannot be edited. The profile of such users cannot be edited and

their data cannot be exported.
• Users with Stop Processing status can still be Purged.
• Users with Stop Processing option enabled will be skipped by Post Internal Person Termination Activity and Post

External Person Termination Activity.

This feature must be enabled by a setting and it is OFF by default and will only be visible if the setting is enabled and
the user is terminated.

To enable the setting:

1. Navigate to Admin>System>Configure System> Services
2. Search for and launch User Profile.
3. Select the Allow Stop Processing on User Profile check box and Save.

Enable Allow Stop Processing on User Profile
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Only when this option is enabled, you will be able to select the Stop Processing check box on the Edit User profile
page.

Stop Processing option displayed on User Profile

Organizations can now stop processing information for terminated users.
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Extended Custom attributes are visible in Custom sections

In the past, the Custom Sections (Additional Information) on the Me page and the Profile pages did not support Extended
Custom attributes. Some users needed to add additional attributes beyond what Saba Cloud provided.

With this update, Extended Custom attributes on Custom sections are enabled and visible for these sections.

Users can add additional attributes using the Extended custom attributes to the Custom section under Additional
Information of the Me page and the Profile page.

Figure 80: Extended custom attributes

Extended Custom attributes are now supported under the Custom Attributes section of the Me page and the Profile page.
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Configure milestone steps in review cycle

The performance review used to go through the following cycle:

Begin & Activate the Review   Complete the Review   Submit the Review   Approve the Review   Release the Review
  Finalise the Review

The performance administrator now has the provision to make some of the review steps optional so that the review
bypasses those steps. This helps the administrator speed up the review process to avoid unwanted delays. This can be
configured only at the review cycle level so that the review obeys the process.

The review cycle now has the following steps:

1. Draft (Optional)
2. Activation
3. Owner Submission
4. Approval
5. Release (Optional)
6. Finalization (Optional)

The Draft, Release, and Finalization steps are optional and performance administrator can choose to enable or disable
these steps as per their requirements. If any of these optional steps are disabled, then the review based on this review
cycle, bypasses these steps and moves to the next step. The Owner Submission and Approval steps are enabled by
default and the administrator cannot disable them. The reviewer sequence has now been moved under the Activation
step.

Note: This is applicable only for Focal, Anniversary, and Off Cycle reviews.

Consider an example where the Draft, Release and Finalization steps within a review cycle are disabled.

Figure 81: Example of steps disabled within review cycle

As a performance administrator when you try to create a review via monitor review, the review bypasses the Draft step
and moves to the Activated step. Further it goes only through the following cycle:

Complete the Review   Submit the Review   Approve the Review

Few policies on the review cycle and form are now controlled by these steps. For example, the Review owner can
release reviews policy is now moved under the Release step and if this step is disabled, the policy doesn’t appear on
the cycle. If the Draft status is disabled, then the Review owner can move the review back to draft status from active
status. policy is disabled on the review form.
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This feature provides the ability for performance administrator to configure the review steps based on the organization's
needs. The administrator can disable some of the optional steps to speed up the review process.

Change review owner

The reviewee, review owner, and performance administrator could change the current review owner of the review if
there is any change in the management hierarchy.

In this update, only the review owner and the performance administrator is allowed to change the review owner of a
review. The performance administrator can now set a review owner in the review cycle itself so that the same setting is
applied to all reviews associated with that cycle. As an admin, you can make only the Manager, 2nd Level Manager,
and Alternate Manager as a review owner. By default, while creating the cycle, Manager is set as a review owner. You
cannot disable the reviewer who is the review owner.

Figure 82: Set review owner in cycle

Once the review cycle is activated, you will not be able to change the review owner.

In the Summary tab of the review cycle, the review owner is highlighted.
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Note: You can also export the cycle, change the review owner setting, and import the same.

Figure 83: Review owner

Once the reviews are triggered to users, the review owner or performance administrator can change the review owner
to any other user. In the second step, you need to choose whether you want to keep or discard the existing comments
and/or ratings made by the current review owner. Once the review owner is changed, the same accountability is transferred
to the new review owner. As the review owner passes the responsibility of the review to a new review owner, the original
review owner is no longer associated with the review.

Figure 84: Change review owner

Note: The Change button appears only on the Draft and Active reviews within that active review cycle. If the
review cycle is completed, then only completed reviews show the Change button.

If the same review is assigned to multiple reviewees, you can perform a bulk change action to change the review owner.
The Bulk Change is a 3-step process where, you will have to select a new review owner and reviewees, choose whether
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to keep or discard existing comments/ratings, and confirmation whether it was success or fail. You must click the
dropdown corresponding to the Change button to click the Bulk Change button and proceed.

Figure 85: Bulk change review owner

The reviewee can download the review, make changes to the review owner and upload the same to reflect that changes
in the review. The people administrator can also do the same through Download/Upload Bulk Reviews.

This allows the user to change the review owner to any user for a review.

Delete Held Skills from My Plan
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The end user and manager could delete a non-assessed skill from My Plan > Skills Development tab.

Figure 86: Delete non-assessed skill

The end user and manager can now also delete assessed skills from My Plan > Skills Development tab. The Delete
action appears for all assessed skills. However, the end user and manager can delete the assessed skill only if the source
type of that skill is person.

Figure 87: Delete assessed skill

This Delete action is governed by the following privileges on Skills component for Internal Person Basic Privileges
and Internal Manager Basic Privileges security roles.

• Can delete skills added by me to my plan - Allows to delete the skill added by yourself. By default this privilege is
enabled for end user and manager.

• Can delete skills of my direct reports, added by me or the direct report - Allows to delete the skill added by your
manager. By default this privilege is enabled for manager.

• Can delete any skills added to my plan - Allows to delete the skill added by any source type. By default this privilege
is disabled for end user and manager.
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Figure 88: Privileges to Delete Skills

This enhancement now improves the usability of skills by allowing the end user and manager to delete the assessed
skills if its no longer needed.

Expected distribution can now be hidden from Review
Owners

Review Owners would always see expected distribution.
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Performance Administrators can now set whether they want Review Owners to see expected distribution (also known
as targeted distribution). The new check box is on the Rating Scale page when you are creating a new review cycle.

Figure 89: Review Owner can see expected distribution

Figure 90: Review Owners cannot see expected distribution

Note: This option is not applicable for 360/Multi Rater Assessments (MRAs).
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Enhancements to Overall Score Calculation in Reviews

The final score calculation policies on the review cycle were:

• Yes, calculated
• Yes, set manually by review owner
• No

Figure 91: Final Score Calculation Policies on Review Cycle

The terminology and behavior of overall score calculation policies on the review cycle has been updated.

Figure 92: Updated Score Calculation Policies on Review Cycle

The enhancements are:

• The Generate final score label is changed to Generate Overall Score.
• A new Allow Override checkbox appears on selecting Yes, calculated policy.
• Yes, set manually by review owner is changed to No, set manually by review owner.

The functioning of overall score calculation is:

• When Yes, calculated policy and Allow Override checkbox are selected on the review cycle, the review owner can
override overall score during review submission, review calibration, and in n-box comparison.

• When Yes, calculated policy is selected, but Allow Override checkbox is not selected on the review cycle, the
review owner cannot override the overall score during submission. But, the review owner can override the overall
score via the review calibration and n-box comparison. Performance administrator can still override these ratings.

• When No, set manually by review owner policy is selected, the calculated ratings are hidden on the review page
and on the submission page, but the manual ratings are shown. In the review calibration and in n-box, the review
owner can override the calculated scores.
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• When No policy is selected, the calculated scores are hidden from the reviews page, review calibration, and in n-box.

Note: There is no functional change on overriding score via RDI.

This simplifies the overall score calculation functionality.

New filter to access reviews from My Plan page

The end user could access the reviews on the My Plan page using the following filters:

• Type
• Reviews
• Status
• Due Date On Or Before
• Due Date On Or After
• Active Year From
• Active Year To

A new filter Reviewee is added under the Reviews, Meetings & Interviews tab. This filter appears only when Reviews
is selected from the Type filter. By default this field is blank. This filter allows you to search for reviews based on the
reviewee name. You can search for reviews using the first few letters of the first name or last name; you don't have to
enter the entire first or last name. This field does not support both first name + last name. For example, you can either
use J, Jo, John or G, Gar, Gartener but not both John Gartener.

Figure 93: Reviewee filter

This enhancement allows you to find the review of a specific user.
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Restrict who can cancel reviews to Performance
administrators

Performance administrators could not restrict who was allowed to cancel reviews.

Performance administrators can now disallow review owners from canceling reviews by enabling the following check
box when creating a review cycle:

Figure 94: Only an administrator can cancel reviews check box

Section weights support up to two decimal places

Review sections on the form configuration page could be set up to support weights but you could not enter section
weights with a decimal place.

Now you can enter section weights with up to two decimal places on the form configuration page. The weights must
total 100%.

Here is an example of how you could set up sections with different weights:
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Transfer points to peers via impression

Through an impression you let the user know how you were impressed by their work and you also associate a badge to
describe them. In addition to this, you would give them suggestions for improvements. When Saba Net Performance
Score is enabled, then you could rate the user on the scale of 0-10 where 0-4 being lowest and 5-10 being the highest.
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Figure 95: Leave an Impression popup
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The rating scale of 0-10 on the Leave an Impression popup has now been replaced with emojis. Therefore, after enabling
Saba Net Performance Score, this is how the Leave an Impression popup appears.

Figure 96: Leave an Impression

On selecting the Happy emoji, you can leave a public/private comment and a badge. If you select the Neutral or Sad
emoji, the recipient does not receive any notification but the system collects your response.

In addition to this, you can now also transfer your earned points to users while leaving an impression. You can transfer
points only when the Assign points on leaving an impression setting under the Foundation > Rewards service is
enabled. By default, this setting is disabled. To enable, contact your system administrator.

 | Performance | 158



Figure 97: New setting to assign points

In the Give points? widget, you can either type or use the Up and Down icons to enter your points for transfer. Once
transferred, those points are deducted from your wallet. It is not mandatory to give points to other users. You can check
the Available points on the widget and accordingly choose to transfer. On selecting the points, they are immediately
deducted from your wallet in real time and the available points reflect on the widget. The Give points? widget appears
only if you have points in your wallet.
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Figure 98: Leave an impression with points

Once you give the impression including points to a user, the recipient and you will receive a notification indicating the
reward points earned via impression. This notification is triggered only when the
@SabaImpression_Rewards_Points_Earned@, keyword is used in the Saba Impression Created and Private Saba
Impression Created triggered events.

Points once transferred cannot be retrieved by deleting the impression, you may have to contact your HR administrator
to cancel those points. The HR administrator can navigate to ADMIN > HR > Manage Rewards > Manage Points,
search for the impression with points and cancel that impression. The HR administrator must provide a valid reason for
cancelling the impression. Once the impression is cancelled, the points are reverted to your wallet.

Note: The HR administrator can cancel only those points that are associated with the impression.

Figure 99: Cancel impression points

This improves the usability of points because if you are not redeeming those points for yourself; you can transfer those
points to your peer or anyone who impressed you.
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Update required level for skills

Once you add a skill or your manager assigns a skill, you could only update the held level of the skill but not the required
level of that skill.

You and your manager can now update the required level of a skill that is added by self or manager. You and your
manager can use the new action Update Required Level corresponding to the skill to update the level.

Figure 100: Update required level action

On the Update Required Level popup, you can view the current level and then set the new required level. You can now
also view the descriptions on the level while selecting. The highest level appears for that skill under the Progress column.

Figure 101: Update required level

In addition to this, you can also view the behavioral indicators of skills while adding skills and set the required level for
your selected skills.
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Figure 102: Behavioural Indicators of Skills

This improves the usability of skills.

Updated labels for override overall ratings

There was a need to update labels on the Override Overall Rating page.

Figure 103: Current Override Overall Rating Popup
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The labels on the Override Overall Rating popup have been updated as shown below.

Figure 104: Updated labels on Submit Review popup

Figure 105: Updated labels on Override Review Rating popup

This simplifies the labels on both the popups thus improving its usability.
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Apply for Job with Facebook

The candidates could apply for a job via Facebook but, it was just a Single Sign-On. The profile details were not fetched
from Facebook.

The candidates can now apply for a job via Facebook thus pulling the profile details from Facebook.

Figure 106: Apply for Job with Facebook

This simplifies the job application process for the candidate. With just one click, the candidate's details like about me
profile, website URL, work history, location, education history, date of birth details are pulled from Facebook.

Figure 107: Apply for Job with Facebook

This information reflects in the Step 2 Candidate Details tab.
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Note: As of today, candidate's details such as About Me, Education and Work History is not retrieved as Facebook
aims to keep the people’s information safe and secure. This feature relies on Facebook policies about their core
commitments to privacy and security. Sooner or later the data will be re-shared.

This feature is useful for companies that are in media where the potential candidates does not have profiles on professional
sites like LinkedIn.

Configurable Invite Candidate Email for External
Assessment

When the hiring team members invite a candidate to take an external assessment, an adhoc notification is sent to the
candidate. This notification was triggered through the system and it was not configurable.

A new notification Candidate Invitation for External Assessment has been added under the Recruiting + Internal
Opportunities service. This notification is a triggered event and configurable. By default this notification is enabled.
It is triggered to a candidate to take the external assessment.

Note: You can access notifications by navigating to Admin > System > Configure System > Services > Recruiting
+ Internal Opportunities > Notifications tab.

This notification includes all keywords associated with other Recruiting notifications. However, the following new
keywords are added to this notification:

• @Recruiting_ReqCandidate_ExtAssessment_Id@ - Displays the ID associated with the external assessment.
• @Recruiting_ReqCandidate_ExtAssessment_LaunchUrl@ - Displays the assessment URL.
• @Recruiting_ReqCandidate_ExtAssessment_Name@ - Displays the assessment name.

The system administrator can define the notification by adding the desired keywords, recipients, and attachments. For
more information, refer the Notification Reference guide.
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Figure 108: Candidate Invitation for External Assessment Notification

Once the notification is configured, the hiring team members can invite candidates for external assessment from the
Hiring Team view. The candidate receives the notification with a link to take the external assessment.
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Figure 109: Inviting Candidate for External Assessment

This enhancement improves the usability of the Candidate Invitation for External Assessment notification by letting
you configure the notification text as per your requirement. You can add Job Requisition ID, Name, and such elements
to the notification to distinguish it from other notifications in the candidate's Inbox.

Enable and define external job boards

The external job boards were not supported as the desired metadata were not configurable in job requisition.

The Marketplace Administrator can now add OOB and custom attributes and configure external job boards. These
additional information is necessary for mapping the user data with the job requisition to publish the job requisition.

The Job Postings & Services tab of a job requisition displays external job boards and the data required by them.

The typical job board attributes supported by Saba are Location, Job Family, Salary Type, Employment Type, Industry,
Min Experience, and so on. You can use the custom attributes to provide the additional mandatory details.

 | Recruiting | 169



Figure 110: External Job Boards

The recruiting admin and recruiter can update the desired metadata and use custom fields to populate the additional
information desired by the external job board.

The recruiting admin and recruiter can now post the requisition to an external job board by defining additional metadata.

Enhancements to Workflow

Candidate selection workflow is a hiring process to evaluate and find the best candidate for the open job. There was a
need to make some cosmetic changes focussing on usability, alignment and spaces.

The following changes have been made in the create workflow, hiring team view of requisition with workflow, and
candidate details page:

1. Admin > Recruiting > Manage Workflows

• On the Workflows page, the following new search filters are added:

• Workflow Name - Allows you to search for a workflow using its name.
• Status - Allows you to search for a workflow using its current status i.e., Active or Inactive

Figure 111: New filters

• On the Create New Workflow popup, the Preview action is prefixed with an icon and suffixed with the selected
workflow name.
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Figure 112: Updated Preview label

• When you move a step within the statuses on the workflow details page, the Moving message appears until the
action is completed.

• When a user opens a workflow and clicks Cancel, the user is navigated to last accessed page and not the first
page.

2. Hiring team page of a requisition associated with workflow

• The message Offer can be sent to the candidate only once its approved appears when you select the Move to
Offer Sent action. This message indicates that the offer will be sent to the candidate only when its approved.

• The actions in the Change Status dropdown list for selected candidates (bulk action) are sequenced as defined
in the workflow.

Figure 113: Change Candidate Status in Bulk

• The next action is populated by default in the Change Status dropdown while changing the status for individual
candidates.
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Figure 114: Change Candidate Status for individual

• Info icon appears on the Offer Sent step indicating whether the candidate has accepted the offer or rejected it.
If it is rejected, then the rejected reason is also shown.

Figure 115: Info icon on Offer Sent step

3. Candidate details page

• The steps are now shown under the Change Status dropdown list for hired candidates.
• The Mark Rejected step is moved out from More Actions and placed next to Change Status.

Figure 116: Usability changes on Candidate Details page

These enhancements improve the usability of workflows in job requisition.
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New recruiting dashboard

You viewed job requisitions in a list using the Manage Requisitions page.

Now there is a new recruiting dashboard, which is a quick, visual way to see the status of job requisitions. Recent
requisitions in the dashboard are sorted by the creation date (not the last modified date).

Figure 117: Recruiting Dashboard

A Click to view the job requisitions that need your attention, which are job requisitions that have stayed in the same
status for a specific period of time.

B Shows the job requisitions that need attention by displaying a red or yellow warning icon.

Shows Yellow When Greater
Than...

Shows Red When Greater Than...Status

7 days14 daysDraft

5 days10 daysPending Approval

7 days14 daysRejected

7 days14 daysActive
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Shows Yellow When Greater
Than...

Shows Red When Greater Than...Status

90 days180 daysOn Hold

60 days120 daysPublished

C Shows the number of candidates who have applied to the job.

D Shows the number of new candidates for the job.

E Click to see the candidates for the job.

F Click to view the job requisition.

G Shows where the requisition is in the approval chain (1 has completed their approval and another needs to approve).

H Shows a list of all job requisitions.

New settings to enable resume parsing and TIM
recommendations

Resume parsing and prefilling the candidate profile fields only worked for English locale resume and was always enabled
and there was no option to turn it off.

In this update, two new settings have been introduced under Recruiting + Internal Opportunities service.

The settings are:

• Enable Resume Parsing

Syncs resume and pre-fills candidate's profile with the parsed information. By default this setting is enabled. On
disabling this setting:

• Resume will not be parsed during candidate's application flow.
• Candidate's profile will not pre-filled with parsed results.
• The Sync link will be hidden from the Candidate details page.

• Enable TIM candidate's recommendation

Suggests better candidates for hiring and helps in tuning TIM's logic. By default this setting is enabled. On disabling
this setting, the following options are hidden from the Hiring Team view:

• Tune TIM button
• Candidate Suggestions tab
• % Match from candidate details, sort criteria and filter criteria
• Compare Candidate button
• Add to compare action from More actions and Candidate details
• Internal People with Similar Skills section

 | Recruiting | 174



Figure 118: New settings

This improves the usability as the user can disable resume parsing and TIM when not needed.

Updated logic of Days to Fill calculation for position

Once a candidate for a position is hired, the Days to Fill field on the Hiring Team view calculates the number of days
used to fill this position. This field actually considers the days right from the requisition published date till the candidate
is hired. This field also considers the days when the requisition is moved to Draft, On Hold, Cancelled status and so on
before any candidate is hired.

The Days to Fill field is now calculated as:

last candidate marked hired - requisition published date

Before the candidate is hired, if the requisition goes into status other than Active, then those days are not considered.
In such a case, this field is calculated as:

last candidate marked hired - first activated date - (summation of invalid 
days like requisition
was on hold, draft, closed, or pending)

Illustration

Consider a requisition that was published and a candidate got hired. In between, the requisition went through multiple
statuses. So let's see in this case how the Days to Fill will be calculated.

Days to FillEnd DateStart DateCurrent StatusOld Status

10-Jan-1810-Jan-18PendingDraft

515-Jan-1810-Jan-18ActivePending

520-Jan-1815-Jan-18On HoldActive

3 days

(13-Jan-18) - (10-Jan-
18)

13-Jan-181st candidate hired
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Days to FillEnd DateStart DateCurrent StatusOld Status

1030-Jan-1820-Jan-18ActiveOn Hold

1110-Feb-1830-Jan-18ClosedActive

515-Feb-1810-Feb-18DraftClosed

520-Feb-1811-Feb-18PendingDraft

20-Feb-18ActivePending

20 days

(25-Feb-18) - (15-Jan-
18) - (invalid days in
italics)

25-Feb-182nd candidate hired

Figure 119: Days to fill requisition

This improves the usability by displaying the correct duration of days to fill the job requisition.
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Saba Video

Saba Video provides you with an easy and secure way to learn with video. You
can now upload and stream video content from Saba Cloud's formal (courses,

Topics:

• Saba Video services certification, and more) and social learning (canvas, newsfeed, video channel,
• Upload and launch formal

streaming videos
groups, and more) workflows. Organizations can configure and manage all these
video capabilities from one consolidated place.

• Manage Saba Video usage
• Showcase videos in a group
• Upload Saba Video



Saba Video services

Prior to this update, Saba Cloud provided video streaming only via the Marketplace connector with Panopto.

With this update, Saba Cloud introduces video streaming via Saba Video.

The following new services can control various actions such as upload, launch and other features for Saba Video:

Table 31: New Saba Video services

Default ValueDescriptionService

DisabledParent service that provides the ability to access Saba Video
in Saba Cloud.

Saba Video

DisabledProvides the ability to access Saba Video in Learning. Cur~
rently, this service controls import and launch of 'Video con~
tent' of 'Saba Video' provider type.

Formal Videos

DisabledProvides ability for users to contribute/add and play Saba Video
from Home/Group Activity Stream, Video Channels, System
Canvas, Workspace, Page, Blogpost, and Announcement areas.

Social Videos

These services are domain-aware.

Note:  Saba Video is an add-on feature. For provisioning Saba Video, submit a request. For details, contact your
Saba Account Manager.

After enabling the services by "admin" user, system administrators can enable or disable the services at the site level.
To access the new services, navigate to System > Configure System > Services > Saba Video.

Administrators need the ability to configure various activities such as upload, launch and so on for Saba Video.

Upload and launch formal streaming videos

Prior to this update, Saba Cloud did not provide the ability to upload and launch formal streaming videos.
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With this update, Saba Cloud provides support to upload and launch formal streaming videos. Streaming video differs
from regular video files such that the video can be streamed rather than downloaded.

Note: This feature is available only if the Formal Video service under Saba Video parent service is enabled for
a site. To enable the services, submit a request. For details, contact your Saba Account Manager or Saba support.
Once Saba enables the service, system administrators can enable or disable the service at the site level.

Upload streaming videos to content library

Content administrators can now upload formal streaming videos in the "video content" format to the content library.

To upload a formal streaming video to content library:

1. Navigate to Learning > Manage Content > Content Library.
2. Select the required folder and click Import.
3. Important: Select "Video Content" from Content Format and "Saba Video" from Content Provider.
4. Click Next.
5. Click Upload Video. The Select Video popup appears.
6. Either add a new video or select a previously uploaded video as follows:

a. To add a new video, click the Upload icon or drag and drop a video file.
b. The upload progress is displayed as a percentage. You can cancel the upload midway by clicking the x icon.

OR,

a. To add an existing video, search and select the video, if available.
b. Click the Upload button.

Figure 120: Import a formal streaming video

7. Specify the Video Completion Criteria in percentage. When learners launch the video and watch the specified
percentage of video, they are automatically marked complete. Valid values range between 1 and 100.
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Note: This field is available only if the selected Content Provider is "Saba Video". It is not available for
"Panopto".

Figure 121: Video completion criteria

8. Specify other informatio, if any.
9. Click the Import button.

Upload streaming videos to a quick online course

Catalog administrators can now upload formal streaming videos in the "video content" format to a quick online course
using the quick course wizard.

To upload a formal streaming video to a quick online course:

1. Navigate to Learning > Manage Learning Catalog > Learning Catalog > New Catalog Item.
2. Click Online Course link. The quick course wizard opens.
3. Specify required fields and go to the Activities tab.
4. Select "Content" from Add Activity.
5. Select New Content and Video options.
6. Important: Select "Saba Video" from Content Provider.
7. Click Choose File. The Select Video popup appears.

Figure 122: Upload a streaming video
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8. Either add a new Saba video or select a previously uploaded video as follows:

a. To add a new video, click the Upload icon or drag and drop a video file.
b. The upload progress is displayed as a percentage. You can cancel the upload midway by clicking the x icon.

OR,

a. To add an existing video, search and select the video, if available.
b. Click the Upload button.

9. Click Upload.
10. On the Activities page, click the Add button. If the upload is successful, then the Activity Details popup page

appears; else, the wizard displays an error message.
11. Add the required activity details and click Save. The selected Saba video content is added as an activity to the course.

Clicking Preview Content link streams the video.

Launch streaming videos

Now, learners can stream videos as opposed to launching them from their registered classes. The content is streamed
directly from Saba Video.

Features

• Provides ability to upload large videos to content library.
• With streaming videos, learners experience quick start, minimum buffering and smooth playing, regardless of the

size* of the video and network bandwidth*.

- *Within a reasonable range

• Provides a uniform video experience to learners with different screen resolutions, regardless of their screen resolution.
• Allows learners to smoothly pause, resume, fast-forward and rewind videos without intrusive buffering.
• Supports full screen for videos so the video is played in the entire viewable space of the device.

Limitation

• Saba Cloud does not provide data import and API support for formal streaming video content.

Saba Cloud needs to support upload and launch of streaming formal videos using Saba Video.

Manage Saba Video usage

N/A

With this update, Saba Cloud introduces the new Video Usage dashboard for Saba Video that allows administrators to:

• View how many videos are uploaded out of total available video count
• Find videos by different attributes such as name, author, size, count, and so on
• Delete one or more videos to free up count

Note: Your video limit depends on the number of videos purchased. For provisioning the dashboard, submit a
request. For details, contact your Saba Account Manager or Saba support.
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If enabled, then the dashboard is available to users with the following roles:

• Learning admin - Catalog Builder

To access the new dashboard, navigate to Admin > Learning > Manage Content > Manage Videos.

• Collaboration admin

To access the new dashboard, navigate to Admin > Social > Manage Videos.

• System admin

To access the new dashboard, navigate to Admin > System > Configure System > Manage Videos.

Figure 123: Video Usage dashboard by Video Count

All administrators can view the video usage summary details for all categories. However, except for System administrators,
other administrators can can find and delete videos only in their respective categories. For example, Learning administrators
can only find and delete Learning videos. Similarly, Social administrators can only find and delete Social videos.

To delete a video, select the checkbox corresponding to the video and click the delete icon. Once a video is deleted, it
cannot be recovered. So, when users try to view a deleted video, Saba Cloud shows them an error message.

It is critical for organizations to effectively implement a capacity for videos uploaded to Saba Cloud and manage their
video limit without having to contact Saba Support.

Showcase videos in a group
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The user could not contribute a video channel to a group.

The group owner can now share a video channel to a group. If the Video Channel service under the Collaboration
service is enabled, then the Video Channel service within Groups is available. By default, this service is disabled. The
group owner must edit the group and enable this service.

Figure 124: Video Channel service within Group

The group owner can then share a video channel by clicking Contribute > Video > Share Video Channel. It populates
all the public and active video channels where a logged-in user is a member. You can select the desired channel for
your group. You can share a channel only if you are member of that channel. The members of the group must subscribe
to the channel to view the videos
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Figure 125: Share Video Channel

If a video channel is already added to the group, it does not appear in the list while adding. You can add multiple channels
to a group. You can also add the same channel to your other groups.

All your video channels appear under the Videos tab of your group.

Figure 126: Videos tab in Group

The first section shows all the videos posted in the group. The rest of the sections are video channels shared in the group.
You and your group members can use the Search bar to search for a desired video. Above Search bar, you can view the
count of videos that includes group videos and shared channel videos. All the videos within a channel can be viewed in
the carousel. The carousel can display only 25 videos. Click the See all x videos link to view all videos. This link appears
only when there are more than 3 videos in the channel. The videos are sorted by added on or created on date and time.
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Once the channel is added to the group, as a group owner you can remove the video channel by clicking the Stop Sharing
link.

If a video channel which is already shared gets unsubscribed, then all videos of that channel gets removed from the
group. The count of videos get updated accordingly. Once again the group administrator can subscribe for the channel
to restore the channel videos.

This improves the usability of accessing group and video channels within the same instead of a separate group and a
channel. This also helps the group members to find videos within the group easily.

Upload Saba Video

You could contribute a video to the activity stream only by embedding videos with HTML code.

Figure 127: Contribute video

You can now contribute videos to the activity stream by uploading videos from the existing library or from your computer.
You can upload videos only after your "admin" user configures the Saba Video settings within your site and enables the
Social Videos service within the Saba Video service. By default, these services are disabled. To enable them, contact
your system administrator.

Figure 128: Upload video services
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Figure 129: Upload video

Points to Remember:

• While uploading a video, the progress bar appears indicating the uploading progress.
• The Upload button is enabled only when you select an existing video. If you are uploading a new video, the popup

closes once the video is uploaded and redirects you to the main page.
• You can upload only one video at a time.
• You can play the video in the carousel before uploading it.
• After selecting a video, you can update the video title before contributing it. The title doesn’t change the actual

video's title but reflects only where the video is shared.
• Once the video is uploaded, you can edit the video and its details.
• You can view the user activity on the uploaded videos like number of users who have played and watched the video

provided the Learning Record Store Reporting service within Saba Discovery is enabled.

Impacted Areas:

This upload functionality now appears in the following areas as well:

• System Canvas: The users who can edit the canvas; can now upload Saba Video.
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Figure 130: Upload video in system canvas

• Home > Announcements portlet: As a group owner, you can upload a Saba Video in the Announcements portlet.
Click Edit > Advanced Options > Insert/Edit Video > Upload Saba Video to upload the desired video and click
Save.
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Figure 131: Upload video in Announcements portlet

• Collections: As an end user, you can now upload a Saba Video to your collections. Navigate to ME > Collections
> <collection-name> > New > Video and click the Upload option to add a Saba Video to your collection.
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Figure 132: Upload video in Collections

• Groups: As a group member, you can now contribute videos by uploading it provided the Can Submit Video Content
privilege is enabled by the group owner.

Figure 133: Upload video in group

• Groups > Announcements portlet: As a group owner, you can upload a Saba Video in the Announcements portlet.
Click Edit > Advanced Options > Insert/Edit Video > Upload Saba Video to upload the desired video and click
Save.

• Groups > Resources folder: As a group member, you can upload a Saba Video to a group resource folder. Go to a
group > Resources tab > <folder-name> > Add New > Video > Upload to upload the desired video and click Save.
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Figure 134: Upload video in resources folder of group

• Video Channel: As a member if you have subscribed to the video channel, you can also upload videos to it.
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Figure 135: Upload video in video channel

• Workspace Page: As an owner and contributor, you can upload a Saba Video in a page within a workspace.

Figure 136: Upload video in Workspace Page

• Blog: As a owner and editor, you can upload a Saba Video in a post within a blog.
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Figure 137: Upload video in Blog

The supported formats for uploading videos are:

• QuickTime: MP4, MOV, QT, and M4V
• Flash: FLV and F4V
• Microsoft Windows: AVI, ASF and WMV along with MPEG, WEBM, 3GP and MXF

If you have multiple video providers, such as Panopto and Saba Video, then Saba Video will be your default video
provider.

This improves the usability of video upload feature as you can now upload a video in groups and video channels thus
increasing the feature value.
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Enhancements to Collections

In the last update, the Collection details page was updated with a fresh visually engaging look. However, there were
several requirements to be accomplished in the existing framework.

In this update, the following enhancements have been made to Collections:

• My bookmarks portlet on the Home page renamed to My Collections.

Figure 138: My Collections portlet

• Bookmarks menu from left navigation under ME tab renamed to Collections.

Figure 139: Collections left navigation menu

• Add a New Folder on the My Collections page is renamed to New Collection.
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Figure 140: New Collection button

• List Of Contents title on the Collection details page is renamed to Contents.
• Add New button on the Collection details page is renamed to New.

Figure 141: Collections page

This enhancement improves the usability of collections.

Inline preview of images in activity stream

When you contribute a portrait image, the entire image doesn’t appear in the Activity Stream. You had to click on the
image to view the entire picture.
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Figure 142: Incomplete Picture Preview

The picture algorithm has been updated so that the picture is shown based on its aspect ratio irrespective of their different
dimensions. The entire picture is now resized and displayed accordingly in the Home Activity Stream and Group Activity
Stream.

Figure 143: Complete Picture Preview

The pictures are now resized thus improving its preview functionality in the activity stream.
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Web accessibility support

Prior to this update, there was no Web accessibility support for the following areas in Saba Cloud:

• Analytics
• Career Site
• Portlets in HOME and GROUPS tab
• Goals
• Performance Reviews
• Skills
• Assessment Player for end users
• Content Player for end users
• Sections under the Profile team in Me and My Team

With this update, certain areas in Saba Cloud provide support for Web accessibility (Section 508 and WCAG 2.0 level
AA). Users can now use keyboard navigation and keyboard key presses to access the user interface in the following
areas:

• Analytics
• Career Site

• Home Page

• View All Jobs

• Job details page
• Job Application steps
• My Jobs
• My Profile

Note: The Work Reference, Education and Employment sections are not compliant.

• User Name > My Settings

• GROUPS

• Groups Home
• Workspaces
• Discussions
• Ideas
• Issues

• HOME page

• Shopping Cart
• Inbox
• Contribute
• Private Message
• Activity Stream

• ME
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Subscription page•

• Subscription details page

• Training Unit page
• Payment Options page
• Profile page
• Reviews
• Skills
• Goals
• Additional Information page

• My Team

• Profile page
• Reviews
• Skills
• Goals
• Additional Information

• Assessment Player for end users
• Content Player for end users

There is a need to enable users using Assistive technologies to easily navigate through the application with interaction
taking place through keyboard events.

Captcha is now updated

Google has discontinued the support for the version of reCAPTCHA that used to appear on the signup and forgot
password pages.

This reCAPTCHA is now upgraded to a version 2. The reCAPTCHA challenge just requires the user to click a checkbox
indicating the user is not a robot. It challenges users using a photo grid as well as an audio based captcha to validate
whether or not they are human.

This enhancement upgrades the existing reCAPTCHA.

Change in sorting of text-based searches for Catalog items
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Search results were inconsistent. Certain text-based searches for the catalog items were alphabetically sorted, whereas
the same search performed under global search would sort the results by relevance.

For example: Manager goes to add learning (from My Team) and searches for some catalog items, the search results
used to be sorted alphabetically.

Now the search results are consistent. Text-based searches for the catalog items are also sorted by relevance.

Customers used to seeing the catalog search results in alphabetical order may notice a change that the results are now
sorted by relevance instead.

Audit Trail Authorization

The Audit Trail details page used to display the audit details for the objects that the logged-in user does not have access
to view.

A new configuration security property called Audit Trail Authorization is now available for the Saba Cloud microsite.
When this property is enabled, the logged in user only sees details that he/she is authorized to see.

Note:  By default, Audit Trail Authorization is disabled.

Audit Trail details will now be accessible only to those authenticated users who have the access to view them.

Improvements to PGP configuration

The existing UI System > Manage Integrations > PGP Configuration was not very intuitive and it didn't allow
generating a new PGP key pair.

System > Manage Integrations > PGP Configuration now has a better UI.
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Figure 144: PGP Configuration

PGP Encryption and PGP Decryption sections give a lot more information on the actions that can be performed along
with the appropriate warnings.

Additionally, the new UI now allows the system admin to generate a new PGP key pair. The system admin needs to
choose the required key size (2048 / 4096) and then click GENERATE to generate a new PGP key pair.

Note:  Data Import will fail for import data files that have been encrypted with older public key.

Figure 145: PGP Decryption - Generate a new PGP key pair

Customers can now generate a new PGP key pair using the new UI.

Change or import IdP certificate for an existing IdP metadata

Prior to this update, it was not possible to change or import IdP certificate for an existing IdP metadata. It required
re-importing the IdP metadata.
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In this update, a new option called Change IdP Certificate is available under System > Configure System > SAML
SSO Setup > Edit configuration > Configure IdP.

Figure 146: Change IdP Certificate

You can either copy the certificate to the text area or import it using the link. If you want to replace the encryption
certificate, select the option. After the certificate is imported it will appear in the text area, verify it and click the button
to import and replace the certificate in the system.

Use this option to change the IdP certificate for an existing IdP metadata that is already imported into the system. This
option allows changing the signing and encryption certificate in the IdP metadata which was imported earlier without
requiring to re-import the IdP metadata.

Note: This option will be available only if this config setup has imported the IdP metadata at least once previously.
You can either copy the certificate to the text area or import it using the Import link.

Figure 147: Change IdP Certificate - Import
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Clicking Import shows the Import Certificate popup, where you can browse to the actual certificate file.

If you want to also replace the encryption certificate, select the Select to change the encryption certificate option.

Figure 148: Change IdP Certificate - Select to change the encryption certificate

You can either copy the certificate to the text area or import it using the Import link.

Note:  If the encryption certificate is the same as the signing certificate, select the Encryption certificate is
same as signing certificate option.

After the certificate is imported it will appear in the text area, verify it and click the IMPORT button to import
and replace the certificate in the system.
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While importing the IdP metadata, if there are 2 different certificates for Signing or Encryption, the user will be
shown a pop-up allowing to choose the right certificate to be used in the system. By default, the certificate with
the farthest expiry date will be selected. A certificate in the drop down will be indicated using the first and last 10
characters in the certificate and the expiry date in the format yyyy-MM-dd.

Select the right certificate to be used and click SUBMIT.

Figure 150: Change IdP Certificate - Choose the right certificate

Figure 149: Change IdP Certificate - IMPORT

This helps improve the IdP certificate management.
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Changes to attributes for SAML user provisioning

N/A

In this update, the following attributes have been added and are available under System > Configure System > SAML
SSO Setup > Edit / Start any existing SAML configuration > Configure Properties > Show Advanced Config:

Figure 151: New attributes

• UserName Attribute Name: Provide the username in the SAML response for user provisioning, in case the username
has to be different from the NameId provided.

Note:  It will be honored only if the property Enable Person Number As Username is true during user creation.

• User Currency Attribute Name: Provide the ISO code for the currency. It will be added as the default currency
for the user during the external user creation.

Note:  No currency update option is available with this attribute.

• User Termination Date Attribute Name: Termination Date can be provided during creation / update of the user.
The accepted date format is yyyy-MM-dd.

Note:  Past or current date will be ignored.

• Enable Termination Date Update if Empty - true indicates, that the termination date will be updated even if it is
empty, if the provisioning update is enabled for SAML. If the property value is set to false, then the termination date
will be updated only if it is not empty.

In addition to this, there's a change in the following attribute:

• Use Person Number as UserName: For user provisioning, NameID will be used as Person Number instead of
Person Number attribute field value. The Person Number attribute field will be ignored for user provisioning.

This provides better flexibility and management of user profile data during SAML user provisioning.
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Changes to Badges administration workflow

Prior to this update, there were certain restrictions for administrators in the Badge creation workflow:

• If the "Assign points on earning badge" setting was disabled on a domain, then HR administrators were not allowed
to create Badges with points in that particular domain.

• HR administrators were not allowed to add learning items to a badge if the domains of learning items were different
than that of the Badge. They could only see learning items that were associated with the Badge's domain.

This update enhances the security model of Badge creation workflow for administrators as follows:

• HR administrators can now create Badges with points in a domain where they have access to, irrespective of the
"Assign points on earning badge" setting value on that domain. For example, consider HR admin has access to
domain "Mumbai" where Rewards service is enabled but the "Assign points on earning badge" setting under this
service is disabled. In this case, HR admin can still define numeric point and associate them with a badge.

This change does not affect the existing behavior for learners. Continuing with the above example, if Jay is a learner
in domain "Mumbai" and if he earns a badge in that domain, then he does not earn any points for that badge because
the "Assign points on earning badge" setting is disabled on domain "Mumbai".

• HR administrators can now add learning items from domains they have access to, to a Badge even if the domains of
learning items are different than that of the Badge. With this change, they can now see all learning items where they
have domain rights, irrespective of the Badge's domain.

This change does not affect the existing behavior for learners. They continue to earn badges and points if any for
learning items they successfully complete or acquire in the domain they have access to.

There is a need to enhance the Badge administration workflow to improve its usability and effectiveness.

Improvements to Microsite properties page

The existing UI System > Configure System > Microsites > Configure Microsite was not very intuitive. The Properties
tab had a lot of links making it huge and difficult to use.

The existing Microsite properties are now also available under the new UI System > Configure System > Microsite
Properties.

Note:  By default, the new UI will be disabled. To enable the new UI, submit a support request. For assistance,
contact Saba support.

As of now, these properties are also accessible from the old UI: System > Configure System > Microsites >
Configure Microsite > <MicroSiteName> > Site Properties.
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Figure 152: Configure Properties

This page lists the properties for the selected Microsite. You can also filter the properties using the Search Properties
textbox.

Figure 153: Filter properties

After filtering, the sections (for example: Web Utility properties) will only show the filtered values.
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This enhancement help improve the usability of the Microsite properties page.

Alerting users about the use of cookies

Prior to this update, it was not possible to alert the users about the use of cookies in Saba Cloud.

It is now possible to alert the users about the use of cookies in Saba Cloud.

Note:  By default, this feature is not enabled. To enable the alerts, either of the following properties need to be
enabled:

• Microsites > Web Variables > Enable GDPR Configurations
• Microsites > Web Variables > Show Cookie Consent Message

The message will be shown on the following pages:

• Login

• Guest Catalog

• SignUp Page

• Career Site

• All the application pages

Note:  Pop-up windows are not included.

A cookie will be created when the user acknowledges the message and that cookie will be valid for a month. The cookie
is not user specific and will persist on the user's Web browser.

Note: The message will then not show up till this cookie is valid.

You can change this message via Microsite's Configure Branding page.

Note: Cookie usage Information Text textfield will only be available if this alerts feature is enabled.

This enhancement will allow customers to alert their users about the use of cookies.
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Improvements to IP validation error messages and status
codes

Prior to this update, if a user fails at IP validation while trying to access the system, the following error message was
shown "You are not authorized to perform this action." along with the Saba logo.

Note:  IP validation is an existing feature where you can either whitelist or blacklist a set of IPs to access the system.
It can be configured via Admin > System > Configure System > Microsites > Open any microsite > Site
properties > Security.

This update brings in the following changes, when the user is restricted from accessing the system during IP validation

1. The Saba logo is no longer shown
2. The status code is now 403
3. The error message is now updated as "Access Denied: Unauthorized access"

Note: This error message can be customized via Admin > System > Configure Labels. Search for the current
label/error message and then change the message as required.

This enhancement helps bring consistency in error messages.

Cert SSO enabled Microsite login page to now also accept
URL Identifier

Prior to this update, on the login page of a Certificate SSO enabled Microsite, in the MicrositeId text field you could
only pass the internal micrositeId.

On the login page of a Certificate SSO enabled Microsite, in the MicrositeId text field you can now either pass urlIdentifier
or the micrositeId.

N/A
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Data Integration

Checklists association for Blended offering, virtual class, ILT and
WBT imports

In the past, Virtual Class, Blended Offering, Instructor Led Training (ILT) and Web-based Training (WBT) imports
only allowed associating Content and Task as activity; Checklists were not included.

Starting from this update, Checklists are also included in the association.

You can add or remove pre-existing checklists from Virtual class, Blended offerings, ILT and WBT classes through
imports.

The following editing activities are supported for checklists:

• Marking it Optional
• Marking it Required
• Marking it Enabled
• Marking it Disabled

The following new columns are added to the RDI template:

• TASK_STATUS
• CHECKLIST_NAME
• CHECKLIST_REQUIRED
• CHECKLIST_SEQUENCE
• CHECKLIST_STATUS

This update provides the capability to associate Checklists for Virtual Class, Blended Offering, ILT and WBT classes
and the capability to pass the Task Status for Blended and Virtual classes.

Data import option for Sign-up Rules

This is a new feature.

With this update, data import option is provided for Sign-up Rules.
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Figure 154: Signup Rules Data Import

This new data import option for sign-up rules will help with automation of external user management.

Enhancement to Student Certification Import

Until now, ability to grant student certification as well as student curriculum was not available from RDI import.

With this update, RDI import supports granting of student certifications and curriculum without their having to complete
a course. This feature was available via the application interface. It is now available from RDI import as well.

This update makes it possible to grant certificate and curriculum to users without them completing the course. This
provides more flexibility to users.

Skip column functionality extended to a few more objects

Until now, SKIP Column configuration was not available for the objects listed below.

With this update, the following additional objects are available for SKIP Column configuration:

1. VC Offering
2. Bulk Content Import
3. Registration
4. Student Certification
5. Student Curriculum
6. New Sign Up Rules

SKIP column functionality is extended to a few more objects.
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Associate and dis-associate courses in Job Role imports

Currently, Job Role Import can only be used to associate Learning events like Certification and Curricula but not for
Courses.

With this update, It is also be possible to use Job Role import to associate/dis-associate Courses.

Job Role imports can also be used to associate/dis-associate Courses.

RDI import for Adhoc transcript improved

Currently, it is only possible to cancel or revoke a recurring course completion from the application UI. It is not possible
from the RDI import.

With this update, It is also be possible to cancel or revoke Adhoc Transcripts for recurring course completions.

The following statuses are applicable:

• Cancellation only applies to assigned/expired-reassigned transcripts.
• Revocation applies to acquired transcripts.
• Cancel or Revoke will have no effect on Expired and In-progress transcripts.

Adhoc transcripts for recurring course completions can now be cancelled or revoked using the RDI import.

Allow removal of skills from Person Competency Import

Currently, the Person Competency Import (Required Skills Import) and Held Skills import can be used to assign skills
to the user but not to remove skills.

In this update an enhancement added enables users to delete Required or Held Skills from a single source or all sources,
provided the required level is set for skills.

Note: This option is available only in Person Competency import.

A new column named ACTION is available in the RDI import which can accept values such as DELETE_REQUIRER,
DELETE_ALL_REQUIRERS.

Default value for this columns stays empty which will continue assigning or updating competency to user.
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With DELETE_REQUIRER option REQUIRER will be mandatory and only source for competency assigned by the
REQUIRER will be deleted.

DELETE_ALL_REQUIRERS option enables competency to be deleted from all sources, without mentioning REQUIRER.

Figure 155: Person Competency RDI Import

Person Competency Import (Required Skills Import) and Held Skills import process has been enhanced to allow users
to assign as well remove skills.

Provide data import option for bulk transfer of people

New addition.

With this update, bulk transfer of people can be performed using the RDI import.

All of the following steps are accomplished using the RDI import file.

• Create a profile of the opposite type.
• Ensure that the user name on the new record is the one that was on the old record.
• Execute a Profile merge to bring data from the old profile to the new profile.
• Mark old profile as terminated.

Figure 156: Bulk transfer RDI import file
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Bulk transfer of people can be performed using the RDI import method.

Data import supports marking a terminated person with Stop
Processing

In the past, terminated users could not be marked with Stop Processing.

This release provides the capability to mark a terminated user as Stop Processing. A new column named
DO_NOT_PROCESS has been added to the RDI import file for Internal Person and External person. This provides the
capability to mark a terminated user as Stop Processing.

See Provide ability to mark a terminated person as Stop Processing on page 142 "Provide ability to mark a terminated
person as Stop Processing" for details on how this works using Saba Cloud application interface.

When a terminated person record is processed by setting DO_NOT_PROCESS to TRUE, that Person will be marked
with Stop Processing. Once this is done, person record will no longer be editable via Imports. For such a record, you
can only reset Stop Processing back by setting DO_NOT_PROCESS to FALSE; no other field can be modified.

Note: The MIGRATION_ADMIN user which is configured to run RDI imports, should not have Stop Processing
enabled.

Data Import now has the mechanism to stop processing a terminated user's data.

Premium data extracts will not return purged users or those with
do-not-process mark

In the past, Premium Data Extracts were pulling the records of Purged users.

With this update, OOB queries in Premium Data Extract will not return users that are purged from Saba Cloud as well
as users with Do-Not-Process status mark.

OOB queries will no longer return records of users that are purged or are marked with Do-Not-Process status.

RDI supports certification in recertify status

RDI import did not support the recertify option on certifications that were already in acquired status.
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With this release, it is now possible to recertify certifications that were already in acquired status. A new column named
RECERTIFY_ALREADY_ACQUIRED has been added to the RDI import template to provide the capability. Until
now the UI had the capability for this option, but the RDI import is now enhanced to support this feature.

Figure 157: Recertify if already acquired selection

Figure 158: RECERTIFY_ALREADY_ACQUIRED column added

RDI import now supports the recertify option on certifications that were already in acquired status.
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REST API

Support for special characters

REST APIs did not support , ; < and > characters as q param values.

REST APIs now support , ; < and > characters as q param values. They just need to be encoded before passing as a q
param value.

N/A

Updated REST APIs

Updates to Training Unit Agreement APIs

The following existing APIs did not support the flag to indicate if this TUA is shared with other organizations:

• GET META DETAILS OF TRAINING UNIT AGREEMENT
• GET DETAILS OF A PARTICULAR TRAINING UNIT AGREEMENT
• CREATE A NEW TRAINING UNIT AGREEMENT
• UPDATE DETAILS OF A TRAINING UNIT AGREEMENT

These REST APIs are now updated with a new attribute called is_shared_with_other_orgs.

GET META DETAILS OF TRAINING UNIT AGREEMENT

Return Values

{  
   "sampleData":{  
      "expiration_date":null,
      "trainingunit_id":null,
      "available_units":0,
      "agreement_no":null,
      "no_unit":0,
      "order_contact":null,
      "no_unit_used":0,
      "sourceagreement_id":null,
      "owner_id":null,
      "source_id":null,
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      "status":"100",
      "id":null,

"is_shared_with_other_orgs":false,

"href":"https://<hostname-api.sabacloud.com>/v1/tuagreement/tutpo000000000000001"

   },
   "name":"TrainingUnitAgreement",
   "displayName":"Training Unit Agreement",
   "attributes":[  
      {  
         "name":"agreement_no",
         "displayName":"Agreement Number",
         "description":null,
         "isRequired":true,
         "isAutoGenerated":true,
         "type":"string",
         "isReference":false,
         "display":true,
         "isSearchFilter":false
      },
      {  
         "name":"available_units",
         "displayName":"Available Training Units",
         "description":null,
         "isRequired":true,
         "isAutoGenerated":false,
         "type":"integer",
         "isReference":false,
         "display":true,
         "isSearchFilter":true
      },
      {  
         "name":"currency",
         "displayName":"Currency",
         "description":null,
         "isRequired":true,
         "isAutoGenerated":false,
         "type":"object",
         "isReference":true,
         "display":true
      },
      {  
         "name":"expiration_date",
         "displayName":"Expiry Date",
         "description":null,
         "isRequired":false,
         "isAutoGenerated":false,
         "type":"date",
         "isReference":false,
         "display":true,
         "isSearchFilter":true
      },
      {  
         "name":"id",
         "displayName":"ID",
         "description":null,
         "isRequired":true,
         "isAutoGenerated":true,
         "type":"string",
         "isReference":false,
         "display":true,
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         "isSearchFilter":false
      },
      {  
         "name":"no_unit",
         "displayName":"Number of Units",
         "description":null,
         "isRequired":true,
         "isAutoGenerated":false,
         "type":"integer",
         "isReference":false,
         "display":true,
         "isSearchFilter":true
      },
      {  
         "name":"no_unit_used",
         "displayName":"Number of Training Units Used",
         "description":null,
         "isRequired":true,
         "isAutoGenerated":false,
         "type":"integer",
         "isReference":false,
         "display":true,
         "isSearchFilter":true
      },
      {  
         "name":"order_contact",
         "displayName":"Order Contact",
         "description":null,
         "isRequired":false,
         "isAutoGenerated":false,
         "type":"object",
         "isReference":true,
         "display":true
      },
      {  
         "name":"owner_id",
         "displayName":"Organization",
         "description":null,
         "isRequired":true,
         "isAutoGenerated":false,
         "type":"object",
         "isReference":true,
         "display":true
      },
      {  
         "name":"paymentTransactionId",
         "displayName":"Payment Transaction ID",
         "description":"payment transaction id",
         "isRequired":true,
         "isAutoGenerated":false,
         "type":"string",
         "isReference":false,
         "display":true,
         "isSearchFilter":false
      },
      {  
         "name":"paymentType",
         "displayName":"Payment Type",
         "description":"payment type",
         "isRequired":true,
         "isAutoGenerated":false,
         "type":"string",
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         "isReference":false,
         "display":true,
         "isSearchFilter":false
      },
      {  
         "name":"sourceagreement_id",
         "displayName":"Source Agreement",
         "description":null,
         "isRequired":false,
         "isAutoGenerated":false,
         "type":"object",
         "isReference":true,
         "display":true
      },
      {  
         "name":"source_id",
         "displayName":"Source Company",
         "description":null,
         "isRequired":false,
         "isAutoGenerated":false,
         "type":"object",
         "isReference":true,
         "display":true
      },
      {  
         "name":"status",
         "displayName":"Status",
         "description":null,
         "isRequired":true,
         "isAutoGenerated":false,
         "type":"object",
         "isReference":true,
         "choices":{  

"href":"https://<hostname-api.sabacloud.com>/v1/sysli000000000004006/values"
         },
         "display":true
      },
      {  
         "name":"trainingunit_id",
         "displayName":"Training Unit",
         "description":null,
         "isRequired":true,
         "isAutoGenerated":false,
         "type":"object",
         "isReference":true,
         "display":true
      },
      {  
         "name":"custom0",
         "displayName":"Custom0",
         "description":null,
         "isRequired":false,
         "isAutoGenerated":false,
         "type":"string",
         "isReference":false,
         "display":false,
         "length":255,
         "maximumLength":255,
         "isSearchFilter":true
      },
      {  
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         "name":"custom1",
         "displayName":"Custom1",
         "description":null,
         "isRequired":false,
         "isAutoGenerated":false,
         "type":"string",
         "isReference":false,
         "display":false,
         "length":255,
         "maximumLength":255,
         "isSearchFilter":true
      },
      {  
         "name":"custom2",
         "displayName":"Custom2",
         "description":null,
         "isRequired":false,
         "isAutoGenerated":false,
         "type":"string",
         "isReference":false,
         "display":false,
         "length":255,
         "maximumLength":255,
         "isSearchFilter":true
      },
      {  
         "name":"custom3",
         "displayName":"Custom3",
         "description":null,
         "isRequired":false,
         "isAutoGenerated":false,
         "type":"string",
         "isReference":false,
         "display":false,
         "length":255,
         "maximumLength":255,
         "isSearchFilter":true
      },
      {  
         "name":"custom4",
         "displayName":"Custom4",
         "description":null,
         "isRequired":false,
         "isAutoGenerated":false,
         "type":"string",
         "isReference":false,
         "display":false,
         "length":255,
         "maximumLength":255,
         "isSearchFilter":true
      },
      {  
         "name":"custom5",
         "displayName":"Custom5",
         "description":null,
         "isRequired":false,
         "isAutoGenerated":false,
         "type":"string",
         "isReference":false,
         "display":false,
         "length":255,
         "maximumLength":255,
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         "isSearchFilter":true
      },
      {  
         "name":"custom6",
         "displayName":"Custom6",
         "description":null,
         "isRequired":false,
         "isAutoGenerated":false,
         "type":"string",
         "isReference":false,
         "display":false,
         "length":255,
         "maximumLength":255,
         "isSearchFilter":true
      },
      {  
         "name":"custom7",
         "displayName":"Custom7",
         "description":null,
         "isRequired":false,
         "isAutoGenerated":false,
         "type":"string",
         "isReference":false,
         "display":false,
         "length":255,
         "maximumLength":255,
         "isSearchFilter":true
      },
      {  
         "name":"custom8",
         "displayName":"Custom8",
         "description":null,
         "isRequired":false,
         "isAutoGenerated":false,
         "type":"string",
         "isReference":false,
         "display":false,
         "length":255,
         "maximumLength":255,
         "isSearchFilter":true
      },
      {  
         "name":"custom9",
         "displayName":"Custom9",
         "description":null,
         "isRequired":false,
         "isAutoGenerated":false,
         "type":"string",
         "isReference":false,
         "display":false,
         "length":255,
         "maximumLength":255,
         "isSearchFilter":true
      }
   ]
}

GET DETAILS OF A PARTICULAR TRAINING UNIT AGREEMENT
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Return Values

{
    "agreement_no": "00001040",
    "available_units": 2,
    "customValues": {
        "custom0": null,
        "custom1": null,
        "custom2": null,
        "custom3": null,
        "custom4": null,
        "custom5": null,
        "custom6": null,
        "custom7": null,
        "custom8": null,
        "custom9": null
    },
    "expiration_date": "2015-09-17T00:00:00.000+0000",
    "id": "tutpo000000000001040",

"is_shared_with_other_orgs": false,
    "no_unit": 2,
    "no_unit_used": 0,
    "order_contact": null,
    "owner_id": {
        "displayName": "saba1",
        "id": "cmpny000000000001120"
    },
    "source_id": null,
    "sourceagreement_id": null,
    "status": "200",
    "trainingunit_id": {
        "displayName": "Training Unit1",
        "id": "tunit000000000001000"
    }
}

CREATE A NEW TRAINING UNIT AGREEMENT

Request Body

{
  "owner_id": {
    "id": "cmpny000000000001002",
    "displayName": "Company3"
  },
  "agreement_no": "00001149",
  "expiration_date": null,
  "trainingunit_id": {
    "id": "tunit000000000001058",
    "displayName": "TU1"
  },
  "no_unit": 19,
  "currency": {
    "id": "crncy000000000000001",
    "displayName": "US Dollars"
  },
  "paymentType": "invoiceMe",
"is_shared_with_other_orgs": false,

  "paymentTransactionId": "axxccssxx1001",
  "invoiceRequest": {
    "details": "Invoice payment for TUA via rest api test",
    "custom0": "abc"

 | System | 222



  },
  "customValues": {
    "custom0": true,
    "custom1": "cust1",
    "custom2": "cust2",
    "custom3": "cust3",
    "custom4": "cust4",
    "custom5": "cust5",
    "custom6": "cust6",
    "custom7": "cust7",
    "custom8": "cust8",
    "custom9": "cust9"
  }
}

UPDATE DETAILS OF A TRAINING UNIT AGREEMENT

Request Body

{
    "customValues":{"custom0": "11111"},
    "agreement_no":"123123123",

"is_shared_with_other_orgs":false
}

N/A

Updates to People APIs

The following existing People API did not support user friendly URL:

• GET CERTIFICATIONS/ENROLLMENTS/TRANSCRIPTS FOR A PERSON
• GET PROFILE PIC URL
• GET PROFILE PIC

In the following existing People API the status field did not support the IN clause:

• SEARCH ALL THE CERTIFICATIONS/CURRICULA ASSIGNED TO A LEARNER BASED ON THE STATUS,
TIMESTAMP (Using POST - Range based search)

These REST APIs are now updated.

GET CERTIFICATIONS/ENROLLMENTS/TRANSCRIPTS FOR A PERSON

URL

https://<hostname-api.sabacloud.com>/v1/people/:id/:attributeName/search?q=(:criteria_field%3D%3D:field_value)&count=:count&startPage=:startPage

URL (User-friendly)

You can use a user-friendly URL which accepts username or person_no instead of the internal Person's ID.

https://<hostname-api.sabacloud.com>/v1/people/username=<userName>/:attributeName/search
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?type=internal

https://<hostname-api.sabacloud.com>/v1/people/person_no=<personNo>/:attributeName/search

?type=internal

Note: The type query parameter is mandatory to support these lookups (username or person_no).

GET PROFILE PIC URL

URL

https://<hostname-api.sabacloud.com>/v1/common/profile/:personId/profilePicURL

URL (User-friendly)
You can use a user-friendly URL which accepts the username instead of the internal Person's ID.

https://<hostname-api.sabacloud.com>/v1/common/profile/username%3D<Username>/profilePicURL

GET PROFILE PIC

URL

https://<hostname-api.sabacloud.com>/v1/common/profile/:personId/profilePic

URL (User-friendly)
You can use a user-friendly URL which accepts the username instead of the internal Person's ID.

https://<hostname-api.sabacloud.com>/v1/common/profile/username%3D<Username>/profilePic

SEARCH ALL THE CERTIFICATIONS/CURRICULA ASSIGNED TO A LEARNER BASED ON THE
STATUS, TIMESTAMP (Using POST - Range based search)

A manager/admin can use the IN operator to specify a list of team members as the search criteria. If the logged in person
is a manager, then the API returns the data for all team members specified using the IN operator.

Note:  Only 5 team members are supported in the IN operator.

The following attributes support using the IN operator:

Student Certification

• assignee
• username
• person_no
• status_description_cert
• status_description_curr

Student Curriculum

• assignee
• username
• person_no
• status_description_cert
• status_description_curr

Note: The status_description_cert and status_description_curr attributes are now added to this list.

This helps reduce the number of API calls.
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Retrieve all orders for TUA/PO using ID or Agreement Number

The following existing Order API did not support retrieving all orders for TUA/PO using ID or Agreement Number:

• FIND DETAILS OF ORDERS

The FIND DETAILS OF ORDERS REST API is now updated to support the following additional search criteria:

Searching Orders by Training Unit Agreement's tu_agreement_id

https://<hostname-api.sabacloud.com>/v1/learning/order?q=(tu_agreement_id%3D%3Dtutpo000000000001004)

Searching Orders by Training Unit Agreement's tu_agreement_number

https://<hostname-api.sabacloud.com>/v1/learning/order?q=(tu_agreement_number%3D%3D00001001)

Searching Orders by Purchase Order's po_id

https://<hostname-api.sabacloud.com>/v1/learning/order?q=(po_id%3D%3Dpordr000000000001000)

N/A

Retrieve all the resources attached to a class

The following existing Class API did not support retrieving the resources attached to a class:

• GET DETAILS OF A CLASS

The GET DETAILS OF A CLASS REST API is now updated to support the following additional context value:

You can now alter the URL as below to retrieve all the resources attached to this class:

https://<hostname-api.sabacloud.com>/v1/offering/:offeringId?context=adminWithResources

Example:

https://<hostname-api.sabacloud.com>/v1/offering/class000000000015681?context=adminWithResources

Return Values (?context=adminWithResources)

{
    "@type": "com.saba.learning.services.offering.OfferingDetail",
    "min_ct": 5,
    "max_ct": 20,
    "max_book": 20,
    "csr_id": null,
    "open_enroll": null,
    "open_enroll_for_all": null,
    "enroll_close": null,
    "stop_auto_promotion": null,
    "skip_days_map": "0000000",
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    "vleInfo": null,
    "disp_for_web": true,
    "disp_for_call_center": true,
    "enforced_seq": "100",
    "offeringPrices": [
        "list",
        [
            {
                "@type": "com.saba.learning.services.common.Money",
                "amount": [
                    "java.math.BigDecimal",
                    100
                ],
                "currency": {
                    "@type": "ServiceObjectReference",
                    "id": "crncy000000000000167",
                    "displayName": null
                },
                "amountString": "100 USD",
                "isocode": "USD"
            }
        ]
    ],
    "startDateI18n": "17/04/2018",
    "endDateI18n": "17/04/2018",
    "learningAssignments": null,
    "offering_temp_no": null,
    "offeringlocked": false,
    "publishStartDate": null,
    "publishEndDate": null,
    "publishStatus": null,
    "publishStatusMessage": null,
    "locationDetail": {
        "@type": "com.saba.learning.services.resource.LocationDetail",
        "attachments": [
            "list",
            []
        ],
        "contactInfo": {
            "@type": "com.saba.learning.services.common.ContactDetail",
            "email": "",
            "fax": "",
            "secondaryPhone": "",
            "primaryPhone": ""
        },
        "organization": null,
        "locationId": "00003260",
        "locationName": "Redwood Shore HQ",
        "locationContact": null,
        "addressInfo": {
            "@type": "com.saba.learning.services.common.AddressDetail",
            "city": "Redwood Shore",
            "country": "United States",
            "addressLine1": "2400 Bridge Parkway",
            "addressLine2": "",
            "addressLine3": null,
            "zipCode": "94065",
            "state": "California"
        },
        "eeoMandatory": null,
        "timezone": {
            "@type": "ServiceObjectReference",
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            "id": "tzone000000000000012",
            "displayName": "(GMT-05:00) Eastern Time (US & Canada)"
        }
    },
    "audienceTypes": [
        "list",
        []
    ],
    "availabilityDetails": {
        "@type": "com.saba.learning.services.offering.
            OfferingDetail$OfferingRegistrationAvailabilityDetailsSection",
        "availableSeats": 20,
        "offeringPrice": {
            "@type": "com.saba.learning.services.common.Money",
            "amount": [
                "java.math.BigDecimal",
                100
            ],
            "currency": {
                "@type": "ServiceObjectReference",
                "id": "crncy000000000000167",
                "displayName": null
            },
            "amountString": "100 USD",
            "isocode": "USD"
        },
        "offeringPriceDisplay": "100 USD"
    },
    "creditsCollection": null,
    "actions": null,
    "has_community": false,
    "group_id": null,
    "consumeWithinCert": false,
    "creditString": null,
    "customValues": [
        "list",
        []
    ],
    "owners": [
        "list",
        []
    ],
    "trainingUnits": null,
    "status": "Open - Normal",
    "calendarExportURL": null,
    "microLearning": false,
    "do_not_drop_post": null,
    "post_order": null,
    "post_completion": null,
    "cpfMins": 0,
    "waitListedCount": 0,
    "registeredCount": 0,
    "groupAssociatedWithCourse": {
        "@type": "ServiceObjectReference",
        "id": "teams000000000003361",
        "displayName": "Core Java-00026029"
    },
    "statusNumValue": 100,
    "inheritedTrainingUnits": null,
    "suppressScoreForOT": false,
    "customFieldsSetOnCourse": false,
    "courseDescription": "",
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    "classDescription": "Core Java ilt1",
    "courseCustomValues": [
        "list",
        [
            {
                "@type": "CustomAttributeValueDetail",
                "name": "custom0",
                "datatype": {
                    "@type": "CustomAttributeDatatype",
                    "value": 18
                },
                "value": null,
                "displayName": "Course String"
            },
            {
                "@type": "CustomAttributeValueDetail",
                "name": "custom1",
                "datatype": {
                    "@type": "CustomAttributeDatatype",
                    "value": 1
                },
                "value": null,
                "displayName": "Course Integer"
            },
            {
                "@type": "CustomAttributeValueDetail",
                "name": "custom2",
                "datatype": {
                    "@type": "CustomAttributeDatatype",
                    "value": 2
                },
                "value": null,
                "displayName": "Course Real2"
            },
            {
                "@type": "CustomAttributeValueDetail",
                "name": "custom3",
                "datatype": {
                    "@type": "CustomAttributeDatatype",
                    "value": 9
                },
                "value": null,
                "displayName": "Course Boolean"
            },
            {
                "@type": "CustomAttributeValueDetail",
                "name": "custom4",
                "datatype": {
                    "@type": "CustomAttributeDatatype",
                    "value": 10
                },
                "value": null,
                "displayName": "Course Date"
            },
            {
                "@type": "CustomAttributeValueDetail",
                "name": "custom5",
                "datatype": {
                    "@type": "CustomAttributeDatatype",
                    "value": 12
                },
                "value": null,
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                "displayName": "Course Time"
            },
            {
                "@type": "CustomAttributeValueDetail",
                "name": "custom6",
                "datatype": {
                    "@type": "CustomAttributeDatatype",
                    "value": 18
                },
                "value": null,
                "displayName": "Course String LOV"
            },
            {
                "@type": "CustomAttributeValueDetail",
                "name": "custom7",
                "datatype": {
                    "@type": "CustomAttributeDatatype",
                    "value": 18
                },
                "value": null,
                "displayName": "Course String_Protected"
            },
            {
                "@type": "CustomAttributeValueDetail",
                "name": "custom8",
                "datatype": {
                    "@type": "CustomAttributeDatatype",
                    "value": 18
                },
                "value": null,
                "displayName": "Course String22"
            },
            {
                "@type": "CustomAttributeValueDetail",
                "name": "custom9",
                "datatype": {
                    "@type": "CustomAttributeDatatype",
                    "value": 18
                },
                "value": null,
                "displayName": "Course String LOV"
            },
            {
                "@type": "CustomAttributeValueDetail",
                "name": "custom10",
                "datatype": {
                    "@type": "CustomAttributeDatatype",
                    "value": 18
                },
                "value": null,
                "displayName": "Course Integer"
            },
            {
                "@type": "CustomAttributeValueDetail",
                "name": "custom11",
                "datatype": {
                    "@type": "CustomAttributeDatatype",
                    "value": 18
                },
                "value": null,
                "displayName": "Course Real"
            },
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            {
                "@type": "CustomAttributeValueDetail",
                "name": "custom12",
                "datatype": {
                    "@type": "CustomAttributeDatatype",
                    "value": 18
                },
                "value": null,
                "displayName": "Course String Protected"
            },
            {
                "@type": "CustomAttributeValueDetail",
                "name": "custom13",
                "datatype": {
                    "@type": "CustomAttributeDatatype",
                    "value": 18
                },
                "value": null,
                "displayName": "Course Boolean"
            },
            {
                "@type": "CustomAttributeValueDetail",
                "name": "custom14",
                "datatype": {
                    "@type": "CustomAttributeDatatype",
                    "value": 18
                },
                "value": null,
                "displayName": "Course Time 22"
            }
        ]
    ],
    "id": "class000000000015681",
    "price": {
        "@type": "com.saba.learning.services.common.Money",
        "amount": [
            "java.math.BigDecimal",
            100
        ],
        "currency": {
            "@type": "ServiceObjectReference",
            "id": "crncy000000000000167",
            "displayName": null
        },
        "amountString": "100 USD",
        "isocode": "USD"
    },
    "abstract": "",
    "availableSeats": 20,
    "deliveryType": {
        "@type": "ServiceObjectReference",
        "id": "eqcat000000000000004",
        "displayName": "Instructor-Led"
    },
    "offeringTemplate": {
        "@type": "ServiceObjectReference",
        "id": "cours000000000046101",
        "displayName": "Core Java"
    },
    "language": {
        "@type": "ServiceObjectReference",
        "id": "lange000000000000001",
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        "displayName": "English"
    },
    "offeringNumber": "00026029--CORE JAVA ILT1",
    "sessionTemplate": "Tue 7:00 -8:00;",
    "facility": null,
    "securityDomain": {
        "@type": "ServiceObjectReference",
        "id": "domin000000000000001",
        "displayName": "world"
    },
    "componentName": "ComponentName",
    "startDate": {
        "@type": "com.saba.customtypes.DateWithLocale",
        "date": 1523923200000,
        "locale": "17/04/2018",
        "timeInLocale": "0:00",
        "dateInUserTimeZone": "17/04/2018",
        "timeInUserTimeZone": "5:30",
        "dateInCustomTimeZone": null,
        "timeInCustomTimeZone": null,
        "customTimeZoneDate": 0,
        "timeInStandardFormat": "12:00 AM",
        "dateInStandardFormat": "04/17/2018"
    },
    "endDate": {
        "@type": "com.saba.customtypes.DateWithLocale",
        "date": 1523923200000,
        "locale": "17/04/2018",
        "timeInLocale": "0:00",
        "dateInUserTimeZone": "17/04/2018",
        "timeInUserTimeZone": "5:30",
        "dateInCustomTimeZone": null,
        "timeInCustomTimeZone": null,
        "customTimeZoneDate": 0,
        "timeInStandardFormat": "12:00 AM",
        "dateInStandardFormat": "04/17/2018"
    },
    "duration": 60,
    "cpf": false,
    "customFields": {
        "@type": "map"
    },
    "delivery_id": {
        "@type": "ServiceObjectReference",
        "id": "eqcat000000000000004",
        "displayName": "Instructor-Led"
    },
    "wbt_no": "00026029--CORE JAVA ILT1",
    "avail_from": null,
    "offering_temp_id": {
        "@type": "ServiceObjectReference",
        "id": "cours000000000046101",
        "displayName": "Core Java"
    },
    "language_id": {
        "@type": "ServiceObjectReference",
        "id": "lange000000000000001",
        "displayName": "English"
    },
    "class_no": "00026029--CORE JAVA ILT1",
    "session_template": "Tue 7:00 -8:00;",
    "location_id": {
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        "@type": "ServiceObjectReference",
        "id": "locat000000000003320",
        "displayName": "Redwood Shore HQ"
    },
    "facility_id": null,
    "vendor_id": null,
    "start_date": {
        "@type": "com.saba.customtypes.DateWithLocale",
        "date": 1523923200000,
        "locale": "17/04/2018",
        "timeInLocale": "0:00",
        "dateInUserTimeZone": "17/04/2018",
        "timeInUserTimeZone": "5:30",
        "dateInCustomTimeZone": null,
        "timeInCustomTimeZone": null,
        "customTimeZoneDate": 0,
        "timeInStandardFormat": "12:00 AM",
        "dateInStandardFormat": "04/17/2018"
    },
    "manufacturer_id": null,
    "disc_from": null,
    "dropPolicyInfo": {
        "@type": "com.saba.learning.services.catalog.DropPolicyInfo",
        "notifyDropCondition": "",
        "trainingUnitDropPolicyInfo": null,
        "allEffectivePolicies": [
            "list",
            [
                {
                    "@type": 
"com.saba.learning.services.catalog.DropPolicyDetail",
                    "displayString": "Cancellation charge of 100.0 % if dropped
 between 07/04/2018 and 17/04/2018.",
                    "timeEntryId": "",
                    "daysFrom": 0,
                    "daysTo": 10,
                    "charge": 100,
                    "chargeType": 1,
                    "currency": {
                        "@type": "ServiceObjectReference",
                        "id": "crncy000000000000167",
                        "displayName": null
                    }
                },
                {
                    "@type": 
"com.saba.learning.services.catalog.DropPolicyDetail",
                    "displayString": "Cancellation charge of 10.0 % for all 
other days.",
                    "timeEntryId": "",
                    "daysFrom": -99999,
                    "daysTo": 99999,
                    "charge": 10,
                    "chargeType": 1,
                    "currency": {
                        "@type": "ServiceObjectReference",
                        "id": "crncy000000000000167",
                        "displayName": null
                    }
                }
            ]
        ],
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        "lastDateToDropWithoutCharge": null
    },
    "vleinfoDetail": {
        "@type": "map"
    },
    "courseVersion": null,
    "durationString": "01:00",
    "baseDeliveryType": 100,
    "ownersValue": null,
    "customFieldsValue": [
        "list",
        []
    ],
    "priceDisplayString": "100 USD",
    "description": "Core Java ilt1",
    "location": {
        "@type": "ServiceObjectReference",
        "id": "locat000000000003320",
        "displayName": "Redwood Shore HQ"
    },
    "resources": [
        "list",
        [
            {
                "@type": 
"com.saba.learning.services.resource.ResourceInfoDetail",
                "resourceLocation": null,
                "resourceFacility": null,
                "resourceCatalog": null,
                "resourceRates": null,
                "type": "TYPE_PERSON",
                "qualified": false,
                "resourceStartDate": null,
                "resourceEndDate": null,
                "addInfo": {
                    "@type": "map"
                },
                "resource": {
                    "@type": "ServiceObjectReference",
                    "id": "emplo000000000001041",
                    "displayName": "Super User"
                },
                "resourceType": 200,
                "disabled": false,
                "purpose": "recat000000000000504"
            },
            {
                "@type": 
"com.saba.learning.services.resource.ResourceInfoDetail",
                "resourceLocation": {
                    "@type": "LocationReference",
                    "id": "locat000000000003320",
                    "displayName": "Redwood Shore HQ",
                    "primaryKey": {
                        "@type": "com.saba.persist.ObjectId",
                        "id": "locat000000000003320",
                        "prefix": "locat"
                    }
                },
                "resourceFacility": null,
                "resourceCatalog": null,
                "resourceRates": [
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                    "list",
                    [
                        {
                            "@type": "com.saba.currency.Money",
                            "amount": [
                                "java.math.BigDecimal",
                                0
                            ],
                            "currency": {
                                "@type": 
"com.saba.currency.SabaCurrencyReference",
                                "id": "crncy000000000000167",
                                "displayName": "US Dollars"
                            },
                            "isocode": "USD",
                            "string": "0 USD"
                        }
                    ]
                ],
                "type": "TYPE_ROOM",
                "qualified": false,
                "resourceStartDate": null,
                "resourceEndDate": null,
                "addInfo": {
                    "@type": "map",
                    "custom0": "customvalue0",
                    "custom1": "customvalue1",
                    "ExCustom1": "customvalue2"
                },
                "resource": {
                    "@type": "ServiceObjectReference",
                    "id": "rooms000000000001280",
                    "displayName": "Room1"
                },
                "resourceType": 100,
                "disabled": false,
                "purpose": "recat000000000000501"
            },
            {
                "@type": 
"com.saba.learning.services.resource.ResourceInfoDetail",
                "resourceLocation": {
                    "@type": "LocationReference",
                    "id": "locat000000000003320",
                    "displayName": "Redwood Shore HQ",
                    "primaryKey": {
                        "@type": "com.saba.persist.ObjectId",
                        "id": "locat000000000003320",
                        "prefix": "locat"
                    }
                },
                "resourceFacility": null,
                "resourceCatalog": null,
                "resourceRates": [
                    "list",
                    [
                        {
                            "@type": "com.saba.currency.Money",
                            "amount": [
                                "java.math.BigDecimal",
                                0
                            ],
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                            "currency": {
                                "@type": 
"com.saba.currency.SabaCurrencyReference",
                                "id": "crncy000000000000167",
                                "displayName": "US Dollars"
                            },
                            "isocode": "USD",
                            "string": "0 USD"
                        }
                    ]
                ],
                "type": "TYPE_EQUIPMENT",
                "qualified": false,
                "resourceStartDate": null,
                "resourceEndDate": null,
                "addInfo": {
                    "@type": "map",
                    "custom9": "customvalue9",
                    "custom0": "121331",
                    "custom3": null,
                    "custom4": null,
                    "custom1": null,
                    "custom2": null,
                    "custom7": "customvalue7",
                    "custom8": "customvalue8",
                    "custom5": "customvalue5",
                    "custom6": "customvalue6",
                    "ExCustom1": "world"
                },
                "resource": {
                    "@type": "ServiceObjectReference",
                    "id": "equip000000000001180",
                    "displayName": "EQ1001"
                },
                "resourceType": 300,
                "disabled": false,
                "purpose": "recat000000000000510"
            },
            {
                "@type": 
"com.saba.learning.services.resource.ResourceInfoDetail",
                "resourceLocation": null,
                "resourceFacility": null,
                "resourceCatalog": null,
                "resourceRates": [
                    "list",
                    [
                        {
                            "@type": "com.saba.currency.Money",
                            "amount": [
                                "java.math.BigDecimal",
                                80
                            ],
                            "currency": {
                                "@type": 
"com.saba.currency.SabaCurrencyReference",
                                "id": "crncy000000000000167",
                                "displayName": "US Dollars"
                            },
                            "isocode": "USD",
                            "string": "80 USD"
                        }
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                    ]
                ],
                "type": "TYPE_INVENTORY",
                "qualified": false,
                "resourceStartDate": null,
                "resourceEndDate": null,
                "addInfo": {
                    "@type": "map"
                },
                "resource": {
                    "@type": "ServiceObjectReference",
                    "id": "prdct000000000001100",
                    "displayName": "20170802001Inventery"
                },
                "resourceType": 400,
                "disabled": false,
                "purpose": "recat000000000000519"
            }
        ]
    ],
    "name": "Core Java"
}

N/A

Retrieve external Job Board data

The following existing Job Requisition API did not support retrieving external Job Board data:

• GET DETAILS OF A PARTICULAR JOB REQUISITION

The GET DETAILS OF A PARTICULAR JOB REQUISITION REST API is now updated to support the following
additional parameter as well as retrieving external Job Board data:

URL (to include external job board data)

https://<hostname-api.sabacloud.com>/v1/job-requisition/:id?includeJobBoardData=true

OR

https://<hostname-api.sabacloud.com>/v1/job-requisition/:id:(jobBoardData,jobboards)

Return Values

{
    "jobboards":[
        {
            "externalId":null,
            "requisition":{
                "id":"jobrq000000000004446",
                "displayName":"Need SSE API"
            },
            "postStatus":null,
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            "jobBoard":"vendr0000001c4316020141108ff091007ffc",
            "externalServiceType":"JOB-BOARD",
            "additionalInfo1":null,
            "additionalInfo2":null,
            "additionalInfo3":null,
            "additionalInfo4":null,
            "postMessage":null,
            "id":"rqjbd000000000004113"
        },
        {
            "externalId":null,
            "requisition":{
                "id":"jobrq000000000004446",
                "displayName":"Need SSE API"
            },
            "postStatus":null,
            "jobBoard":"vendr000000545cc2aa0140c94bfe57007ffe",
            "externalServiceType":"JOB-BOARD",
            "additionalInfo1":null,
            "additionalInfo2":null,
            "additionalInfo3":null,
            "additionalInfo4":null,
            "postMessage":null,
            "id":"rqjbd000000000004114"
        },
        {
            "externalId":null,
            "requisition":{
                "id":"jobrq000000000004446",
                "displayName":"Need SSE API"
            },
            "postStatus":null,
            "jobBoard":"vendr0000001c4316020141108ff091007fff",
            "externalServiceType":"JOB-BOARD",
            "additionalInfo1":null,
            "additionalInfo2":null,
            "additionalInfo3":null,
            "additionalInfo4":null,
            "postMessage":null,
            "id":"rqjbd000000000004115"
        },
        {
            "externalId":null,
            "requisition":{
                "id":"jobrq000000000004446",
                "displayName":"Need SSE API"
            },
            "postStatus":null,
            "jobBoard":"vendr00000049a4339c01629452a33a004142",
            "externalServiceType":"JOB-BOARD",
            "additionalInfo1":null,
            "additionalInfo2":null,
            "additionalInfo3":null,
            "additionalInfo4":null,
            "postMessage":null,
            "id":"rqjbd000000000004116"
        },
        {
            "externalId":null,
            "requisition":{
                "id":"jobrq000000000004446",
                "displayName":"Need SSE API"
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            },
            "postStatus":null,
            "jobBoard":"vendr00000049a4339c01629452a33a0034dc",
            "externalServiceType":"JOB-BOARD",
            "additionalInfo1":null,
            "additionalInfo2":null,
            "additionalInfo3":null,
            "additionalInfo4":null,
            "postMessage":null,
            "id":"rqjbd000000000004117"
        },
        {
            "externalId":null,
            "requisition":{
                "id":"jobrq000000000004446",
                "displayName":"Need SSE API"
            },
            "postStatus":null,
            "jobBoard":"vendr00000034540e6f0162bd540a150020d4",
            "externalServiceType":"JOB-BOARD",
            "additionalInfo1":null,
            "additionalInfo2":null,
            "additionalInfo3":null,
            "additionalInfo4":null,
            "postMessage":null,
            "id":"rqjbd000000000004118"
        }
    ],
    "id":"jobrq000000000004446",
    "jobBoardData":[
        {
            "name":"Broadbean",
            "code":"BROADBEAN",
            "customFields":[

            ],
            "oobFields":[
                {
                    "name":"Location",
                    "code":"COUNTRY_CODE",
                    "visible":true,
                    "type":"LOV",
                    "value":null,
                    "lovValue":{
                        "code":"in",
                        "displayName":"India"
                    }
                },
                {
                    "name":"State",
                    "code":"STATE",
                    "visible":true,
                    "type":"String",
                    "value":"Maharashtra",
                    "lovValue":null
                },
                {
                    "name":"Job Family",
                    "code":"JOB_FUNCTION",
                    "visible":true,
                    "type":"LOV",
                    "value":null,
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                    "lovValue":{
                        "code":"mgmt",
                        "displayName":"Management"
                    }
                },
                {
                    "name":"Salary Type",
                    "code":"PAY_INTERVAL",
                    "visible":true,
                    "type":"LOV",
                    "value":null,
                    "lovValue":{
                        "code":"BW",
                        "displayName":"Bi-weekly"
                    }
                },
                {
                    "name":"Employment Type",
                    "code":"JOB_TYPE",
                    "visible":true,
                    "type":"LOV",
                    "value":null,
                    "lovValue":{
                        "code":"C",
                        "displayName":"Contract"
                    }
                },
                {
                    "name":"Industry",
                    "code":"INDUSTRY",
                    "visible":false,
                    "type":"LOV",
                    "value":null,
                    "lovValue":null
                },
                {
                    "name":"Min experience ",
                    "code":"EXPERIENCE_LEVEL",
                    "visible":true,
                    "type":"LOV",
                    "value":null,
                    "lovValue":null
                }
            ]
        },
        {
            "name":"Metro Job",
            "code":"METRO JOB",
            "customFields":[
                {
                    "name":"Custom0",
                    "code":"CUSTOM",
                    "visible":true,
                    "type":"String",
                    "value":"custom0str",
                    "lovValue":null
                },
                {
                    "name":"CustomString",
                    "code":"CUSTOMSTRING",
                    "visible":true,
                    "type":"String",
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                    "value":"str",
                    "lovValue":null
                }
            ],
            "oobFields":[
                {
                    "name":"Location",
                    "code":"COUNTRY_CODE",
                    "visible":true,
                    "type":"LOV",
                    "value":null,
                    "lovValue":{
                        "code":"in",
                        "displayName":"India"
                    }
                },
                {
                    "name":"State",
                    "code":"STATE",
                    "visible":false,
                    "type":"LOV",
                    "value":"Maharashtra",
                    "lovValue":null
                },
                {
                    "name":"Job Family",
                    "code":"JOB_FUNCTION",
                    "visible":true,
                    "type":"LOV",
                    "value":null,
                    "lovValue":{
                        "code":"mgmt",
                        "displayName":"Management"
                    }
                },
                {
                    "name":"Salary Type",
                    "code":"PAY_INTERVAL",
                    "visible":true,
                    "type":"LOV",
                    "value":null,
                    "lovValue":{
                        "code":"BW",
                        "displayName":"Bi-weekly"
                    }
                },
                {
                    "name":"Employment Type",
                    "code":"JOB_TYPE",
                    "visible":true,
                    "type":"LOV",
                    "value":null,
                    "lovValue":{
                        "code":"P",
                        "displayName":"Part-time"
                    }
                },
                {
                    "name":"Industry",
                    "code":"INDUSTRY",
                    "visible":false,
                    "type":"LOV",
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                    "value":null,
                    "lovValue":null
                },
                {
                    "name":"Min experience ",
                    "code":"EXPERIENCE_LEVEL",
                    "visible":true,
                    "type":"LOV",
                    "value":null,
                    "lovValue":null
                }
            ]
        },
        {
            "name":"Cus_JB",
            "code":"CUS_JB",
            "customFields":[
                {
                    "name":"String_attr",
                    "code":"code3",
                    "visible":true,
                    "type":"String",
                    "value":null,
                    "lovValue":null
                },
                {
                    "name":"custlov",
                    "code":"custlov",
                    "visible":true,
                    "type":"LOV",
                    "value":null,
                    "lovValue":{
                        "code":null,
                        "displayName":null
                    }
                },
                {
                    "name":"test",
                    "code":"code1",
                    "visible":true,
                    "type":"LOV",
                    "value":null,
                    "lovValue":{
                        "code":null,
                        "displayName":null
                    }
                },
                {
                    "name":"flag",
                    "code":"code2",
                    "visible":true,
                    "type":"Boolean",
                    "value":true,
                    "lovValue":null
                },
                {
                    "name":"customLov",
                    "code":"customLov",
                    "visible":true,
                    "type":"LOV",
                    "value":null,
                    "lovValue":{
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                        "code":null,
                        "displayName":null
                    }
                }
            ],
            "oobFields":[
                {
                    "name":"Location",
                    "code":"COUNTRY_CODE",
                    "visible":true,
                    "type":"LOV",
                    "value":null,
                    "lovValue":{
                        "code":"in",
                        "displayName":"India"
                    }
                },
                {
                    "name":"State",
                    "code":"STATE",
                    "visible":true,
                    "type":"String",
                    "value":"Maharashtra",
                    "lovValue":null
                },
                {
                    "name":"Job Family",
                    "code":"JOB_FUNCTION",
                    "visible":true,
                    "type":"LOV",
                    "value":null,
                    "lovValue":{
                        "code":"mgmt",
                        "displayName":"Management"
                    }
                },
                {
                    "name":"Salary Type",
                    "code":"PAY_INTERVAL",
                    "visible":true,
                    "type":"LOV",
                    "value":null,
                    "lovValue":{
                        "code":null,
                        "displayName":null
                    }
                },
                {
                    "name":"Employment Type",
                    "code":"JOB_TYPE",
                    "visible":true,
                    "type":"LOV",
                    "value":null,
                    "lovValue":{
                        "code":null,
                        "displayName":null
                    }
                },
                {
                    "name":"Industry",
                    "code":"INDUSTRY",
                    "visible":false,
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                    "type":"LOV",
                    "value":null,
                    "lovValue":null
                },
                {
                    "name":"Min experience ",
                    "code":"EXPERIENCE_LEVEL",
                    "visible":true,
                    "type":"LOV",
                    "value":null,
                    "lovValue":null
                }
            ]
        },
        {
            "name":"Job Market Fair",
            "code":"JOB MARKET FAIR",
            "customFields":[
                {
                    "name":"Are you willing to Join this organization now?",
                    "code":"21",
                    "visible":true,
                    "type":"Boolean",
                    "value":true,
                    "lovValue":null
                },
                {
                    "name":"Skills",
                    "code":"Sk1",
                    "visible":true,
                    "type":"LOV",
                    "value":null,
                    "lovValue":{
                        "code":null,
                        "displayName":null
                    }
                },
                {
                    "name":"Degree",
                    "code":"T1",
                    "visible":true,
                    "type":"String",
                    "value":"ENGG",
                    "lovValue":null
                }
            ],
            "oobFields":[
                {
                    "name":"Location",
                    "code":"COUNTRY_CODE",
                    "visible":true,
                    "type":"LOV",
                    "value":null,
                    "lovValue":{
                        "code":"in",
                        "displayName":"India"
                    }
                },
                {
                    "name":"State",
                    "code":"STATE",
                    "visible":false,
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                    "type":"LOV",
                    "value":"Maharashtra",
                    "lovValue":null
                },
                {
                    "name":"Job Family",
                    "code":"JOB_FUNCTION",
                    "visible":true,
                    "type":"LOV",
                    "value":null,
                    "lovValue":{
                        "code":"mgmt",
                        "displayName":"Management"
                    }
                },
                {
                    "name":"Salary Type",
                    "code":"PAY_INTERVAL",
                    "visible":false,
                    "type":"LOV",
                    "value":null,
                    "lovValue":{
                        "code":null,
                        "displayName":null
                    }
                },
                {
                    "name":"Employment Type",
                    "code":"JOB_TYPE",
                    "visible":false,
                    "type":"LOV",
                    "value":null,
                    "lovValue":{
                        "code":null,
                        "displayName":null
                    }
                },
                {
                    "name":"Industry",
                    "code":"INDUSTRY",
                    "visible":false,
                    "type":"LOV",
                    "value":null,
                    "lovValue":null
                },
                {
                    "name":"Min experience ",
                    "code":"EXPERIENCE_LEVEL",
                    "visible":false,
                    "type":"LOV",
                    "value":null,
                    "lovValue":null
                }
            ]
        },
        {
            "name":"LinkedIn",
            "code":"LINKEDIN",
            "customFields":[

            ],
            "oobFields":[
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                {
                    "name":"Location",
                    "code":"COUNTRY_CODE",
                    "visible":true,
                    "type":"LOV",
                    "value":null,
                    "lovValue":{
                        "code":"in",
                        "displayName":"India"
                    }
                },
                {
                    "name":"State",
                    "code":"STATE",
                    "visible":true,
                    "type":"String",
                    "value":"Maharashtra",
                    "lovValue":null
                },
                {
                    "name":"Job Family",
                    "code":"JOB_FUNCTION",
                    "visible":true,
                    "type":"LOV",
                    "value":null,
                    "lovValue":{
                        "code":"mgmt",
                        "displayName":"Management"
                    }
                },
                {
                    "name":"Salary Type",
                    "code":"PAY_INTERVAL",
                    "visible":true,
                    "type":"LOV",
                    "value":null,
                    "lovValue":{
                        "code":"BW",
                        "displayName":"Bi-weekly"
                    }
                },
                {
                    "name":"Employment Type",
                    "code":"JOB_TYPE",
                    "visible":true,
                    "type":"LOV",
                    "value":null,
                    "lovValue":{
                        "code":"C",
                        "displayName":"Contract"
                    }
                },
                {
                    "name":"Industry",
                    "code":"INDUSTRY",
                    "visible":false,
                    "type":"LOV",
                    "value":null,
                    "lovValue":null
                },
                {
                    "name":"Min experience ",
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                    "code":"EXPERIENCE_LEVEL",
                    "visible":true,
                    "type":"LOV",
                    "value":null,
                    "lovValue":null
                },
                {
                    "name":"LinkedIn Id",
                    "code":"POSTED_BY",
                    "visible":true,
                    "type":"String",
                    "value":"test123@test.test",
                    "lovValue":null
                }
            ]
        },
        {
            "name":"Monster",
            "code":"MONSTER",
            "customFields":[

            ],
            "oobFields":[
                {
                    "name":"Location",
                    "code":"COUNTRY_CODE",
                    "visible":true,
                    "type":"LOV",
                    "value":null,
                    "lovValue":{
                        "code":"in",
                        "displayName":"India"
                    }
                },
                {
                    "name":"State",
                    "code":"STATE",
                    "visible":true,
                    "type":"String",
                    "value":"Maharashtra",
                    "lovValue":null
                },
                {
                    "name":"Job Family",
                    "code":"JOB_FUNCTION",
                    "visible":true,
                    "type":"LOV",
                    "value":null,
                    "lovValue":{
                        "code":"mgmt",
                        "displayName":"Management"
                    }
                },
                {
                    "name":"Salary Type",
                    "code":"PAY_INTERVAL",
                    "visible":true,
                    "type":"LOV",
                    "value":null,
                    "lovValue":{
                        "code":"BW",
                        "displayName":"Biweekly"
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                    }
                },
                {
                    "name":"Employment Type",
                    "code":"JOB_TYPE",
                    "visible":true,
                    "type":"LOV",
                    "value":null,
                    "lovValue":{
                        "code":"P",
                        "displayName":"Intern"
                    }
                },
                {
                    "name":"Industry",
                    "code":"INDUSTRY",
                    "visible":false,
                    "type":"LOV",
                    "value":null,
                    "lovValue":null
                },
                {
                    "name":"Min experience",
                    "code":"EXPERIENCE_LEVEL",
                    "visible":true,
                    "type":"LOV",
                    "value":null,
                    "lovValue":null
                }
            ]
        }
    ],
    "jobboards":[
        {
            "externalId":null,
            "requisition":{
                "id":"jobrq000000000004446",
                "displayName":"Need SSE API"
            },
            "postStatus":null,
            "jobBoard":"vendr0000001c4316020141108ff091007ffc",
            "externalServiceType":"JOB-BOARD",
            "additionalInfo1":null,
            "additionalInfo2":null,
            "additionalInfo3":null,
            "additionalInfo4":null,
            "postMessage":null,
            "id":"rqjbd000000000004113"
        },
        {
            "externalId":null,
            "requisition":{
                "id":"jobrq000000000004446",
                "displayName":"Need SSE API"
            },
            "postStatus":null,
            "jobBoard":"vendr000000545cc2aa0140c94bfe57007ffe",
            "externalServiceType":"JOB-BOARD",
            "additionalInfo1":null,
            "additionalInfo2":null,
            "additionalInfo3":null,
            "additionalInfo4":null,
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            "postMessage":null,
            "id":"rqjbd000000000004114"
        },
        {
            "externalId":null,
            "requisition":{
                "id":"jobrq000000000004446",
                "displayName":"Need SSE API"
            },
            "postStatus":null,
            "jobBoard":"vendr0000001c4316020141108ff091007fff",
            "externalServiceType":"JOB-BOARD",
            "additionalInfo1":null,
            "additionalInfo2":null,
            "additionalInfo3":null,
            "additionalInfo4":null,
            "postMessage":null,
            "id":"rqjbd000000000004115"
        },
        {
            "externalId":null,
            "requisition":{
                "id":"jobrq000000000004446",
                "displayName":"Need SSE API"
            },
            "postStatus":null,
            "jobBoard":"vendr00000049a4339c01629452a33a004142",
            "externalServiceType":"JOB-BOARD",
            "additionalInfo1":null,
            "additionalInfo2":null,
            "additionalInfo3":null,
            "additionalInfo4":null,
            "postMessage":null,
            "id":"rqjbd000000000004116"
        },
        {
            "externalId":null,
            "requisition":{
                "id":"jobrq000000000004446",
                "displayName":"Need SSE API"
            },
            "postStatus":null,
            "jobBoard":"vendr00000049a4339c01629452a33a0034dc",
            "externalServiceType":"JOB-BOARD",
            "additionalInfo1":null,
            "additionalInfo2":null,
            "additionalInfo3":null,
            "additionalInfo4":null,
            "postMessage":null,
            "id":"rqjbd000000000004117"
        },
        {
            "externalId":null,
            "requisition":{
                "id":"jobrq000000000004446",
                "displayName":"Need SSE API"
            },
            "postStatus":null,
            "jobBoard":"vendr00000034540e6f0162bd540a150020d4",
            "externalServiceType":"JOB-BOARD",
            "additionalInfo1":null,
            "additionalInfo2":null,
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            "additionalInfo3":null,
            "additionalInfo4":null,
            "postMessage":null,
            "id":"rqjbd000000000004118"
        }
    ]
}

Integration partners will be able to extract the posting details for the extended job boards they support and perform the
job posting.

New REST APIs

Add smartlist as a criteria for an audience type

The existing Smartlist APIs did not allow associating a smart list to an audience type.

The following API is now available that allows adding smartlist as a criteria for an audience type.

ADD SMARTLIST AS CRITERIA FOR AUDIENCE TYPE

Overview

Adds smartlist as a criteria for an audience type.

Requires OAuth

No

Method

POST

URL

http://<hostname-api.sabacloud.com>/v1/smartlists/addOwner

Calling Options

Table 32: Calling Options

Required?Data TypeDefault ValueDescriptionName

Yesstring{"id":
"stlst000000000001062","dis~

The Smartlist used as criteriaparent

playName": "test
smartlist"}
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Required?Data TypeDefault ValueDescriptionName

Yesstring{"id":
"audie000000000001163","dis~
playName": "AT1"}

Audience typeowner

Request Body

{
 "parent": {
  "displayName": "test SL basic"
 },
 "owner": {
  "displayName": "aud_1"
 }
}

In addition to this, the following existing REST APIs will now return smartlistId, in case there is criteria associated to
the AT:

• GET DETAILS OF A PARTICULAR AUDIENCE TYPE
• GET DETAILS OF A PARTICULAR SUB AUDIENCE TYPE

This helps associating a smart list to an audience type using REST APIs.

APIs to find extended details of classes

These are new REST APIs.

The following APIs are now available that allow finding the extended details of classes.

FIND EXTENDED DETAILS OF CLASSES

Overview

Returns the details of the classes along with the ID, class_no and the Deeplink URL based on the provided search criteria.

Requires OAuth

YES

Method

GET

URL

https://<hostname-api.sabacloud.com>/v1/offering/search?type=:type&q=(:criteria_field%3D%3D:field_value)&count=:count&startPage=:startPage
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Calling Options

Table 33: Calling Options

Required?Data TypeSample ValueDescriptionName

Nostringinstructor_ledThe type of the desired class.type

Nostringpart_noThe search criteria i.e. the
field name.

criteria_field

NostringThe search value for the
specified search criteria.

field_value

Nointeger10The number of records per
page.

count

Nointeger1The start page number for
the list of records.

startPage

Criteria and display columns supported by this API

Condition tokenDisplay columnDescriptionName

YesYesOffering Idpart_no

YesYesOffering start dateoffering_start_date

YesYesOffering end dateoffering_end_date

YesYesClass Domain IdDomain

NoYesCourse Domaincourse_domain

YesYesOffering titleoffering_name

NoYesCreditsoffering_credits

YesYesCourse Idcourse_id

YesYesCourse Titlecourse_title

YesYesCourse custom 0course_custom0

YesYesCourse custom 1course_custom1

YesYesCourse custom 2course_custom2

YesYesCourse custom 3course_custom3

YesYesCourse custom 4course_custom4

YesYesCourse custom 5course_custom5
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Condition tokenDisplay columnDescriptionName

YesYesCourse custom 6course_custom6

YesYesCourse custom 7course_custom7

YesYesCourse custom 8course_custom8

YesYesCourse custom 9course_custom9

YesYesCourse custom 10course_custom10

YesYesCourse custom 11course_custom11

YesYesCourse custom 12course_custom12

YesYesCourse custom 13course_custom13

YesYesCourse custom 14course_custom14

YesYesCourse Numbercourse_no

YesYesCourse Versioncourse_version

NoYesCourse descriptioncourse_description

NoYesCourse abstractcourse_abstract

YesYesSession template idsession_name

YesYesOffering Status codeStatus

YesYesLanguage IdLanguage

NoYesOffering delivery type namedelivery_name

YesYesAvailable from dateavail_from

YesYesDiscontinued from datedisc_from

YesYesMax number of seatsmax_ct

YesYesWaitlist capacitymax_book

YesYesMin number of seatsmin_ct

YesYesNumber of registered seatsstud_ct

YesYesMaximum overbookstud_book

YesNoCompetency Idcompetency_id

YesNoCompetency level Idcompetency_level_id
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Condition tokenDisplay columnDescriptionName

YesNoCompetency Namecompetency_name

YesNoCompetency Level Namecompetency_level_name

YesNoDelivery type Iddelivery_id

YesYesLocation Idlocation_id

YesNoPerson Id against which
audience type check will be
performed

person_id

NoCollection of categoriesCategories of coursecourse_categories

NoCollection of KeywordsKeywords of coursecourse_keywords

NoCollection of EquivalentsEquivalents of coursecourse_equivalents

NoCollection of competencies
with level details

Competencies of coursecourse_competencies

YesYesOffering custom 0offering_custom0

YesYesOffering custom 1offering_custom1

YesYesOffering custom 2offering_custom2

YesYesOffering custom 3offering_custom3

YesYesOffering custom 4offering_custom4

YesYesOffering custom 5offering_custom5

YesYesOffering custom 6offering_custom6

YesYesOffering custom 7offering_custom7

YesYesOffering custom 8offering_custom8

YesYesOffering custom 9offering_custom9

Return Values

{
    "facets": [],
    "totalResults": 1,
    "itemsPerPage": 1,
    "hasMoreResults": false,
    "startIndex": 1,
    "results": [
        {
            "offering_name": "Attendance Check",

 | System | 253



            "session_name": null,
            "course_keywords": [
                {
                    "name": "abc",
                    "id": "kywrd000000000200200"
                },
                {
                    "name": "abc pqr",
                    "id": "kywrd000000000200201"
                }
            ],
            "min_ct": null,
            "offering_start_date": "3000-01-01T00:00:00.000+0530",
            "delivery_name": "Web-Based",
            "disc_from": "3000-01-01T00:00:00.000+0530",
            "language": "lange000000000000001",
            "location_id": null,
            "course_categories": [
                {
                    "name": "new Cat",
                    "id": "categ000000000001040"
                }
            ],
            "course_competencies":[
                {
                    "competency_name":"Designer",
                    "competency_level_id":"cplvl000000000001067",
                    "competency_level":"Average",
                    "competency_id":"compt000000000001021"
                }
            ],
             "course_domain":"domin000000000000001"
            "stud_book": null,
            "course_custom2": "2",
            "course_custom1": "1",
            "course_custom4": "4",
            "course_equivalents": [
                {
                    "name": "111",
                    "id": "cours000000000200486",
                    "version": null
                },
                {
                    "name": "#12",
                    "id": "cours000000000200814",
                    "version": null
                }
            ],
            "offering_end_date": "1900-01-01T00:00:00.000+0530",
            "id": "dowbt000000000001943",
            "course_custom3": "3",
            "course_custom0": "0",
            "stud_ct": null,
            "offering_custom0": "0",
            "course_abstract": "-------------- Course to validate Session 
Attendance ---------------- 
\nuone1 has not attended any sessions\nutwo1 has attended sessions 
1,3,5\nuthree1 has attended all sessions",
            "course_custom9": "9",
            "course_custom10":null,
            "course_custom11":null,
            "course_custom12":null,
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            "course_custom13":null,
            "course_custom14":null,
            "course_id": "cours000000000001080",
            "offering_custom1": "1",
            "max_ct": null,
            "course_custom6": "6",
            "course_custom5": "5",
            "course_custom8": "8",
            "course_custom7": "7",
            "course_title": "Attendance Check",
            "offering_custom8": "8",
            "offering_custom9": null,
            "offering_custom6": "6",
            "course_version": null,
            "offering_custom7": "7",
            "offering_custom4": "4",
            "offering_custom5": "5",
            "offering_custom2": "2",
            "avail_from": "2009-07-17T00:00:00.000+0530",
            "max_book": null,
            "offering_custom3": "3",
            "part_no": "ID",
            "domain": "domin000000000000001",
            "offering_credits": null,
            "course_no": "PG2-ATTCHK",
            "course_description": "Description",
            "status": null,
            "href": 
"http://localhost/Saba/api/component/offering/dowbt000000000001943"
        }
    ]
}

FIND EXTENDED DETAILS OF CLASSES (Using POST - Range based search)

Overview

Returns the details of the class along with the ID, part_no and the Deeplink URL based on the provided range based
search criteria.

Requires OAuth

No

Method

POST

URL

https://<hostname-api.sabacloud.com>/v1/offering/search?type=:type&q=(:criteria_field%3D%3D:field_value)&count=:count&startPage=:startPage

Calling Options

Table 34: Calling Options

Required?Data TypeSample ValueDescriptionName

Nostringinstructor_ledThe type of the desired class.type
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Required?Data TypeSample ValueDescriptionName

Yesstring[{"name": "part_no",
"operator":
"==","value": "Id"}]

The search conditions.

You can use search operators
such as:

conditions

• =gt=
• =ge=
• =lt=
• =le=
• =eq=
• =ne=

Nointeger10The number of records per
page.

count

Nointeger1The start page number for
the list of records.

startPage

Criteria and display columns supported by this API

Condition tokenDisplay columnDescriptionName

YesYesOffering Idpart_no

YesYesOffering start dateoffering_start_date

YesYesOffering end dateoffering_end_date

YesYesClass Domain IdDomain

NoYesCourse Domaincourse_domain

YesYesOffering titleoffering_name

NoYesCreditsoffering_credits

YesYesCourse Idcourse_id

YesYesCourse Titlecourse_title

YesYesCourse custom 0course_custom0

YesYesCourse custom 1course_custom1

YesYesCourse custom 2course_custom2

YesYesCourse custom 3course_custom3

YesYesCourse custom 4course_custom4

YesYesCourse custom 5course_custom5
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Condition tokenDisplay columnDescriptionName

YesYesCourse custom 6course_custom6

YesYesCourse custom 7course_custom7

YesYesCourse custom 8course_custom8

YesYesCourse custom 9course_custom9

YesYesCourse custom 10course_custom10

YesYesCourse custom 11course_custom11

YesYesCourse custom 12course_custom12

YesYesCourse custom 13course_custom13

YesYesCourse custom 14course_custom14

YesYesCourse Numbercourse_no

YesYesCourse Versioncourse_version

NoYesCourse descriptioncourse_description

NoYesCourse abstractcourse_abstract

YesYesSession template idsession_name

YesYesOffering Status codeStatus

YesYesLanguage IdLanguage

NoYesOffering delivery type namedelivery_name

YesYesAvailable from dateavail_from

YesYesDiscontinued from datedisc_from

YesYesMax number of seatsmax_ct

YesYesWaitlist capacitymax_book

YesYesMin number of seatsmin_ct

YesYesNumber of registered seatsstud_ct

YesYesMaximum overbookstud_book

YesNoCompetency Idcompetency_id

YesNoCompetency level Idcompetency_level_id
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Condition tokenDisplay columnDescriptionName

YesNoCompetency Namecompetency_name

YesNoCompetency Level Namecompetency_level_name

YesNoDelivery type Iddelivery_id

YesYesLocation Idlocation_id

YesNoPerson Id against which
audience type check will be
performed

person_id

NoCollection of categoriesCategories of coursecourse_categories

NoCollection of KeywordsKeywords of coursecourse_keywords

NoCollection of EquivalentsEquivalents of coursecourse_equivalents

NoCollection of competencies
with level details

Competencies of coursecourse_competencies

YesYesOffering custom 0offering_custom0

YesYesOffering custom 1offering_custom1

YesYesOffering custom 2offering_custom2

YesYesOffering custom 3offering_custom3

YesYesOffering custom 4offering_custom4

YesYesOffering custom 5offering_custom5

YesYesOffering custom 6offering_custom6

YesYesOffering custom 7offering_custom7

YesYesOffering custom 8offering_custom8

YesYesOffering custom 9offering_custom9

Request Body

{
 "conditions" : [
  {"name": "part_no", "operator": "==","value": "WBT000004"}
 ]
}
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Return Values

{
    "facets": [],
    "totalResults": 1,
    "itemsPerPage": 1,
    "hasMoreResults": false,
    "startIndex": 1,
    "results": [
        {
            "offering_name": "Attendance Check",
            "session_name": null,
            "course_keywords": [
                {
                    "name": "abc",
                    "id": "kywrd000000000200200"
                },
                {
                    "name": "abc pqr",
                    "id": "kywrd000000000200201"
                }
            ],
            "min_ct": null,
            "offering_start_date": "3000-01-01T00:00:00.000+0530",
            "delivery_name": "Web-Based",
            "disc_from": "3000-01-01T00:00:00.000+0530",
            "language": "lange000000000000001",
            "location_id": null,
            "course_categories": [
                {
                    "name": "new Cat",
                    "id": "categ000000000001040"
                }
            ],
            "course_competencies":[
                {
                    "competency_name":"Designer",
                    "competency_level_id":"cplvl000000000001067",
                    "competency_level":"Average",
                    "competency_id":"compt000000000001021"
                }
            ],
             "course_domain":"domin000000000000001"
            "stud_book": null,
            "course_custom2": "2",
            "course_custom1": "1",
            "course_custom4": "4",
            "course_equivalents": [
                {
                    "name": "111",
                    "id": "cours000000000200486",
                    "version": null
                },
                {
                    "name": "#12",
                    "id": "cours000000000200814",
                    "version": null
                }
            ],
            "offering_end_date": "1900-01-01T00:00:00.000+0530",
            "id": "dowbt000000000001943",
            "course_custom3": "3",
            "course_custom0": "0",
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            "stud_ct": null,
            "offering_custom0": "0",
            "course_abstract": "-------------- Course to validate Session 
Attendance ---------------- 
\nuone1 has not attended any sessions\nutwo1 has attended sessions 
1,3,5\nuthree1 has attended all sessions",
            "course_custom9": "9",
            "course_custom10":null,
            "course_custom11":null,
            "course_custom12":null,
            "course_custom13":null,
            "course_custom14":null,
            "course_id": "cours000000000001080",
            "offering_custom1": "1",
            "max_ct": null,
            "course_custom6": "6",
            "course_custom5": "5",
            "course_custom8": "8",
            "course_custom7": "7",
            "course_title": "Attendance Check",
            "offering_custom8": "8",
            "offering_custom9": null,
            "offering_custom6": "6",
            "course_version": null,
            "offering_custom7": "7",
            "offering_custom4": "4",
            "offering_custom5": "5",
            "offering_custom2": "2",
            "avail_from": "2009-07-17T00:00:00.000+0530",
            "max_book": null,
            "offering_custom3": "3",
            "part_no": "ID",
            "domain": "domin000000000000001",
            "offering_credits": null,
            "course_no": "PG2-ATTCHK",
            "course_description": "Description",
            "status": null,
            "href": 
"http://localhost/Saba/api/component/offering/dowbt000000000001943"
        }
    ]
}

N/A

Public APIs to retrieve job postings

These are new public REST APIs.

The following APIs are now available that allow retrieving job postings.

GET ALL ACTIVE JOB-POSTINGS
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Overview

Returns all the active job-postings.

Note: This is a public REST API (for external career sites) and does not require authentication.

Requires OAuth

No

Method

GET

URL

https://<hostname-api.sabacloud.com>/v1/public/job-postings?count=:count&startPage=:startPage

Table 35: Calling Options

Required?Data TypeSample ValueDescriptionName

Nointeger10The number of records per
page.

count

Nointeger1The start page number for
the list of records.

startPage

Return Values

{
    "totalResults": 2,
    "startIndex": 1,
    "hasMoreResults": false,
    "itemsPerPage": 10,
    "results": [
        {
            "id": "jobrq000000000001020",
            "href": 
"http://<hostname-api.sabacloud.com>/v1/public/job-postings/jobrq000000000001020",

            "title": "Coder"
        },
        {
            "id": "jobrq000000000001060",
            "href": 
"http://<hostname-api.sabacloud.com>/v1/public/job-postings/jobrq000000000001060",

            "title": "HPEngineer3A"
        }
    ],
    "facets": []
}

GET DETAILS OF A PARTICULAR JOB-POSTING

Overview

Returns details of a particular job-posting.
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Note: This is a public REST API (for external career sites) and do not require authentication.

Requires OAuth

No

Method

GET

URL

https://<hostname-api.sabacloud.com>/v1/public/job-postings/{id}

Table 36: Calling Options

Required?Data TypeSample ValueDescriptionName

Yesstringjobrq000000000001020ID of the job-postingid

Return Values

{
    "employmentType": "Regular",
    "about": "<p>We are a dynamic organization with great customers and a 
culture where people are valued and empowered to deliver amazing results. We 
are also growing and looking to hire talented and passionate individuals to 
join our team!</p>",
    "description": "<p>Job description</p>",
    "title": "QA Manager",
    "experience": [
        {
            "experience": "Strategy",
            "experienceLevel ": "3"
        },
        {
            "experience": "IT Background",
            "experienceLevel ": "10"
        },
        {
            "experience": "Team Management",
            "experienceLevel ": "7"
        }
    ],
    "applyLink": 
"http://<hostname>/Saba/Web_spf/HPRecruit/jobs-jobs/career/jobdetail/jobrq000000000001020",

    "skills": [
        {
            "skill": "MBA",
            "skillLevel ": "Guru"
        },
        {
            "skill": "HTML5",
            "skillLevel ": "Expert"
        },
        {
            "skill": "JAVA",
            "skillLevel ": "Expert"
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        }
    ],
    "number": "1020",
    "qualification": "<p>qa</p>",
    "locationCountry": "USA",
    "closedDate": null,
    "postedOn": "Posted 25 day(s) ago",
    "jobFamily": "Executives",
    "location": "San Francisco, Californina",
    "id": "jobrq000000000001020",
    "locationState": "CA",
    "category": null,
    "locationCity": "Redwood Shores"
}

The public job requisition posting API allows external vendors/job boards to subscribe to publicly posted jobs on the
customer tenant and automatically post jobs on external job boards.

Update or delete profile picture of a person using REST APIs

The existing People APIs did not allow updating or deleting profile picture of a person.

The following APIs are now available that allow updating or deleting the profile picture of a person.

UPDATE A PERSON'S PROFILE PIC

Overview

Updates the profile picture of a person based on the Person's ID or username using multipart/form-data as the content-type.

Requires OAuth

No

Method

PUT

URL

https://<hostname-api.sabacloud.com>/v1/common/profile/:person_id/profilePic

URL (User-friendly)
You can use a user-friendly URL which accepts the username instead of the internal Person's ID.

https://<hostname-api.sabacloud.com>/v1/common/profile/username%3D<Username>/profilePic?type=<type>

Content-type
Multipart/form-data
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Note:

The supported file types for upload are: .jpg of .gif. A file needs to be passed and the file size should be less than
Picture size specified Web variables.

Calling Options

Table 37: Calling Options

Required?Data TypeSample ValueDescriptionName

Yesstringper~
sn000000000001000

Person's IDperson_id

Yesfile
file: picturefile.jpg

key / valuefile

DELETE A PERSON'S PROFILE PIC

Overview

Deletes the profile picture of a person based on the Person's ID or username.

Requires OAuth

No

Method

DELETE

URL

https://<hostname-api.sabacloud.com>/v1/common/profile/:person_id/profilePic

URL (User-friendly)
You can use a user-friendly URL which accepts the username instead of the internal Person's ID.

https://<hostname-api.sabacloud.com>/v1/common/profile/username%3D<Username>/profilePic?type=<type>

Calling Options

Table 38: Calling Options

Required?Data TypeSample ValueDescriptionName

Yesstringper~
sn000000000001000

Person's IDperson_id

N/A

 | System | 264



Chapter

14

Talent

Topics:

• Update domain of talent pool in
Draft state



Update domain of talent pool in Draft state

The talent administrator could update the domain of a talent pool in the Active state.

The talent administrator can now update the domain of a talent pool only in the Draft state. The Domain field is grayed
out in Active state.

Figure 159: Domain field disabled on Pool Edit Details page

This improves the usability.
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